COPYRIGHT
Copyright ©2001–2015 Given Imaging Ltd.

TRADEMARKS
Copyright ©2001-2015 Given Imaging Ltd. GIVEN, GIVEN & Design, PILLCAM, PILLCAM & Logo, RAPID, RAPID ACCESS, BRAVO, BRAVO PH SYSTEM, DIGITRAPPER, MANOSCAN, MANOSHIELD, MANOVIEW, GASTROTAC, GEROFLEX, VERSAFLEX, ACCUTRAC, ACCUVIEW, POLYGRAF ID, SMARTPILL, MOTILIGI, SMARTBAR, and THE MEASURE OF GI HEALTH are trademarks and/or registered trademarks of Given Imaging Ltd., its subsidiaries and/or affiliates in the United States and/or other countries. All other company or product names are the trademarks or registered trademarks of their respective holders. All rights not expressly granted are reserved.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Note
Changes or modifications not expressly approved by Given Imaging Limited could void authority to operate the PillCam Capsule Endoscopy System.

Rx Only

Given Imaging
3950 Shackleford Road, Suite 500 Duluth GA
30096 USA  supportUS@givenimaging.com

Given Imaging GmbH
Borsteler Chaussee 47 D-22453
Hamburg, Germany  supportEU@givenimaging.com
# Table of Contents

## Chapter 1

### Using This Guide

Conventions .................................................................................................................. 1

## Chapter 2

### Indications, Contraindications, Warnings, Cautions

#### Indications for Use

- PillCam SB .................................................................................................................. 3
- PillCam ESO .................................................................................................................. 3
- PillCam UGI .................................................................................................................. 3
- PillCam COLON ........................................................................................................... 4

#### Contraindications

- PillCam SB .................................................................................................................. 4
- PillCam ESO/PillCam UGI .......................................................................................... 4
- PillCam COLON ........................................................................................................... 4

#### Adverse Events ........................................................................................................ 5

#### Warnings .................................................................................................................. 5

#### Cautions .................................................................................................................... 8

### Benefits and Risks—PillCam Capsule Endoscopy

- Benefits ....................................................................................................................... 8
- Risks ............................................................................................................................. 9

#### Essential Performance

- PillCam Video Capsules ............................................................................................. 10
- PillCam Recorder DR2 and PillCam Recorder DR3 ...................................................... 10

#### Accuracy of the Device—SB

#### Accuracy of the Device—ESO

#### Accuracy of the Device—UGI

#### Accuracy of the Device—COLON 2

  - Clinical Validation Study and Interpretation of Results ............................................. 17
  - Evaluation of Capsule Endoscopy with PillCam COLON 2 in Visualization of the Colon (MA-204) 17

## Chapter 3

### Welcome to PillCam Capsule Endoscopy

- What is PillCam Capsule Endoscopy? ........................................................................ 29
- The PillCam Capsule Endoscopy Process .................................................................. 29

### PillCam Capsule Endoscopy System Components

- PillCam Capsules ........................................................................................................ 29
- Handling the PillCam Capsule .................................................................................... 31
- PillCam Recorders ....................................................................................................... 31
- PillCam Sensors .......................................................................................................... 32
- RAPID for PillCam Software ..................................................................................... 32
- Home Screen .............................................................................................................. 32
# Chapter 4
## Preparing for PillCam Capsule Endoscopy ................................................. 37
- **Preparing the Patient** .............................................................................. 37
- **Preparing the Required Equipment** ...................................................... 38
  - Connecting the PillCam Recorder to RAPID for Check-in .................. 38
- **Creating Patient Instructions for the Procedure** .................................. 40
  - Pre-ingestion Instruction Handouts ....................................................... 40
  - Post-ingestion Instructions for Procedures Involving Colon Visualization 41
- **General Patient Guidelines During the Procedure** .............................. 42
- **Performing Patient Check-in** ................................................................. 43
  - Updating Patient Details ........................................................................ 50
- **Fitting Equipment on the Patient** ......................................................... 51
  - Applying the PillCam Sensor Belt .......................................................... 51
  - Applying the PillCam Sensor Array ......................................................... 52
  - Necessary Equipment and Accessories ................................................ 52
  - ESO/UGI Sensor Locations .................................................................... 54
  - SB Sensor Locations ............................................................................... 55
  - COLON 2 Sensor Locations .................................................................... 56
- **Attaching the Sensors to the PillCam Recorder** ................................... 57
  - Recorder Pouch ..................................................................................... 57
  - PillCam Recorder Belt ........................................................................... 58
  - PillCam Recorder DR2 and DR3 .............................................................. 58
  - Positioning PillCam Recorder DR3 .......................................................... 59
  - Positioning PillCam Recorder DR2 .......................................................... 60

# Chapter 5
## Know Your PillCam Recorder ................................................................. 63
- **Preparing the PillCam Recorder** ............................................................ 63
- **Functions** .............................................................................................. 63
  - Initialization ......................................................................................... 63
  - Pairing for DR3 .................................................................................... 63
  - Real-Time Viewing .............................................................................. 63
  - Regimen Reminder .............................................................................. 64
  - Download ............................................................................................. 64
- **PillCam Recorder DR3** .......................................................................... 64
  - General ................................................................................................. 64
  - Turning On and Off .............................................................................. 65
  - Regimen Reminder .............................................................................. 66
  - Charging ............................................................................................... 66
  - Controls ............................................................................................... 67
    - Main Display .................................................................................... 67
    - LED Display ..................................................................................... 68
    - Acknowledge (ACK) Button, Designated for Patient Use ............... 68
    - Navigation Buttons ......................................................................... 69
    - Button Pressing Indication .............................................................. 69
    - Battery and Capsule Icons ............................................................. 70
    - PillCam Recorder DR3 LEDs .......................................................... 70
    - Screen Icons ................................................................................... 71
    - Check-in Screen Icons ................................................................... 72
## Table of Contents

- **Error Messages** ....................................................................................................................... 73
- **PillCam Recorder DR2** ........................................................................................................... 74
  - General ..................................................................................................................................... 74
  - Turning On and Off ............................................................................................................... 74
  - Charging .................................................................................................................................. 75
  - PillCam Recorder DR2 LEDs ............................................................................................... 75
- **Connecting a PillCam Recorder to a Personal Computer (PC)** .............................................. 77
- **Connecting a PillCam Recorder to the External Real-Time Viewer** ......................................... 77

### Chapter 6

**Performing PillCam Capsule Endoscopy** ................................................................................. 79

- Setting Delay First Instruction in PillCam Recorder .................................................................. 79
- **PillCam Recorder—Capsule Pairing (DR3 only)** .................................................................... 80
  - Capsule Designation During Patient Check-in ...................................................................... 80
  - Capsule Designation Before Capsule Ingestion .................................................................... 81
- **Capsule Ingestion** .................................................................................................................. 82
  - PillCam Recorder DR3 ........................................................................................................... 83
  - PillCam Recorder DR2 ........................................................................................................... 83
- **After Capsule Ingestion** ......................................................................................................... 84
  - PillCam ESO/UGI .................................................................................................................... 84
  - PillCam SB ............................................................................................................................. 84
  - PillCam Recorder DR3 ........................................................................................................... 84
  - PillCam Recorder DR2 ........................................................................................................... 84
  - PillCam COLON (DR3 only) ................................................................................................. 84
- **Real-Time Viewing with PillCam Recorder DR3 Only—Internal Mode** ............................... 85
- **Real-Time Viewing with PillCam Recorder DR2 Only—External Mode** ............................... 87
- **Removing Equipment from the Patient** ................................................................................ 87

### Chapter 7

**Creating RAPID Videos** ........................................................................................................... 89

- **PillCam Recorder Download** ................................................................................................. 89
  - Creating a Video from the PillCam Recorder ........................................................................ 90
  - Creating a Video from USB Storage Device or DVD ............................................................... 91
  - Batch Video Creation ............................................................................................................. 92
  - From PillCam Recorders ........................................................................................................ 92
  - From Raw Data Files/USB Storage Devices ......................................................................... 92
  - Pause/End Video Creation ..................................................................................................... 92
- **Managing RAPID Video Data** ............................................................................................... 92
  - Copying Data from a PillCam Recorder ................................................................................. 93
  - Managing Data Files ................................................................................................................ 95
  - Batch Data Copy .................................................................................................................... 96
  - From PillCam Recorders ........................................................................................................ 96
  - From Video Data Files/USB Storage Devices ....................................................................... 96
  - Backing up Data ..................................................................................................................... 96
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chapter 8</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Reviewing and Interpreting RAPID Videos</strong></td>
<td>97</td>
</tr>
<tr>
<td><strong>Loading a Study with the Study Manager</strong></td>
<td>97</td>
</tr>
<tr>
<td>Archives</td>
<td>99</td>
</tr>
<tr>
<td>Adding an Archive</td>
<td>99</td>
</tr>
<tr>
<td>Archive Options</td>
<td>100</td>
</tr>
<tr>
<td>Studies</td>
<td>100</td>
</tr>
<tr>
<td>Study Columns</td>
<td>101</td>
</tr>
<tr>
<td>Study Options</td>
<td>101</td>
</tr>
<tr>
<td>Understanding the Status Bar</td>
<td>101</td>
</tr>
<tr>
<td>Action Buttons</td>
<td>102</td>
</tr>
<tr>
<td>Search Function</td>
<td>103</td>
</tr>
<tr>
<td>Managing Columns</td>
<td>104</td>
</tr>
<tr>
<td><strong>Using the Study Manager</strong></td>
<td>107</td>
</tr>
<tr>
<td>Open</td>
<td>107</td>
</tr>
<tr>
<td>Export</td>
<td>107</td>
</tr>
<tr>
<td>Burning a Study to a CD/DVD</td>
<td>108</td>
</tr>
<tr>
<td>Saving a Study to Another Archive</td>
<td>110</td>
</tr>
<tr>
<td>Saving a Study as a Zip File</td>
<td>111</td>
</tr>
<tr>
<td>Delete</td>
<td>111</td>
</tr>
<tr>
<td>Offline Studies</td>
<td>112</td>
</tr>
<tr>
<td><strong>Overview of the RAPID Interface</strong></td>
<td>114</td>
</tr>
<tr>
<td>Dialog Box Launchers</td>
<td>114</td>
</tr>
<tr>
<td>Quick Access Toolbar</td>
<td>115</td>
</tr>
<tr>
<td>File View</td>
<td>116</td>
</tr>
<tr>
<td>View Screen</td>
<td>117</td>
</tr>
<tr>
<td>View Ribbon</td>
<td>118</td>
</tr>
<tr>
<td>Preview/Review Groups</td>
<td>118</td>
</tr>
<tr>
<td>Preview Group buttons</td>
<td>119</td>
</tr>
<tr>
<td>Review Group Buttons</td>
<td>120</td>
</tr>
<tr>
<td>Viewing Layout Group</td>
<td>120</td>
</tr>
<tr>
<td>Image Adjustment Group</td>
<td>121</td>
</tr>
<tr>
<td>Zoom Group</td>
<td>124</td>
</tr>
<tr>
<td>Show Group</td>
<td>124</td>
</tr>
<tr>
<td><strong>Using RAPID to View a Video</strong></td>
<td>125</td>
</tr>
<tr>
<td>Reading a Capsule Endoscopy Video</td>
<td>125</td>
</tr>
<tr>
<td>QuickView</td>
<td>125</td>
</tr>
<tr>
<td>Complementary QuickView</td>
<td>126</td>
</tr>
<tr>
<td>Viewing a Video</td>
<td>126</td>
</tr>
<tr>
<td>Dynamic Player Control</td>
<td>127</td>
</tr>
<tr>
<td>Dual Head View</td>
<td>128</td>
</tr>
<tr>
<td>SBI View</td>
<td>129</td>
</tr>
<tr>
<td>Time Bar/Color Bar</td>
<td>129</td>
</tr>
<tr>
<td>Time Indication</td>
<td>130</td>
</tr>
<tr>
<td>Creating and Annotating Thumbnails</td>
<td>130</td>
</tr>
<tr>
<td>Thumbnail Status</td>
<td>131</td>
</tr>
<tr>
<td>Thumbnail Comments</td>
<td>132</td>
</tr>
<tr>
<td>Thumbnail Editor</td>
<td>134</td>
</tr>
<tr>
<td>Marking Tools</td>
<td>134</td>
</tr>
<tr>
<td>Mark Circle</td>
<td>134</td>
</tr>
<tr>
<td>Mark Arrow</td>
<td>135</td>
</tr>
<tr>
<td>Undo Mark</td>
<td>135</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Circumference Scale</td>
<td>135</td>
</tr>
<tr>
<td>Polyp Size Estimation</td>
<td>135</td>
</tr>
<tr>
<td>Using Localization and Landmarks</td>
<td>137</td>
</tr>
<tr>
<td>Landmarks</td>
<td>137</td>
</tr>
<tr>
<td>Suggested Flexure Landmarks for COLON Videos</td>
<td>138</td>
</tr>
<tr>
<td>Suggested Landmarks for PillCam SB 3 Videos</td>
<td>138</td>
</tr>
<tr>
<td>Localization</td>
<td>138</td>
</tr>
<tr>
<td>PillCam Progress Indicator</td>
<td>139</td>
</tr>
<tr>
<td>Colon Location Diagram</td>
<td>140</td>
</tr>
<tr>
<td>Passage Times</td>
<td>141</td>
</tr>
<tr>
<td>Comparing Thumbnails</td>
<td>141</td>
</tr>
<tr>
<td>RAPID Video Files</td>
<td>143</td>
</tr>
<tr>
<td>Working with Findings</td>
<td>143</td>
</tr>
<tr>
<td>Saving Your Findings</td>
<td>144</td>
</tr>
<tr>
<td>Opening a Findings File</td>
<td>144</td>
</tr>
<tr>
<td>Creating a PillCam Capsule Endoscopy Report</td>
<td>146</td>
</tr>
<tr>
<td>Overview</td>
<td>146</td>
</tr>
<tr>
<td>Report Ribbon</td>
<td>147</td>
</tr>
<tr>
<td>Configure Buttons Group</td>
<td>147</td>
</tr>
<tr>
<td>Report Buttons Group</td>
<td>149</td>
</tr>
<tr>
<td>Markings Buttons Group</td>
<td>152</td>
</tr>
<tr>
<td>Clinical Tools Buttons Group</td>
<td>152</td>
</tr>
<tr>
<td>RAPID Atlas</td>
<td>153</td>
</tr>
<tr>
<td>Comparing Video Images to Atlas Images</td>
<td>154</td>
</tr>
<tr>
<td>Atlas Image Export</td>
<td>155</td>
</tr>
<tr>
<td>Lewis Score</td>
<td>155</td>
</tr>
<tr>
<td>Generating a Report</td>
<td>158</td>
</tr>
<tr>
<td>Image Data Buttons Group</td>
<td>159</td>
</tr>
</tbody>
</table>

**Appendix A1**

**Installing RAPID Software** ................................................................. 163

- Setup Requirements ............................................................................. 163
- RAPID Installation ............................................................................ 163
- Main Endoscopy System Components .................................................. 164
- Connecting the Components .............................................................. 164
- Connecting the PillCam Recorder Cradle .......................................... 165
- Starting RAPID for the First Time .................................................... 165

**Appendix A2**

**Configuring RAPID Software** .............................................................. 169

- Single or Multi-user Setting ............................................................. 169
  - RAPID Workstation Configuration .................................................. 169
- RAPID Settings .................................................................................. 170
  - General Tab .................................................................................... 171
    - User Information Section .......................................................... 171
    - Regional Settings Section ......................................................... 172
    - Permissions Section .................................................................. 173
Appendix A3

PillCam Equipment Maintenance ......................................................... 201

PillCam Recorder Maintenance .......................................................... 201
  Important Safety Instructions ............................................................ 201
  PillCam Recorder DR3 ................................................................. 202
  PillCam Recorder DR2 ................................................................. 203
  Charging ....................................................................................... 203
  Manual Discharge ....................................................................... 204

PillCam Sensor Cleaning ................................................................. 205
  Cleaning the PillCam Sensor Belt ................................................... 205
  Cleaning the PillCam Sensor Array ............................................... 205
  Cleaning the Recorder Pouch ...................................................... 205
# Appendix A4

## Troubleshooting

- **RAPID Video** .......................................................... 207
- **Saving and Opening Videos** ........................................ 207
- **Printer** ..................................................................... 208
- **CD/DVD** ................................................................. 208
- **Sensor Array** .......................................................... 208
- **Sensor Belt** ............................................................. 209
- **Capsule** ................................................................. 209
- **Cradle** ................................................................. 209
- **PillCam Recorder DR3** .............................................. 209
- **PillCam Recorder DR2** .............................................. 210
- **Error Messages** ...................................................... 211
- **Low Signal** ............................................................ 212

# Appendix A5

## Technical Description

- **System Labeling** ..................................................... 213
  - Capsule Labeling ..................................................... 214
- **Essential Performance** ............................................. 214
  - PillCam Capsules .................................................. 214
  - PillCam Recorder DR2 and PillCam Recorder DR3 ........ 214
- **Warnings** ............................................................. 214
- **Cautions** ............................................................... 216
- **System Specifications** ............................................. 217
  - PillCam SB 2 Capsule ............................................. 217
  - PillCam SB 3 Capsule ............................................. 218
  - PillCam UGI Capsule ............................................. 219
  - PillCam COLON 2 Capsule ..................................... 220
  - Sensor Array PillCam Recorder DR2 ......................... 221
  - Sensor Array PillCam Recorder DR3 ......................... 221
  - PillCam Recorder DR2/DR2C .................................. 222
  - Cradle PillCam Recorder DR2 .................................. 222
  - PillCam Recorder DR3 ............................................. 223
  - PillCam Recorder DR3 SDHC Memory Card ................. 224
  - Cradle PillCam Recorder DR3 .................................. 224
  - DC Power Supply ................................................... 224
  - RAPID for PillCam Software .................................... 225
- **Guidance and Manufacturer's Declarations** ............... 225
  - PillCam Capsules .................................................. 225
  - PillCam Recorder DR2/DR2C .................................. 229
  - PillCam Recorder DR3 ............................................. 232
- **Index** ..................................................................... 237
Conventions

Screen elements, such as menus, button names, and screen names are in bold as follows: PillCam Recorders.

System messages appear as follows: Your PillCam recorder needs an update.

A Note is a piece of information or a remark that receives emphasis and appears as follows:

<table>
<thead>
<tr>
<th>![Bell]</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When connecting more than one PillCam recorder DR2 to the computer, use a USB-powered hub.</td>
</tr>
</tbody>
</table>

A Caution warns you about possible damage to equipment, and appears as follows:

<table>
<thead>
<tr>
<th>![Exclamation]</th>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Make sure that there is no other PillCam capsule or other diagnostic capsule in the patient’s gastrointestinal tract.</td>
</tr>
</tbody>
</table>

A Warning warns you about possible harm to people and appears as follows:

<table>
<thead>
<tr>
<th>![Warning]</th>
<th>Warning</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Never connect the PillCam recorder to the sensor array while the PillCam recorder is in its cradle.</td>
</tr>
</tbody>
</table>
Indications for Use

PillCam SB

The PillCam Capsule Endoscopy System with the PillCam SB capsule is intended for visualization of the small bowel mucosa.

- The PillCam Capsule Endoscopy System with the PillCam SB capsule may be used in the visualization and monitoring of lesions that may indicate Crohn's disease not detected by upper and lower endoscopy.
- The PillCam Capsule Endoscopy System with the PillCam SB capsule may be used in the visualization and monitoring of lesions that may be a source of obscure bleeding (either overt or occult) not detected by upper and lower endoscopy.
- The PillCam Capsule Endoscopy System with the PillCam SB capsule may be used in the visualization and monitoring of lesions that may be potential causes of iron deficiency anemia (IDA) not detected by upper and lower endoscopy.

The Suspected Blood Indicator (SBI) feature is intended to mark frames of the video suspected of containing blood or red areas.

The PillCam Capsule Endoscopy System with PillCam SB capsules may be used as a tool in the detection of abnormalities of the small bowel and is intended for use in adults and children from two years of age.

PillCam ESO

The PillCam Capsule Endoscopy System with PillCam ESO capsules is intended for the visualization of esophageal mucosa in adults and children from 18 years of age.

PillCam UGI

The PillCam UGI capsule endoscopy system is intended for visualization of the upper gastrointestinal tract (esophagus, stomach, duodenum). It may be used for visualization of blood in the upper gastrointestinal tract (esophagus, stomach, duodenum) in patients who are hemodynamically stable and at least 18 years of age.
PillCam COLON

The PillCam COLON 2 capsule endoscopy system is intended to provide visualization of the colon. It may be used for detection of colon polyps in patients after an incomplete optical colonoscopy with adequate preparation, and a complete evaluation of the colon was not technically possible.

Note
The procedure may involve intake of laxatives and prokinetic ("push") agents to aid in advancement of the capsule through the digestive tract. Refer to the labeling of these agents for their contraindications.

Contraindications

PillCam SB

The PillCam SB capsules are contraindicated for use under the following conditions:

- In patients with known or suspected gastrointestinal obstruction, strictures, or fistulas based on the clinical picture or pre-procedure testing and profile.
- In patients with cardiac pacemakers or other implanted electromedical devices.
- In patients with dysphagia or other swallowing disorders.

Note
The SB PillCam Capsule may be deployed by using transendoscopic delivery in patients who are either unable to ingest the PillCam capsule or are known to have slow gastric emptying time. Placement into the duodenum is recommended to prevent the patient from vomiting the capsule.

PillCam ESO/PillCam UGI

The PillCam ESO/PillCam UGI capsule is contraindicated for use under the following conditions:

- In patients with known or suspected gastrointestinal obstruction, strictures, or fistulas based on the clinical picture or preprocedure testing and profile.
- In patients with cardiac pacemakers or other implanted electromedical devices.
- In patients with dysphagia or other swallowing disorders.

Note
This device is not meant to replace upper endoscopy.

PillCam COLON

The PillCam COLON capsule is contraindicated for use under the following conditions:

- In patients with known or suspected gastrointestinal obstruction, strictures, or fistulas based on the clinical picture or pre-procedure testing and profile.
- In patients with cardiac pacemakers or other implanted electromedical devices.
Indications, Contraindications, Warnings, Cautions

- In patients with dysphagia or other swallowing disorders.
- In patients with allergies or known contraindication to the medications and preparation agents used in the procedure as described in the relevant instructions for use.

Adverse Events

Potential adverse events associated with the use of this device may include delayed or no excretion of the capsule, aspiration, obstruction, perforation, and mucosal injury or bleeding. In some instances, intervention is required to remove the capsule.

Warnings

**Warning**
PillCam capsules are MR unsafe.

**Procedure Related:**
- The absence of blood when performing an evaluation with the PillCam UGI video capsule does not exclude the presence of a significant bleeding site in the acute upper gastrointestinal (esophagus, stomach and duodenum).
- The PillCam COLON 2 capsule may be used for individuals after an incomplete optical colonoscopy with adequate preparation, and a complete evaluation of the colon, was not technically possible.
- A normal or negative capsule endoscopy examination does not exclude the possibility of colon polyps or colon cancer.
- A negative or normal result obtained by the PillCam video capsule does not exclude the presence of pathology and if symptoms persist, further evaluation should be performed.
- The safety of the PillCam SB capsule has not been established in children below two years of age.
- The safety of the PillCam ESO/PillCam UGI capsule has not been established in patients below age 18.
- The safety of the PillCam COLON capsule has not been established in patients below age 18.
- In a small number of cases, the PillCam COLON capsule used for Colon capsule endoscopy may not image the entire large bowel (colon) due to variations in patient GI motility. In the MA-204 study 104 (11.8%) subjects were excluded due to issues with the capsule procedure including 77 (8.7%) subjects with inadequate cleansing or short transit time for the capsule.
- If an adequate cleansing level is not achieved and the total transit time of the capsule is less than 40 minutes related, a repeat evaluation should be considered with the PillCam COLON capsule, or with alternative diagnostic modalities.
- The capsule should not be swallowed by children under the age of 8 years or patients where a concern for aspiration of the capsule exists (e.g., due to cognitive or neurological deficits or a history of aspiration). In these patients, it is recommended that a capsule endoscopic delivery
system be used to place the capsule directly in the duodenum. Placement of the capsule in the duodenum will decrease the risk of aspiration of the device [by vomiting] and gastric retention.

- Examine both video streams when viewing the results of a COLON capsule endoscopy.
- If intestinal fistulas, strictures, or stenosis are suspected, or the patient has had prior abdominal or pelvic surgery, the physician should consider performing an examination to ascertain patency for an object the size of the PillCam video capsule.
- A thorough understanding of the technical principles, clinical applications and risks associated with the PillCam system is necessary before using this product. Read the entire manual before using the system for the first time.
- To prevent the patient from being exposed to unforeseen risks during passage of any PillCam video capsule, make sure the patient thoroughly understands the procedure, and provide the patient with a copy of the Patient Instructions.
- A patient with known or suspected delayed gastric emptying (whether disease related or drug induced) could be at increased risk for incomplete PillCam capsule endoscopy of the small bowel or colon.
- When swallowing the capsule there is a possibility of choking on the capsule. If the patient exhibits any symptoms and/or clinical signs of choking (labored breathing, wheezing, involuntary coughing, etc.), the recommended first-aid procedure should be followed.
- If a child has accidentally swallowed any unused or spent PillCam video capsule, seek medical attention.
- Instruct the patient not to sit on bare metal surfaces, such as chairs with metal seating area, during the procedure.
- Instruct the patient to contact the physician immediately if, after ingesting any PillCam video capsule, there is any abdominal pain, nausea, or vomiting.
- Only one PillCam video capsule should be ingested at a time and only after confirmation that no other PillCam video capsules or ingestible diagnostic devices remain in the patient’s body.
- If, contrary to instructions, a patient ingests more than one PillCam video capsule, instruct the patient to immediately contact the physician.
- In patients with unsuspected strictures of the GI tract, any PillCam video capsule can potentially cause intestinal obstruction resulting in the need for hospitalization and surgery.
- The safety of this device in pregnant women has not been established.
- The safety of this device in patients with significant gastrointestinal diverticular disease is unknown.
- Final diagnosis based on the RAPID video should be made only by physicians who are trained in the interpretation of capsule endoscopy images.

**Product Related:**

- If there is reasonable doubt concerning the integrity of the PillCam video capsule due to dropping, biting, or any other eventuality, the capsule should be deactivated by returning it to its box and it should not be used until consulting with an authorized Given Imaging representative.
- Store all PillCam video capsules in a safe place, out of the reach of children and infants.
- Do not use any PillCam video capsule after its expiration date.
- Instruct the patient to avoid biting the PillCam video capsule prior to swallowing.
• Instruct the patient to wear the PillCam recorder throughout the procedure for as long as the PillCam recorder LED continues to blink at the ingested capsule's blinking rate.

• Review the time bar of the RAPID video to determine if video gaps exist, which may result in the need to repeat the capsule endoscopy procedure. This is important if the procedure results in a normal or negative capsule endoscopy examination.

• Occasionally, some images may be lost (less than 3% for COLON 2 and UGI procedures and less than 1% for SB procedures) which results in video gaps (shown as a gray section on the time bar display of the RAPID video) due to radio interference (e.g., from amateur radio transmitters, RFID (radio-frequency identification) systems, MRI). This may result in the need to repeat the capsule endoscopy procedure. In such a case, advise the patient to stay within the premises of the clinic for the duration of the second capsule endoscopy procedure to prevent this problem from recurring.

Electromagnetic Compatibility Related:

• After ingesting the PillCam video capsule and until it is excreted, the patient should not be near any source of powerful electromagnetic fields such as one created near an MRI device.

• Keep the magnet of the PillCam video capsule’s packaging away from implants such as pacemakers, defibrillators, nerve stimulators, and other devices that could be affected by proximity to a DC magnetic field.

• PillCam Capsule Endoscopy System and its components need special precautions regarding Electromagnetic Compatibility (EMC) to avoid loss of image transfer resulting in video gaps. PillCam Capsule Endoscopy System needs to be installed and put into service according to the Electromagnetic Compatibility (EMC) information provided in the accompanying documents.

• The use of the accessory with PillCam capsule other than those specified may result in increased emissions or decreased immunity of the PillCam capsule.

Recorder Related:

• A PillCam video capsule should be ingested only in the presence of authorized medical personnel. The patient should be instructed not to let relatives, neighbors or acquaintances use any PillCam video capsule without medical attention.

• If excretion of the PillCam video capsule from the patient has not been positively verified, and the patient develops unexplained post-procedure abdominal pain, vomiting, or other symptoms of obstruction, he/she should contact the physician for evaluation and possible abdominal X-ray examination.

• Never connect the PillCam recorder to the sensor array while the PillCam recorder is in its cradle.

• The PillCam video capsule and PillCam recorder should not be used adjacent to or stacked with other equipment and that if adjacent or stacked use is necessary, the equipment or system should be observed to verify normal operation in the configuration in which it will be used.

• Portable and mobile RF communications equipment can affect the PillCam video capsule and the PillCam recorder.

• The PillCam video capsule may be interfered with by other equipment, even if that other equipment complies with CISPR emission requirements.

• The Lithium-Ion battery pack in the PillCam recorder DR3 incorporates built-in safety devices.

• Do not use the PillCam recorder in a location where static electricity (greater than the manufacturer’s guarantee) may be present. Otherwise, the safety devices can be damaged, possibly leading to acid leakage, overheating, smoke emission, bursting and/or ignition.
Cautions

A caution indicates a condition that may damage the equipment.

- Make sure that only trained personnel, familiar with all of the PillCam Capsule Endoscopy System operating procedures, use the system.

- Endoscopic video capsule placement requires skill and experience in endoscopic esophageal intubations with an accessory device seated at the distal tip of the endoscope. Use of the device is not recommended if the clinician lacks the required experience and proficiency.

- Use the system only with components purchased from Given Imaging Ltd. Use of other components including power supply for the cradle, may damage the system and void the warranty.

- Occasionally, some images may be lost (less than 3% for COLON 2 and UGI procedures and less than 1% for SB procedures) which results in video gaps (shown as a gray section on the time bar display of the RAPID video) due to radio interference (e.g., from amateur radio transmitters, RFID (radio-frequency identification) systems, MRI). This may result in the need to repeat the capsule endoscopy procedure. In such a case, advise the patient to stay within the premises of the clinic for the duration of the second capsule endoscopy procedure to prevent this problem from recurring.

- In a small number of cases, the PillCam SB capsules used for Small Bowel Capsule Endoscopy may not image the entire small bowel due to variations in patient GI motility. Similarly the PillCam COLON capsule used for COLON Capsule Endoscopy may not image the entire large bowel (colon) due to variations in patient GI motility.

- Final diagnosis based on the RAPID video should be made only by physicians who are trained in the interpretation of capsule endoscopy images.

- The Lithium-Ion battery pack in the PillCam recorder DR3 incorporates built-in safety devices. Do not use the PillCam recorder in a location where static electricity (greater than the manufacturer’s guarantee) may be present. Otherwise, the safety devices can be damaged, possibly leading to acid leakage, overheating, smoke emission, bursting and/or ignition.

Benefits and Risks—PillCam Capsule Endoscopy

Benefits

- PillCam capsule endoscopy is the most widely used patient-friendly tool for visualization of the GI tract. To date, more than 2,000,000 patients worldwide have benefited from PillCam endoscopy.

- PillCam capsule endoscopy provides an alternative for those patients who have had an incomplete optical colonoscopy with an adequate preparation, and a complete evaluation of the colon was not technically possible.

- After the patient swallows the PillCam video capsule, images and data are transmitted wirelessly as the capsule passes through the digestive system. The images are captured and stored in a PillCam recorder worn by the patient; after the procedure is complete the images are reviewed by a physician.

- The procedure does not require sedation, intubation, bowel insufflation or radiation.

- Patients may continue with their normal daily activity during the procedure.
• PillCam capsule endoscopy offers a simple, safe and non-invasive alternative to traditional imaging procedures.

• The PillCam patency capsule provides a simple and convenient means to verify functional patency of the GI tract in patients with known or suspected strictures.

**Risks**

• A normal or negative capsule endoscopy examination does not exclude the possibility of colon polyps or colon cancer.

• PillCam capsule endoscopy is not for everyone. PillCam video capsules are contraindicated in patients with known or suspected gastrointestinal obstruction, strictures or fistulas, in patients with cardiac pacemakers or other implantable electromedical devices and in patients with swallowing disorders.

• Capsule retention has been reported in less than two percent of all capsule endoscopy and patency procedures. Capsule retention is defined as having a capsule remain in the digestive tract for more than two weeks.

• Causes of retention cited in the literature include: NSAID strictures, Crohn's disease, small bowel tumors, intestinal adhesions, ulcerations, and radiation enteritis. Summaries in published literature identify the overall risk of retention for capsule endoscopy to be 1.4%. The risk of retention for obscure bleeding is estimated to be 1.2%, for suspected Crohn's disease to be 2.6%, for known Crohn's the risk is higher at 5% and for neoplastic lesions the rate of retention is 2.1% as compared to healthy volunteers [1]. To verify passage of the capsule from the GI tract, an abdominal X-ray may be obtained at the discretion of the physician. The capsule can be removed using medical, endoscopic or surgical intervention.

• There is an extremely rare risk of capsule aspiration while patients are attempting to swallow a PillCam video capsule or Patency capsule.

• There is also a low risk of skin irritation from the sensor array sleeve adhesive or silicone exposure.

• The PillCam SB video capsule may be administered by using transendoscopic delivery in patients who are either unable to ingest the capsule or are known to have slow gastric emptying time. If using transendoscopic delivery potential complications include, but are not limited to: perforation, hemorrhage, aspiration, fever, infection, hypertension, respiratory arrest, cardiac arrhythmia or arrest, due to the transendoscopic procedure.

• PillCam patency capsules are contraindicated in patients with swallowing disorders. The PillCam patency scanner is contraindicated in patients with cardiac pacemakers or other implanted electromedical devices.

• All medical procedures carry some risks. Information on this site should not be used as a substitute for talking with your doctor about diagnosis and treatment.

**References:**

[1] Liao et al., Indications and detection, completion, and retention rates of small-bowel capsule endoscopy: a systematic review, Gastrointestinal Endoscopy, 2010; 71:280-286
Essential Performance

PillCam Video Capsules

**ON-Mode**
Data transmitting to PillCam recorder is considered to be essential performance of the PillCam capsules. The PillCam capsules shall transmit data continuously monitored by on-line image display as received by PillCam recorder.

**OFF-Mode**
No unintentional transmissions are allowed.

PillCam Recorder DR2 and PillCam Recorder DR3
Data receiving by PillCam recorder is considered to be essential performance of the PillCam recorder DR2 and PillCam recorder DR3.

Accuracy of the Device—SB

The PillCam Capsule Endoscopy System with the PillCam SB 1 capsule was studied in a series of 20 subjects with hemoccult positive stool, iron-deficiency anemia, and/or subacute hematochezia or melena. All patients had undergone unrevealing colonoscopy, gastroscopy, enteroscopy, and small bowel X-rays prior to enrolling in the study. When compared to repeated push enteroscopy, the PillCam video capsule was able to detect a pathological abnormality in 12 (60%) of the patients whereas enteroscopy detected abnormalities in 7 (35%) of these patients. The 5 patients in whom lesions were found by the PillCam video capsule but not enteroscopy all had abnormalities in the distal jejunum or ileum, outside the reach of most standard enteroscopy examinations. The average length of insertion during enteroscopy was 2.3 meters. Specific findings detected by the imaging system included arterio-venous malformations (AVMs), mucosal erosions and ulcerations, and a submucosal tumor. In one case (5%), though the PillCam video capsule detected a small bowel AVM that was found by enteroscopy, one out of the two reviewing physicians did not detect the AVM when reviewing the RAPID video.

Overall, the findings obtained from the PillCam Capsule Endoscopy System and standard enteroscopy agreed in 14 cases (70%). The two methods revealed similar pathologies in 6 of these patients. Both exams were normal in an additional 8 patients. [1]

A total of 14 separate small bowel findings were eventually noted in 13 patients by either of the two imaging modalities or by laparoscopic surgery. The PillCam Capsule Endoscopy System was able to identify 12 of the 14 lesions (86%) while the enteroscopy detected 7 of the 14 lesions (50%). Both repeated enteroscopies, small bowel X-rays and the PillCam video capsule, failed to detect an ulcerated Meckel’s diverticulum found at surgery.

PillCam video capsule localization is based on off-line processing of the strength of the radio frequency signals emitted from the PillCam video capsule as received by each of the eight sensors. The information helps estimate the relative two-dimensional location of the PillCam video capsule with respect to the umbilicus (e.g., abdominal quadrant).
The localization software was studied in a series of 17 healthy subjects. Multiple fluoroscopic images (92 sets) were obtained at various times during the PillCam video capsule's passage through the small bowel. The location was assessed in two dimensions relative to the umbilicus and then compared to the position obtained from the localization software. When compared to the relative two-dimensional location determined fluoroscopically, approximately 87% (80/92) of the PillCam video capsule estimates were within 6cm (a “fist”). The mean error for PillCam video capsule localization was found to be 3.8 cm. [2]

The Suspected Blood Indicator (SBI) feature is intended to mark frames suspected of containing fresh blood. The feature may be activated only after labeling the first duodenal image and marks frames contained only within the small bowel. The SBI feature should not serve as a substitute for a physician's complete viewing of the video but rather to provide supplemental information afterwards. All events marked by the SBI feature should be carefully reviewed by a physician. In a review of 27 patients with at least one red or bleeding lesion found by a physician on capsule endoscopy, the SBI feature correctly marked 439, or 88%, of the 498 individual lesions. In addition, a total of 561 false positive lesions were marked by the feature, giving a positive predictive value (PPV) of 44%. [3]

References:
[1] Clinical report presented in K010312
[2] Clinical report presented in K020341
[3] Clinical report presented in K022980
Accuracy of the Device—ESO

The PillCam Capsule Endoscopy System with the PillCam ESO 1 capsule was studied in a series of 107 subjects included in the study. Among patients included in this clinical study, 94 subjects had suspected GERD at the time of the study, and a small group (13 subjects) were diagnosed with Barrett’s prior to the study.

All patients underwent esophageal capsule endoscopy as well as esophagoscopy, to compare the results of the esophageal capsule endoscopy with conventional video EGD (imperfect standard) in assessing endoscopic findings of the esophagus.¹

<table>
<thead>
<tr>
<th>Rate of Agreement (95% CI)</th>
<th>Rate of False Pos (95% CI)</th>
<th>Rate of False Neg (95% CI)</th>
<th>Overall Agreement (95% CI)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esophagitis</td>
<td>85% (69%; 95%)</td>
<td>13% (4%; 27%)</td>
<td>12% (3%; 27%)</td>
</tr>
<tr>
<td>Suspected BE</td>
<td>81% (62%; 94%)</td>
<td>15% (6%; 30%)</td>
<td>15% (4%; 34%)</td>
</tr>
<tr>
<td>Normal</td>
<td>70% (53%; 83%)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVERALL</td>
<td></td>
<td></td>
<td>78.3% (69%; 86%)</td>
</tr>
</tbody>
</table>

The study was too small to accurately assess the agreement with lesions other than the most common findings—esophagitis and suspected Barrett’s esophagus. There were several other lesions which were noted as depicted in the table below.

<table>
<thead>
<tr>
<th></th>
<th># Cases Diagnosed by EGD</th>
<th># Cases correctly Diagnosed by CE</th>
<th>Agreement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hiatal Hernia</td>
<td>37</td>
<td>6</td>
<td>16%</td>
</tr>
<tr>
<td>Stricture</td>
<td>5</td>
<td>1</td>
<td>20%</td>
</tr>
<tr>
<td>Polyps/Nodules</td>
<td>3</td>
<td>0</td>
<td>0%</td>
</tr>
<tr>
<td>Varices</td>
<td>1</td>
<td>1</td>
<td>100%</td>
</tr>
</tbody>
</table>

Note
The PillCam ESO 1 capsule was not able to reliably identify:
• Precise location of lesion(s)
• Length or extent of lesion(s)
• Severity or grade of lesion(s)

¹.Clinical report presented in K041149
**Accuracy of the Device—UGI**

The PillCam Capsule Endoscopy System with the PillCam UGI capsule was evaluated in adults with acute upper gastrointestinal hemorrhage who were hemodynamically stable presenting to the emergency departments of two academic medical centers.

There were 49 patients enrolled in the clinical study of which 46 patients underwent an UGI capsule endoscopy (CE, PillCam ESO 2), and 47 patients underwent an upper endoscopy examination within 12 to 24 hours. One patient was unable to swallow the CE capsule. The results from the patients with completed CE examinations demonstrated the presence of blood in the upper gastrointestinal tract in 15 patients. The results of the EGD examination for the 15 patients with blood in the upper gastrointestinal tract included 8 (53%) patients with normal or non-clinically significant findings which included:

- Normal: \( n = 2 \)
- Hiatal hernia: \( n = 1 \)
- Esophagitis: \( n = 2 \)
- Gastritis/Duodenitis: \( n = 3 \)

There were 16 (35%) patients that had no evidence of blood in the upper gastrointestinal tract at the time of the CE examination, but had clinically significant lesions identified at the time of upper endoscopy examination which included:

- Mallory-Weiss tear: \( n = 1 \)
- Esophageal varices: \( n = 1 \)
- Gastric/Duodenal ulcers: \( n = 11 \)
- Gastric masses: \( n = 3 \)

The results are summarized in the below table [1]:

**Diagnosis and detection of gross blood by capsule endoscopy compared to EGD**

<table>
<thead>
<tr>
<th>No</th>
<th>Patient</th>
<th>Detection of Gross blood by Capsule endoscopy</th>
<th>Detection of Gross blood by EGD</th>
<th>Diagnosis Based on CE Findings</th>
<th>Diagnosis Based on EGD Findings</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>001SIT</td>
<td>No</td>
<td>No</td>
<td>Gastric Ulcer in antrum</td>
<td>Gastric Ulcer, Gastritis</td>
</tr>
<tr>
<td>2</td>
<td>002GBA</td>
<td>No</td>
<td>No</td>
<td>Duodenitis</td>
<td>Duodenal Ulcer, gastritis</td>
</tr>
<tr>
<td>3</td>
<td>003VSA</td>
<td>Yes</td>
<td>No</td>
<td>Normal</td>
<td>Normal</td>
</tr>
<tr>
<td>4</td>
<td>004KAY</td>
<td>Yes</td>
<td>Yes</td>
<td>Esophageal Varices</td>
<td>Esophageal Varices</td>
</tr>
<tr>
<td>5</td>
<td>005ZOV</td>
<td>No</td>
<td>No</td>
<td>Gastric Ulcer</td>
<td>Normal</td>
</tr>
<tr>
<td>6</td>
<td>006ROY</td>
<td>Yes</td>
<td>No</td>
<td>Coffee grounds</td>
<td>Gastritis, duodenitis</td>
</tr>
<tr>
<td></td>
<td>Patient ID</td>
<td>Found Gross Blood</td>
<td>Endoscopy Findings</td>
<td>Capsule Endoscopy Findings</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>------------</td>
<td>-------------------</td>
<td>-------------------</td>
<td>---------------------------</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>007MIV</td>
<td>No</td>
<td>No</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>008XKK</td>
<td>Yes</td>
<td>No</td>
<td>Coffee grounds</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>001-YN</td>
<td>No</td>
<td>No</td>
<td>Gastritis, duodenitis</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>002SLY</td>
<td>No</td>
<td>Yes</td>
<td>Esophageal Varices</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>003WLC</td>
<td>No</td>
<td>No</td>
<td>Gastritis</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>004YTL</td>
<td>No</td>
<td>No</td>
<td>Gastritis</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>005SCW</td>
<td>Yes</td>
<td>Yes</td>
<td>Gastric Ulcer</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>006WCL</td>
<td>Yes</td>
<td>Yes</td>
<td>Gastric Ulcer, duodenal AVMs</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>007SCC</td>
<td>No</td>
<td>No</td>
<td>Normal, Duodenum Ulcer</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>008NMP</td>
<td>Not applicable</td>
<td>Yes</td>
<td>Patient unable to swallow capsule</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>009CMT</td>
<td>No</td>
<td>No</td>
<td>Duodenal Ulcer, Duodenum Ulcer</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>010PSN</td>
<td>No</td>
<td>No</td>
<td>Normal, Esophageal nodule</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>011YYT</td>
<td>Yes</td>
<td>No</td>
<td>Duodenal Ulcer</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>012FYL</td>
<td>No</td>
<td>No</td>
<td>Erosive Esophagitis, Gastric Ulcer, Duodenal ulcer</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>013-SH</td>
<td>No</td>
<td>No</td>
<td>Normal, Gastritis</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>014MFN</td>
<td>Yes</td>
<td>No</td>
<td>Duodenitis, Esophagitis</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>015LKN</td>
<td>No</td>
<td>No</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>016CWK</td>
<td>No</td>
<td>No</td>
<td>Normal, Gastritis, Duodenitis</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>017SLW</td>
<td>No</td>
<td>No</td>
<td>Normal, Gastritis</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>018-HW</td>
<td>Yes</td>
<td>No</td>
<td>Gastric Ulcer, Gastric Ulcer</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>019SCN</td>
<td>No</td>
<td>No</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>020CSC</td>
<td>No</td>
<td>No</td>
<td>Gastric Ulcer</td>
<td></td>
</tr>
</tbody>
</table>

Diagnosis and detection of gross blood by capsule endoscopy compared to EGD.
### Diagnosis and detection of gross blood by capsule endoscopy compared to EGD

| 29 | 021CKH | Yes | Yes | Duodenum Ulcer | Gastric and Duodenal Ulcers |
| 30 | 022FKC | Yes | No | Blood in duodenum | Gastric Ulcer |
| 31 | 023YTP | No | No | Normal | Gastritis |
| 32 | 024KST | Yes | No | Coffee grounds in stomach & duodenum | Gastritis |
| 33 | 025FHL | Yes | No | Ulcer with overlying clot | Hiatal Hernia |
| 34 | 026KHW | Not applicable | Not applicable | Patient withdrew | Patient withdrew |
| 35 | 027SML | No | No | Normal | Gastric and Duodenal ulcers |
| 36 | 028KHN | No | No | Duodenal Ulcer | Gastric Ulcer |
| 37 | 029CTT | No | No | Gastric Ulcer | Gastritis |
| 38 | 030MLC | No | No | Duodenal Ulcer | Gastroduodenal ulcer |
| 39 | 031CKL | No | No | Normal | Gastritis, Esophagitis |
| 40 | 032KCL | No | No | Gastric Ulcer with visible vessel | Duodenal Ulcer |
| 41 | 033WLC | No | No | Esophagitis, gastritis, duodenitis | Esophagitis, gastritis, duodenitis |
| 42 | 034YCL | Not applicable | Not applicable | Patient withdrew | Patient withdrew |
| 43 | 035LNC | No | No | Normal | Gastric mass |
| 44 | 036SKH | Yes | No | Esophagitis and Duodenal Ulcer | Esophagitis |
| 45 | 037CYL | No | No | Erosive esophagitis, gastritis | Mallory-Weiss Tear |
| 46 | 038WSC | No | Yes | Normal | Gastric Ulcer |
| 47 | 039Y-F | No | No | Esophageal Varices, gastric and duodenal erosions | Esophageal Varices |
| 48 | 040WCL | No | No | Normal | Duodenal Ulcer |
The absence of blood when performing an evaluation with the PillCam UGI video capsule does not exclude the presence of a significant bleeding site in the acute upper gastrointestinal (esophagus, stomach and duodenum).

**Reference:**
Accuracy of the Device—COLON 2

Clinical Validation Study and Interpretation of Results

Evaluation of Capsule Endoscopy with PillCam COLON 2 in Visualization of the Colon (MA-204)

Study Design
A prospective, multi-center study (MA-204) was conducted to evaluate the clinical effectiveness of the PillCam COLON 2 (colon capsule endoscopy or CCE) device. The primary objective of the study was to compare CCE with optical colonoscopy (OC) for agreement on absence or presence of colon polyps (≥6 mm or ≥10 mm). There were a total of 17 enrollment sites; 11 were located in the US and 6 were located in Israel.

Study Design and Accountability
CCE was performed on subjects 6 weeks prior to their OC procedure in order for a central reader to interpret the CCE results prior to OC. In the initial phase of the study, colonoscopists were blinded to CCE results when evaluating their OC findings. The data analysis for this phase of the study is reported here.

A total of 884 subjects were enrolled using the following inclusion criteria:

- Subject is between the ages of 50 and 75 years
- Subject is classified as average risk per the American Gastroenterological Association (AGA) Guidelines on colorectal cancer (CRC) Screening (individuals without a personal or family history of CRC or adenomas, inflammatory bowel disease, or high-risk genetic syndromes).

Among the 884 subjects enrolled, 184 subjects were excluded from the effectiveness analysis. A total of 104 subjects (11.8%) were excluded due to issues related to the performance of the CCE including 77 (8.7%) that were excluded on the basis of an inadequate colon preparation prior to CCE or a rapid transit of the capsule through the colon. A total of 63 subjects withdrew from the study. Two subjects were excluded because of OC procedure violations. One site was terminated due to major protocol violations, accounting for 15 excluded subjects. The samples included in the study were average risk asymptomatic, first time screening patients undergoing colonoscopy. The use of CCE has not been evaluated in other populations.

A total of 700 subjects successfully completed an investigation with both CCE and OC and were included in the effectiveness analysis. The data analysis of the effectiveness of CCE was undertaken on a per subject basis. The comparison of CCE with OC was based on the presence or absence of at least one finding of a polyp of size in diameter (≥6 mm or ≥10 mm) identified on OC.

PillCam COLON 2 bowel preparation:
PillCam COLON 2 bowel preparation included administration of 4 Senna tablets, a clear liquid diet and administration of a purgative sulfate-free polyethylene glycol electrolyte lavage (SF-ELS) solution divided into two doses: the first dose on the evening before the exam (2 liters) and the second dose on the morning of the exam day (2 liters).

Following capsule ingestion and depending on capsule progression through the digestive tract, subjects were required to take a boost of an additional volume of laxative (SuPrep) in order to enhance capsule propulsion and maintain adequate cleansing of the colon. Per procedure progress, in case the capsule remained in the stomach more than an hour after ingestion a prokinetic medication may have been administered. Upon SB detection, a first boost of 6 ounces diluted to 16 ounces was administered. Unless the PillCam capsule was excreted, a second boost of 3 ounces diluted to 8 ounces may have been administered 3 hours after the first boost. If towards the end of the procedure (2 hours after the second boost) the capsule was not excreted, the subject was asked to take a 10mg Bisacodyl suppository according to package insert instructions. Subjects were allowed to eat 2 hours after suppository intake or after capsule excretion.

Subjects were encouraged to drink clear liquids such as water, isotonic drinks, tea or other pulp-free juices throughout their preparation and examination.

**Descriptive Analysis Sizes** of the largest colon polyp identified in a subject by OC and CCE, regardless of segmental location, were compared (Table 1). In particular, on OC 219 subjects were identified as having a colon polyp that measured 5 mm or less in diameter, 115 subjects were identified as having a colon polyp equal to or greater than 6 mm in diameter, but less than 10 mm in diameter, and 77 subjects were identified as having a colon polyp measuring at least 10 mm in diameter. The overall prevalence of subjects with any polyp found on OC was 58.7% (411/700). The prevalence of subjects found to have at least one polyp at least 6 mm in diameter was 27.4% (192/700), and the prevalence of subjects found to have at least one polyp at least 10 mm in size was 11.0% (77/700).

Among 115 subjects with a polyp identified on OC that was greater than 6 mm but less than 10 mm in diameter, CCE also identified 55 (47.8%) subjects with a polyp greater than 6 mm but less than 10 mm in diameter anywhere in the colon, and 19 (16.5%) subjects with a 10 mm in diameter sized polyp, for a total of 74 subjects (64.3%) with a CCE detected polyp of 6 mm or greater.

<table>
<thead>
<tr>
<th>Max CCE (mm)</th>
<th>Max OC (mm)</th>
<th>0&lt;OC&lt;6</th>
<th>6≤OC&lt;10</th>
<th>10≤OC</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>168</td>
<td>84</td>
<td>20</td>
<td>10</td>
<td>282</td>
</tr>
<tr>
<td>0&lt;6</td>
<td>90</td>
<td>71</td>
<td>21</td>
<td>12</td>
<td>194</td>
</tr>
<tr>
<td>6≤CCE&lt;10</td>
<td>18</td>
<td>52</td>
<td>55</td>
<td>18</td>
<td>143</td>
</tr>
<tr>
<td>10≤CCE</td>
<td>13</td>
<td>12</td>
<td>19</td>
<td>37</td>
<td>81</td>
</tr>
<tr>
<td>Total</td>
<td>289</td>
<td>219</td>
<td>115</td>
<td>77</td>
<td>700</td>
</tr>
</tbody>
</table>

Among 77 subjects with a polyp identified on OC that was greater than 10 mm in diameter, CCE identified a polyp anywhere in the colon less than 6 mm in diameter in 12 (15.6%) subjects, a polyp greater than 6 mm but less than 10 mm in diameter in 18 (23.4%) subjects, and a polyp measuring at least 10 mm in diameter in 37 (48.1%) subjects. Thus, CCE identified a total of 55 subjects (71.4%) with a polyp of 6 mm or greater. CCE failed to identify any polyp of 6 mm or greater in 22 (28.6%) subjects and any polyp of 10 mm or greater in 40 (51.9%) subjects.
Analysis of Agreement

Location-based and size-based analyses of the agreement of CCE with OC were conducted. Two polyp size thresholds, 6 mm and 10 mm, were considered for defining a subject as positive for a polyp. If one or more polyps were identified on OC, the polyp with the largest estimated diameter was used for comparison purposes and is referred to as the ‘reference’ polyp. The colon segment location of the reference OC polyp was determined and recorded as the cecum, ascending colon, transverse colon, descending-sigmoid colon or rectum. The largest polyp identified on CCE within the same or an adjacent segment location of the “reference OC” polyp was used to determine agreement with OC based on a size-matching algorithm. If there were two polyps of equal size that were “the largest” and located in different segments of the colon, the location and size-matching algorithm was repeated on each of these reference OC polyps to determine agreement of CCE with OC. In such instances, the reference OC polyp chosen for the final determination was the one that was in favor of the device. A full description of the location and size-matching algorithm is given in the Appendix.

For each subject, the CCE evaluation was classified into one of four categories of agreement with OC: true positive (TP) agreement, false negative (FN) disagreement, false positive (FP) disagreement, or true negative (TN) agreement. Letting TP, FN, FP, and TN denote the number of subjects that fall into these categories (Table 2), the estimates of positive percent agreement (PPA) and negative percent agreement (NPA) of CCE with OC are defined as follows:

\[
PPA = 100 \times \frac{TP}{(TP+FN)}
\]

\[
NPA = 100 \times \frac{TN}{(FP+TN)}
\]

Table 2: Format for reporting agreement results in a 2 x 2 categorical table

<table>
<thead>
<tr>
<th>CCE</th>
<th>OC</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>negative</td>
<td>positive</td>
</tr>
<tr>
<td>negative</td>
<td>TN</td>
<td>FN</td>
</tr>
<tr>
<td>positive</td>
<td>FP</td>
<td>TP</td>
</tr>
</tbody>
</table>

Tables 3 and 4 display the observed 2 by 2 categorical data when, respectively, 6 mm and 10 mm are used as the size thresholds for defining a subject as positive for a polyp. From these data tables, PPA and NPA are estimated along with their 95% confidence intervals (Table 5).

Table 3: Observed Categorical Data, 6 mm Threshold

<table>
<thead>
<tr>
<th>CCE</th>
<th>OC</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>negative</td>
<td>positive</td>
</tr>
<tr>
<td>negative</td>
<td>413</td>
<td>60</td>
</tr>
<tr>
<td>Positive</td>
<td>95</td>
<td>132</td>
</tr>
<tr>
<td></td>
<td>508</td>
<td>192</td>
</tr>
</tbody>
</table>
Table 4: Observed Categorical Data, 10 mm Threshold

<table>
<thead>
<tr>
<th>CCE</th>
<th>OC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>negative</td>
</tr>
<tr>
<td>negative</td>
<td>579</td>
</tr>
<tr>
<td>positive</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>623</td>
</tr>
</tbody>
</table>

Table 5: Percent Agreement of CCE with OC

<table>
<thead>
<tr>
<th>Percent Agreement</th>
<th>Polyp Size Threshold</th>
<th>6 mm</th>
<th>10 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positive Percent Agreement (95% CI) &lt;sup&gt;a&lt;/sup&gt;</td>
<td>≥ 6 mm</td>
<td>68.8% (132/192) (61.7%, 75.2%)</td>
<td>64.9% (50/77) (53.2%, 75.5%)</td>
</tr>
<tr>
<td>Negative Percent Agreement (95% CI) &lt;sup&gt;a&lt;/sup&gt;</td>
<td>≥ 6 mm</td>
<td>81.3% (413/508) (77.6%, 84.6%)</td>
<td>92.9% (579/623) (90.6%, 94.8%)</td>
</tr>
</tbody>
</table>

<sup>a</sup> 95% CI based on Clopper Pearson

Using the 6 mm or greater sized polyp threshold, the positive and negative percent agreements of CCE with OC were, respectively, 68.8% (132/192, 95% CI 61.7-75.2%) and 81.3% (413/508, 95% CI 77.6-84.6%). Using the 10 mm or greater sized polyp threshold, the positive and negative percent agreements were 64.9% (50/77, 95% CI 53.2-75.5%) and 92.9% (579/623, 95% CI 90.6-94.8%).

Following the completion of a colonoscopy when the polyp detected on CCE was not identified, the results of the CCE evaluation were unblinded and the colonoscopy was repeated in a second attempt to identify the polyp identified on CCE. The unblinded colonoscopy results for the ≥6 mm threshold showed a 1% and 3% increase in the positive and negative percent agreement values, respectively. The unblinded colonoscopy results for the ≥10 mm threshold showed a 1% increase in the positive and negative percent agreements.<sup>i, ii</sup>

<sup>i</sup> Five of ninety-five patients who per protocol should have undergone a second OC procedure were determined not to require it by the physician.

<sup>ii</sup> The reported positive and negative percent agreement of the unblinded analysis are potentially biased because OC was repeated only on those patients with an initial CCE false positive finding and not also on those patients with an initial CCE true negative finding based on the blinded OC evaluation.
Safety

Only one (0.1%) case (out of 884 cases) was reported within this study as a serious adverse event (abdominal pain related to OC procedure). The event resolved the following day.

A total of 142 non-serious adverse events related to the study occurred in 101 (11%) out of 884 subjects.

- Three adverse events were reported as related to the capsule procedure and resolved within the same day (i.e., severe gagging reflex and mild vomiting and abdominal cramping).
- Eleven adverse events were reported as related to the colonoscopy procedure as follows:
  - 6 moderate adverse events, out of which 5 occurred in the same subject and resolved within the same day (i.e., fever, headache, abdominal pain, bloating and nausea); a second subject suffered from moderate abdominal pain that resolved within 3 days.
  - 5 mild adverse events resolved within 8 days (i.e., abdominal pain / cramping (3 cases), fever and bleeding-old blood).

The remaining 128 adverse events were reported as related to the colon preparation (prior to CE and optical colonoscopy procedures).

Appendix

Definitions of categories of subject level agreement of CCE with OC used in location- and size-based agreement analysis

Agreement Analysis, polyp size threshold 6 mm

When no OC polyp ≥ 6 mm was detected, a CCE finding of no polyp ≥ 6 mm would be a True Negative finding. A CCE finding of a polyp ≥ 6 mm anywhere in the colon would be a False Positive finding.

When an OC polyp ≥ 6 mm was detected, a CCE polyp that was within the range of 50% smaller diameter or any size larger in diameter, and located in the same or an adjacent colon segment would be a True Positive finding. When an OC polyp ≥ 6 mm was detected, a CCE polyp that was below the 50% smaller diameter in the same or an adjacent colon segment would be a False Negative finding. An exception was made in the situation where an OC polyp ≥ 20 mm and a CCE polyp ≥ 10 mm were identified in the same or an adjacent colon segment. This was also considered a True Positive finding.

Agreement Analysis, polyp size threshold 10 mm

The same algorithm would apply for an OC polyp ≥ 10 mm in terms of determining True Positive, True Negative, False Positive and False Negative findings.

The use of the 50% margin of error rule for the comparison of the diameter of colon polyps as estimated by both OC and CCE was incorporated into this study analysis in order to be consistent with the two other published clinical trials comparing the PillCam COLON 2 device and optical colonoscopy.¹ ²

---

Table 6: Examples of Subject Level Classifications

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>cecum</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>ascending</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>transverse</td>
<td>5</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>desc-sigmoid</td>
<td>-</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>rectum</td>
<td>20</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject Level classification: FN FN

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>cecum</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>ascending</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>transverse</td>
<td>5</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>desc-sigmoid</td>
<td>-</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>rectum</td>
<td>8</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject Level classification: TP TN

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>cecum</td>
<td>-</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>ascending</td>
<td>9</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>transverse</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>desc-sigmoid</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>rectum</td>
<td>11</td>
<td>5</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject Level classification: FN FN

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>cecum</td>
<td>-</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>ascending</td>
<td>9</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>transverse</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>desc-sigmoid</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>rectum</td>
<td>9</td>
<td>54</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject Level classification: TP TN
Table 6: Examples of Subject Level Classifications

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>cecum</td>
<td>-</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>ascending</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>transverse</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>desc-sigmoid</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>rectum</td>
<td>5</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject Level classification: FP, TN

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Cecum</td>
<td>-</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ascending</td>
<td>-</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Transverse</td>
<td>-</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>desc-sigmoid</td>
<td>-</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>rectum</td>
<td>5</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject Level classification: TN, TN

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>cecum</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>ascending</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>transverse</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>desc-sigmoid</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>rectum</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject Level classification: TN, TN

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>cecum</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>ascending</td>
<td>30</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>transverse</td>
<td>-</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>desc-sigmoid</td>
<td>9</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>rectum</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject Level classification: TP, TP

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>cecum</td>
<td>25</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 6: Examples of Subject Level Classifications

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>ascending</td>
<td>-</td>
<td>60</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>transverse</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>desc-sigmoid</td>
<td>-</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>rectum</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject Level classification: TP  TP

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>cecum</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>ascending</td>
<td>8</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>transverse</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>desc-sigmoid</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>rectum</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject Level classification: TP  FP

<table>
<thead>
<tr>
<th>Subject</th>
<th>Segment</th>
<th>OC max Polyp Size</th>
<th>CCE max Polyp Size</th>
<th>CCE Classification for 6 mm threshold</th>
<th>CCE Classification for 10 mm threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>cecum</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>ascending</td>
<td>-</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>transverse</td>
<td>18</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>desc-sigmoid</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>rectum</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Subject Level classification: FN  FN

a. OC index polyps appear in bold face
Published Studies

There have been two published studies utilizing PillCam COLON 2 which are summarized below. The statistical analysis performed on the two published studies below is different from the FDA clinical study presented above (Evaluation of Capsule Endoscopy with PillCam COLON 2 in Visualization of the Colon (MA-204)).

Prospective multicenter performance evaluation of the second-generation colon capsule compared with colonoscopy

This trial was conducted in Israel by Eliakim et al to evaluate the ability of the PillCam COLON 2 capsule endoscopy system to detect polyps and other pathologies in the colon. A total of 104 patients were enrolled using the following inclusion criteria:

1. Subject is between the ages of 18 and 57 years
2. Subject is able and agrees to sign the Informed Consent Form
   - Subject was referred to colonoscopy for at least one of the following reasons:
     - Colorectal cancer screening
     - Clinical symptoms such as: rectal bleeding, hematochezia, melena, positive fecal occult blood test (FOBT), recent change of bowel habits, or diarrhea/constipation of recent onset
     - Positive findings in the colon on a GI radiographic study
     - Personal history of colorectal cancer (CRC) or adenomatous polyps and at least 5 years since last conventional colonoscopy

Patients were excluded from the study for the standard contraindications for small bowel capsule endoscopy such as:

1. Dysphagia,
2. Life threatening conditions,
3. Use of a pacemaker,
4. Current pregnancy,
5. Use of nonsteroidal anti-inflammatory drugs (NSAIDs), or
6. Contraindications to bowel preparation and prokinetic agents used in the study.

98 patients were included in the accuracy analysis with 66% males and 34% females at an average age of 49.8 years (18-57). For the detection of patients with polyps ≥6 mm, a true positive result was considered when at least one polyp equal to or larger than 4 mm was identified by PillCam COLON 2 and at least one polyp equal to or larger than 6 mm was identified by colonoscopy. For the detection of patients with polyps ≥10 mm, a true positive result was considered when at least one polyp equal to or larger than 7 mm was identified by PillCam COLON 2 and at least one polyp equal to or larger than 10 mm was identified by colonoscopy.

---

The accuracy of the PillCam COLON 2 capsule endoscopy system for patients with polyps is listed in the table below:

<table>
<thead>
<tr>
<th>Accuracy</th>
<th>≥ 6 mm</th>
<th>≥ 10 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sensitivity % (95% CI)</strong></td>
<td>89% (70%-97%)</td>
<td>88% (56%-98%)</td>
</tr>
<tr>
<td><strong>Specificity % (95% CI)</strong></td>
<td>76% (72%-78%)</td>
<td>89% (86%-90%)</td>
</tr>
</tbody>
</table>

Second-generation colon capsule endoscopy compared with colonoscopy

This trial was conducted in eight European sites by Spada et al to assess the ability of the PillCam COLON 2 capsule endoscopy system to detect polyps and other pathologies in the colon. A total of 117 patients were enrolled using the following inclusion criteria:

1. Subject is between the ages of 18 and 80 years

2. Subject is referred to colonoscopy for at least one of the following reasons:
   - Colorectal cancer screening,
   - Clinical symptoms such as: rectal bleeding, hematochezia, melena, positive FOBT, recent change of bowel habits for age ≤50,
   - Positive findings in the colon (e.g. Polyp ≥ 10mm), or
   - Personal history of significant polyps (≥ 6 mm) that were removed 3 or more years previously.

Patients were excluded from the study for the following reasons:

1. Dysphagia or any swallowing disorder,

2. Congestive heart failure,

3. Allergy or other known contraindication to the medications used in the study,

4. An increased risk for capsule retention (i.e. Crohn’s disease, previous abdominal surgeries, ongoing nonsteroidal anti-inflammatory drug use), or

5. Cardiac pacemaker or other implanted electromedical device.

109 patients were included in the accuracy analysis with 59% males and 41% females at an average age of 58.0 years (26-79). For a given polyp to be considered a match between PillCam COLON 2 and colonoscopy, it had to be assessed within 50% of the size of the largest estimate of the two studies and as appearing within the same colon segment or in adjacent segments. Following the polyp-match algorithm, for a patient to be considered to be a true-positive at least one polyp in a given size category (i.e., equal to or larger than 6 mm or equal to or larger than 10 mm), had to be present in PillCam COLON 2 and colonoscopy reports.

The accuracy of the PillCam COLON 2 capsule endoscopy system for patients with polyps is listed in the table below:

<table>
<thead>
<tr>
<th>Accuracy</th>
<th>≥ 6 mm (95% CI)</th>
<th>≥10 mm (95% CI)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensitivity %</td>
<td>84% (74%–95%)</td>
<td>88% (76%–99%)</td>
</tr>
<tr>
<td>Specificity %</td>
<td>64% (52%–76%)</td>
<td>95% (90%–100%)</td>
</tr>
</tbody>
</table>
What is PillCam Capsule Endoscopy?

The PillCam capsule endoscopy procedure is a process that enables minimally invasive visualization of the GI tract using an ingestible video capsule. The video capsule captures images that are later presented to the physician for review and interpretation.

The PillCam Capsule Endoscopy Process

The PillCam capsule endoscopy (CE) process consists of the following steps:
- Preparing the patient and the system for the ingestion of the capsule
- Performing the capsule endoscopy procedure
- Video creation
- Video review and interpretation

PillCam Capsule Endoscopy System Components

The PillCam capsule endoscopy (CE) system components that support the PillCam capsule endoscopy process consist of the following:
- PillCam capsules, which acquire pictures of the gastrointestinal tract and transmit them to the PillCam recorder.
- PillCam recorders with PillCam sensors, which receive and store the images collected during the procedure for subsequent video creation with the RAPID software.
- RAPID software, which processes and transforms the raw image data stored in the recorder into a conveniently viewable RAPID video and allows review of the RAPID video.

PillCam Capsules

PillCam capsules are video cameras designed specifically for imaging the intestinal tract. Each capsule is equipped with a tiny battery, a transmitter with antenna, and LEDs (light-emitting diodes) for each video camera head. These components are enclosed in a biocompatible plastic casing. A capsule is about the size of a large vitamin pill.
There are three PillCam capsule types, supported by the current PillCam capsule endoscopy system. Each is optimized for a different bowel segment, some with one video head and some with two video heads:

PillCam SB capsules: small bowel

PillCam ESO/UGI capsules: esophagus and upper GI

PillCam COLON capsule: colon

PillCam SB capsules contain one video camera. PillCam SB 1 is a fixed frame rate first generation capsule, PillCam SB 2 is a fixed frame rate second generation capsule, while PillCam SB 3 is a third generation capsule with enhanced imaging capabilities with adaptive frame rate (AFR).

PillCam ESO/UGI capsules contain two video cameras (one at each end) with prolonged operation time and adaptive frame rate.

PillCam COLON capsules contain two video cameras (one at each end). The PillCam COLON 2 capsule has enhanced imaging capabilities with adaptive frame rate (AFR).

After activation and ingestion, the capsule is propelled by peristalsis through the gastrointestinal tract. During this process, the video cameras acquire images and the transmitter sends them, via the sensors, to the PillCam recorder for storage.

For full technical specifications of PillCam capsules, see System Specifications on page 217. For indications and contraindications, see Indications, Contraindications, Warnings, Cautions on page 3.

Caution

The PillCam capsule transmits at a specific frequency of 434.1MHz in a bandwidth of ± 10MHz. Occasionally, interference from external devices transmitting in the same bandwidth may occur that may interrupt or limit the effective performance of the capsule transmission.

The following possible cases could occur:

• Car or house alarm: These operate with momentary transmissions. Depending on the proximity of the car or house alarm transmitter to the ingested capsule, there could be a momentary interference that should not damage the capsule video.

• Police/Fire stations radio equipment: These may operate with more extended transmission durations. Depending on the proximity of the car or house alarm transmitter to the ingested capsule, this could cause longer duration interference, possibly causing gaps in the capsule video.
Handling the PillCam Capsule

PillCam capsules are packaged using a controlled process that ensures the capsule is activated only when needed. Each PillCam capsule is packed in a separate box with an embedded magnet that prevents it from activating when it is handled in the box prior to ingestion.

To avoid accidental activation (blinking) of the capsule while in its box, please observe the following:

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Keep the PillCam capsules in their box until use.</td>
</tr>
<tr>
<td>• Store the PillCam capsules only in the packaging supplied with the product.</td>
</tr>
<tr>
<td>• Do not use a PillCam capsule if the packaging is damaged.</td>
</tr>
<tr>
<td>• Keep the capsule package away from strong magnetic fields (such as MRI devices).</td>
</tr>
<tr>
<td>• Stack PillCam capsule boxes with the clear lid facing up only; never stack capsule boxes lid to lid.</td>
</tr>
<tr>
<td>• Keep metal objects away from the lid of the capsule box.</td>
</tr>
<tr>
<td>• For procedures involving the visualization of the colon: After ingesting the PillCam COLON capsule, instruct the patient not to sit on bare metal surfaces, such as chairs with a metal sitting area, during the procedure.</td>
</tr>
</tbody>
</table>

PillCam Recorders

The PillCam recorder is a compact battery-operated unit worn by the patient during the procedure. It receives and stores the image data transmitted by the PillCam capsule. There are two models currently available: PillCam recorder DR3 and PillCam recorder DR2.

The PillCam recorder is supplied with a pouch to wear over the shoulder and with an adjustable strap to secure to the waist.
**PillCam Sensors**

The PillCam sensors are physical receptors that receive transmission data from the PillCam capsule and transfer it to the PillCam recorder. These sensors are placed on the patient as a sensor belt or a sensor array:

- **PillCam sensor belt**: The sensor belt is worn around the patient’s waist over a thin shirt.
- **PillCam sensor array**: The sensors of the sensor array are attached to the patient's skin. The sensor locations depend on the procedure type. Each sensor consists of a flexible printed circuit board (PCB) and is attached with a disposable, medical adhesive sleeve.

The PillCam sensor array and belt are connected to the PillCam recorder by a flexible cable.

**Note**
The PillCam Capsule Endoscopy System does not contain any natural rubber latex components.

**RAPID for PillCam Software**

The RAPID for PillCam software (RAPID v8.3) supports the PillCam capsule endoscopy procedure by providing access to the different steps in the PillCam capsule endoscopy procedure via the Home screen.

**Home Screen**

After starting the RAPID v8.3 software, the Home screen appears. The Home screen is the main screen that provides access to all phases of the PillCam capsule endoscopy procedure.

The Home screen enables the following functions:

- **Patient Check-in**: Admitting the patient and initializing PillCam recorder.
- **Recorder Download**: Creating the RAPID video.
- **View Study**: Viewing videos and allowing interpretation as well as generating capsule endoscopy report (see *Reviewing and Interpreting RAPID Videos* on page 97).
Note
Certain key functions described in this manual are accessed from the Home screen. All future mention of Home screen, such as From the Home screen, click the Tools button refers to the screen described above.

1 Patient Check-in: Opens the patient check-in wizard to enter information about the patient and the procedure and to initialize the PillCam recorder with this data. There are a series of screens that walk you through the check-in process (see Performing Patient Check-in on page 43).

2 Recorder Download: Opens a screen to download data from a PillCam recorder (see PillCam Recorder Download on page 89) and to create a RAPID video from the data.

3 View Study: Clicking this button opens a menu that provides access to:
   • Study Manager: Allows easy access to all studies. The Study Manager allows you to open, search, sort, delete, and export studies (see Using the Study Manager on page 107).
   • Open Video: Open a saved RAPID video and findings, if available, by opening a windows screen that enables you to locate the RAPID video.
   • Recent Videos: Displays recently viewed RAPID videos that can be selected and opened.
4 **Tools**: Clicking this button opens a menu that provides access to:
   - **Regimen Manager**: Opens a software tool for creating or modifying capsule ingestion regimen instructions for the patient (see *Regimen Manager* on page 183).
   - **Settings**: Enables user configuration of RAPID settings (see *RAPID Settings* on page 170).
   - **Atlas**: Opens an atlas of typical disease images searchable by key descriptors and used as a viewing aid for comparing study images with reference images (see *RAPID Atlas* on page 153).
   - **Delete Videos**: Delete a RAPID video folder and its contents (see *Freeing Space on Your Computer* on page 195).
   - **User Dictionary**: Import or export term dictionary used in writing comments and study summary.

5 **Help**: Clicking this button opens a menu that provides access to:
   - **Help**: Selecting *Online Help* in the submenu opens a searchable PDF version of this user manual. Selecting *Help Center* will direct you to the RAPID Help Center. The Help Center provides quick references for *How to* questions and additional tools including video clips and step-by-step demonstrations to facilitate learning of Capsule Endoscopy procedures and the RAPID software.
   - **Customer Support**: The menu provides a link to Given Imaging contact information for customer support (see *Customer Support Section* on page 182), an option to collect analysis files and to show the RAPID log.

6 **Exit**: Closes the RAPID software.

RAPID software is supplied as:
- **Software only**: Installs on your PC.
- **RAPID workstation**: Dedicated PC with RAPID pre-installed.
• **RAPID Reader**: A limited version of the software; all RAPID features are available except for creating videos.

![Note]

- Your version of RAPID may include multiple types of RAPID (for example, full software to install on your PC plus copies of RAPID Reader to install on multiple PCs used only for video review and reporting).
- You cannot install RAPID Reader on a PC on which RAPID was already installed.

Throughout this manual, RAPID implies any version unless specifically noted.

![Note]

Videos created using capsule procedures prior to PillCam SB 2 can be viewed in RAPID v8.3. RAPID v8.3 does not support patient check-in for these earlier capsule types.

Before using the RAPID software, you must configure and personalize it. Refer to *Configuring RAPID Software* on page 169 for more details.
Prepared the Patient

Preparing for PillCam Capsule Endoscopy

This chapter covers the following tasks, which must be performed before administering a PillCam capsule:

- Preparing the patient (see Preparing the Patient on page 37)
- Preparing the equipment (see Preparing the Required Equipment on page 38)
- Creating patient instructions for the procedure (see Creating Patient Instructions for the Procedure on page 40)
- Performing patient check-in (see Performing Patient Check-in on page 43)
- Fitting Equipment on patient (see Fitting Equipment on the Patient on page 51)

Preparing the Patient

Once it is decided that the patient should undergo capsule endoscopy:

1. Verify that no contraindications apply to the patient (see Indications, Contraindications, Warnings, Cautions on page 3).

2. Inform the patient:
   
a. Inform the patient of the small possibility of bowel obstruction.

    b. Inform the patient of the importance of a clean bowel for the success of his or her PillCam examination.

    c. Instruct the patient what to expect before, during, and after the procedure.

    d. Instruct the patient on the proper use of the PillCam recorder:

       • The patient must treat the PillCam recorder with care. Avoid any sudden movements. Avoid bumping it.

       • The patient should not remove or disconnect the PillCam recorder at any time during the procedure.

       • The patient should contact the medical staff if the PillCam recorder is blinking red or white.

       • The patient must follow the dietary instructions from the medical staff or when alerted by the PillCam recorder.

    e. If the patient experiences any abdominal pain, nausea, or vomiting after ingesting the PillCam capsule, the patient should immediately inform the medical staff.

    f. After ingesting the PillCam capsule and until it is excreted, the patient should not go near any source of a powerful electromagnetic field, such as one created near an MRI device and should avoid direct exposure to bright sunlight.

    g. If the patient experiences any post-procedure abdominal pain, vomiting, or other unexplained symptoms and PillCam capsule excretion cannot be verified, the patient should contact the physician for evaluation and possible abdominal X-ray procedure.
h. Instruct the patient to contact the medical staff if one of the adhesive sleeves detaches from the patient's body.

i. For procedures involving visualization of the colon: use the Regimen Manager to create and select pre- and post-ingestion instructions (see Regimen Manager on page 183); print for the patient and explain.

3. Obtain the patient’s informed consent.

4. Before the procedure, remind the patient about how to prepare for the procedure. Remind them about appropriate clothing:
   - If using the sensor belt, upper garment of thin, natural fiber cloth that is long enough to reach at least to hip level and will not ride up above the belt.
   - If using the sensor array, loose-fitting, two-piece opaque clothing.

Preparing the Required Equipment

Before the patient arrives for the procedure, verify that the following equipment and accessories are available:

- RAPID (installed, configured, and open after accepting the license agreement)
- PillCam capsule (ESO/UGI, SB, COLON)
- PillCam recorder
- PillCam recorder pouch with shoulder strap
- Printed instructions for the patient
- Prepared PillCam sensor belt or PillCam sensor array with sensors already inserted in sleeves
- Sensor Location Guide (ESO/UGI, SB, SB Pediatric, or COLON) if you are using a sensor array
- Water and drinking cup
- Any medication prescribed for the patient during the procedure

Connecting the PillCam Recorder to RAPID for Check-in

The PillCam recorder must be connected to RAPID during patient check-in. The check-in process allows entering patient and procedure data for the procedure and saves the correct patient and procedure information to the PillCam recorder. The process is explained in detail in this section.

The PillCam recorder connects to the RAPID workstation or Personal Computer (PC) via the cradle.

Caution
Connection of the PillCam recorder to the RAPID software for patient check-in, video download, and recorder upgrade must be done using the cradle.

1. Make sure RAPID is On.

2. Make sure the PillCam recorder is firmly inserted into the cradle.
3. Click **Patient Check-in** on the RAPID Home screen.

   ![RAPID Home screen](image)

   **Note**
   - When the DR3 battery approaches 400 cycles, RAPID will display a warning. Contact customer service for a replacement battery when this battery warning appears, or when the battery reaches 3 years of service, whichever occurs first.
   - Do not remove the PillCam recorder from its cradle before the end of the check-in process.

4. In the **Procedures** screen, select the **Recorders** tab.

   ![Procedures screen](image)

5. Click the Recorder bar to connect the function buttons to the PillCam recorder:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identify Recorder</td>
<td>Identifies the PillCam recorder for the selected recorder bar. When you click this button, all the LEDs on the associated PillCam recorder and cradle blink.</td>
</tr>
<tr>
<td>Check-in Patient</td>
<td>Prepares the PillCam recorder for the capsule endoscopy procedure by entering patient data.</td>
</tr>
</tbody>
</table>
Creating Patient Instructions for the Procedure

Patient Instructions are handouts used to guide the patient in preparing for the PillCam capsule endoscopy procedure.

Note
When performing check-in with RAPID v8.3, video download must be done using RAPID v8.3.

Pre-ingestion Instruction Handouts

PillCam SB procedure goes with predefined pre-ingestion instruction text.

PillCam ESO/UGI procedure also goes with predefined pre-ingestion instruction text.

PillCam COLON procedures go with customizable pre-ingestion instructions that can be created by the physician using the Regimen Manager tool. In general, pre-ingestion bowel preparation for PillCam capsule endoscopy of the colon includes cessation of iron supplement intake several days before capsule ingestion, then adherence to a Clear Liquid Diet starting from at least a full day before capsule ingestion, to be followed by customizable laxative intake with water at least the evening before ingestion as well as the morning of ingestion. All these instructions including the customized laxatives are embedded in the pre-ingestion regimen instructions.

Pre-ingestion instructions for the respective PillCam procedures are printed and given to the patient before the day of the procedure.
Post-ingestion Instructions for Procedures Involving Colon Visualization

In general, the post-ingestion instructions should result in the preservation of proper cleanliness of the colon during the procedure and also facilitate the timely progress of the PillCam COLON capsule in the colon to visualize the entire colon before capsule burn-out or excretion. This is achieved by instructing the patient in real-time during the procedure to conditionally follow a set of instructions involving timely ingestion of prokinetics and laxatives. The post ingestion instructions are grouped in a regimen that is selected by the physician from a library of possible regimens and are loaded into the PillCam recorder DR3 during patient check-in (see Performing Patient Check-in on page 43) and they are also printed out in a handout to the patient. During the PillCam COLON procedure, the PillCam recorder DR3 alerts the user to perform the instructions detailed in the corresponding post-ingestion instructions handout.

The post-ingestion instructions, i.e. a regimen, consists in general of the following conditional instructions:

- Continue fasting until capsule leaves the stomach.
- If capsule is delayed in stomach, ingest a customized prokinetic agent.
- Intake the first *boost* laxative dose (and water when necessary) directly after capsule leaves the stomach.
- Intake the second *boost* laxative dose (and water when necessary) 2 - 4 hours after the capsule leaves the stomach.
- Eat a light meal (depending on capsule progress) 1 - 3 hours after second laxative.
- Take a suppository 1 - 2 hours after the meal (if required).

The execution of these instructions in a regimen is triggered by appropriate alerts from the PillCam recorder which senses the fulfillment of the conditions for the respective instructions and cues the patient during the procedure to refer to the associated instruction and execute it.

The difference between the regimens is in the use of specific laxative and prokinetic materials as well as some timing differences associated with these different materials.

It may happen that the execution of the instructions, some of which drive the capsule through the gastrointestinal tract, needs to be delayed until the patient reaches suitable environment for the intake of the associated laxatives. Such a case is when the ingestion is at the physician's office but the rest of the procedure may take place at the patient's home. Under such circumstances, it is desirable to delay the *capsule-driving* instructions until the patient reaches home. The setting for delay of prompting by alerts may be achieved by appropriate programming of the PillCam recorder DR3, either through check-in (see Performing Patient Check-in on page 43) or through direct programming before capsule pairing (see Setting Delay First Instruction in PillCam Recorder on page 79).

The Regimen Manager tool enables the creation and editing of post-ingestion patient instructions for colon procedures.

Refer to the Regimen Manager section (Regimen Manager on page 183) to familiarize yourself with this tool.

For pre-capsule ingestion regimen refer to Pre-ingestion Instruction Handouts on page 40, and for post-capsule ingestion regimen, refer to Post-ingestion Instructions for Procedures Involving Colon Visualization on page 41.
General Patient Guidelines During the Procedure

Make sure that the patient has the printed post-capsule ingestion instructions or patient instructions with your contact information included, and instruct the patient as follows:

- **For COLON procedures using a PillCam recorder DR3:** Explain to the patient that the PillCam recorder DR3 will alert him to perform instructions from the post-ingestion instructions handout by beeping and vibrating and displaying on its screen the number of the instruction to be performed at the alert time. When the PillCam recorder beeps and vibrates he or she should do the following:
  
  a. Check the instruction number on the PillCam recorder LCD screen.
  
  b. Press the Acknowledge button on the upper right corner of the PillCam recorder for at least 3 seconds.
  
  c. Follow the corresponding post-capsule ingestion instruction on the supplied printed out.
  
  d. Follow instructions only when prompted by the PillCam recorder and only the instruction that matches the displayed number, even if the PillCam recorder skips a number.
  
  e. The PillCam recorder DR3 displays the End of Procedure screen, beeps and vibrates when the procedure is over and shuts down automatically after five minutes.

- Avoid any physical activity that involves sweating, bending, or stooping.
- Remain active. Do not sleep.
- Use the bathroom as often as needed (do not suppress the urge). The use of wet wipes and cream to protect the skin is recommended.
- Avoid any source of powerful electromagnetic field (such as an MRI device).
- **DR3 only:** Do not remove the PillCam recorder until the capsule is excreted or the End of Procedure instruction appears on the PillCam recorder.
- **DR3 only:** If the capsule LED at the top of the recorder is blinking red, move to a different location until the capsule LED on the top of the PillCam recorder has resumed blinking blue.
- **DR2 only:** If the LED of the top of the PillCam recorder stops blinking blue before the timeouts specified in the next section for the different capsules, contact the medical staff.
- **DR3 only:** The end of the procedure for a PillCam recorder DR3 is when the End Of Procedure instruction is alerted and displayed on the recorder screen.

  The end of a procedure may also be declared by the medical staff after proper consultation if the blinking stopped before the above specified times.

- **DR2 only:** In the event that no transmissions are received from the capsule (the PillCam recorder stops blinking blue) for more than 60 minutes, the PillCam recorder will shut down.
- At the end of the procedure, remove the PillCam recorder and sensors. If you need assistance, or were instructed to do so, return to the clinic to have this done.
- Contact the medical staff in case of any unexpected event or doubt.
Performing Patient Check-in

Patient check-in is the process of entering patient and procedure data into the PillCam recorder. This information becomes part of the data in the RAPID video and capsule endoscopy report. During this process, old data from previous procedures is cleared and the new patient and regimen information is saved to the PillCam recorder.

For colon visualization procedures: patient check-in also programs the PillCam recorder to provide post-ingestion patient alerts. It also allows you to print out the selected post-ingestion instructions for the patient. Make sure that the RAPID workstation or PC is connected to a printer (for printing the post-ingestion patient instructions).

1. Make sure the PillCam recorder is fully charged and connected to RAPID.

2. From the Home screen, click **Patient Check-in**.

3. In the Procedures screen, click the Recorder bar.

4. Click **Check-in Patient**.
Caution
When placed in the cradle, RAPID 8.3 will perform updates to your existing PillCam recorders. It is important to follow the instructions displayed on the screen. Do not stop the update process until it is finished.
- For the PillCam recorder DR3, RAPID will perform a mandatory update.
- For the PillCam recorder DR2, follow the instructions detailed in the Note below.

Note
PillCam recorder DR2 only: If the PillCam recorder needs a software update, this message appears: This recorder requires a software update. Do you want to update the recorder software version?
We highly recommend you perform this upgrade unless you are an ESO 2 user. Upgrading the DR2 to SB 3 support will deactivate ESO 2 support. If you are working with several recorders, designate which will support ESO 2 procedures and which will support SB 3 procedures.
- Click Yes and follow the instructions on the screen. When the update is done, remove the PillCam recorder from its cradle and reinsert it.
- To ignore the update, click No. You may continue the check-in and perform the update later.
- Selecting the Don't show this message again checkbox will disable further updates to this specific recorder. This option is available only if you are logged in as the administrator.
The **Patient Check-in** wizard opens.

![Patient Check-in Wizard](image)

5. Click **Next** to continue.

The first **Patient Check-in** window appears.

![Patient Check-in Window](image)

6. Enter patient data by importing from HIS (Hospital Information System) or by typing in manually:

   **HIS Import**: If you are working in a HIS-enabled networked environment, you can import the patient check-in data to automatically complete the check-in fields.

   a. Click **Import**.

   The **Import Patient Data** screen appears.
The available data for patients not yet checked in appears on the screen sorted by planned **Procedure Date**. You can sort the studies by any of the column headings in either ascending or descending order.

**b.** To select a patient, select the relevant line and click **OK**. This automatically adds check-in data into the appropriate fields in RAPID.

Once imported, the patient data is removed from the **Available for Check-in** list and appears in the **Already imported** list. In the list next to **Display** at the top of the screen, you can select which patient list you wish to see: **Available for Check-in** or **Already imported**.

To delete a patient from the **Already imported** list, select the relevant line and click **Delete**.

Once you click **OK**, the first check-in screen appears again, with all available information already entered. You may need to complete additional mandatory or optional procedure information (such as capsule ID) not auto-populated from the HIS (see the *RAPID v8.3 IT Guide*). When all necessary data entry is completed, you may proceed to the **Procedure info confirmation** screen by clicking the **Next** or **Finish** buttons or by changing any of the information fields.

**Manual Data Entry:** You can enter patient information manually.

**a.** Enter the patient’s **Last**, **First**, and **Middle** names into the appropriate fields. Use alphanumeric, underscore, hyphen, and space characters. Use the TAB key to move to the next field.

**b.** Enter the patient ID number in **ID**.

**c.** Select the **Gender**.

**d.** In **Birth Date**, set the patient’s date of birth.

**e.** In **Procedure Date**, enter the date on which the procedure is to be performed. By default, it is set for current date.

**f.** In **Capsule ID**, if filling this field during check-in, enter the capsule ID code that is printed on the bottom of the capsule box (by typing it in or by using a barcode). The capsule type field is automatically populated according to the capsule type encoded in the capsule ID entered.
Preparing for PillCam Capsule Endoscopy

Performing Patient Check-in

7. Click Next to continue.

8. For PillCam COLON 2 procedures only: Select a regimen and print it out to hand it out to the patient before capsule ingestion. Use the Delay first instruction? checkbox (ON by default) to determine if a predefined minimum 90 minute free-of-instructions period will or will not be forced between the time of ingestion and the first instruction to the patient. If the delay first instruction is set, the first instruction to the patient will be either alert 0 (if still relevant) or alert 1:

- **Alert 0**: An instruction #0 (based on time passed from capsule ingestion) to take prokinetics to facilitate passage of the PillCam COLON 2 capsule to the small bowel. Threshold of time passed from capsule ingestion for alert 0 can be modified in the regimen manager for a specific regimen.

- **Alert 1**: An instruction #1 for taking laxative after detection by the PillCam recorder of PillCam COLON 2 passage into the small bowel. It coincides with the activation of the AFR mode in the PillCam COLON 2 capsule and the appearance of the AFR status icon in the right corner of the status line at the top of the PillCam recorder DR3 display. The appearance of alert 1 can be designated to appear either an additional 0 minutes or 15 minutes after original tentative alert 1 timing. Alert 0 will not occur if alert 1 was raised before it.

If you do not change this parameter during check-in, it remains in its default state (ON for “Delay first instruction”, i.e. delayed) but you may set it also through the PillCam recorder DR3 before pairing the PillCam COLON 2 capsule to the PillCam recorder DR3.

9. Click Next to continue.
10. Complete physician and insurance details:

   a. Enter **Referring Physician** and **Ordering Physician**.
   b. In **Check-in by**, enter your name.
   c. Enter **Insurance**, **Group Number**, and **ICD Code**, as required.
   d. Click **Next** to continue.

11. Type in the **Reason for Referral**, if it is known, and click **Next**.
12. Complete the patient physical description (Height, Weight, Waist, and Physique).

13. Click Next.

14. Complete the protocol and materials details:

   a. Fill in Protocol number or Name if you are performing a clinical trial.
   b. For Capsule lot number, enter the LOT # from the back of the capsule box.
   c. For Sensor serial number, enter the SN from the sensor array cable.
   d. For Battery pack serial number, enter the DR2 recorder battery pack serial number.
   e. For Recorder serial number, enter the PillCam recorder serial number.
   f. Click Next to continue.
15. In the **Procedure Information Confirmation** screen, verify that the patient and procedure data is correct:

- If the data is incorrect, click **Back** and return to a previous screen to correct the mistake.
- If the data is correct, select **Accept**, and then click **Finish** to continue. When the **Patient Check-in complete** screen appears, click **Ready** to proceed.

**Note**
When the patient check-in is complete, the capsule LED on the PillCam recorder lights up in orange.
After patient check-in, keep the PillCam recorder in its cradle until the capsule ingestion procedure begins.

**Updating Patient Details**
Patient details are collected during the Patient Check-in process. However, RAPID allows you to change or update all the patient information after a video creation.

**To update patient details:**
1. Find the study in the Study Manager.
2. Right-click the study and select **Update Patient Details**.
   The following screen appears. Make the desired changes and click **Next** until you have completed your update.
Fitting Equipment on the Patient

The following section details the instruction for preparing and fitting the patient with the recording equipment required for the capsule endoscopy procedure.

Applying the PillCam Sensor Belt

The sensor belt is used for SB or COLON procedures and consists of a flat, flexible belt-like sensor arrangement worn around the patient's waist over a single, thin layer of natural fabric, such as a T-shirt. Depending on the sensor belt, for sanitary purposes some models may require the fitting of a single use disposable protective sleeve while other models feature a reusable washable external fabric sleeve.

The image above of the PillCam sensor belt is for reference only. Sensor belt models may differ from image.

Note
Refer to the product insert supplied with your sensor belt for full instructions on fitting, usage, cleaning, and technical description.
Applying the PillCam Sensor Array

The sensor array allows the PillCam recorder to collect localization data during a procedure. The prescribing physician may request this. To prepare the sensor array:

1. Insert each sensor into an adhesive sleeve. The sensor markings (dots or this side up) should face away from the adhesive side of the sleeve.

2. To secure the sensor in the sleeve, remove the liner from the topside of the lower lip at the opening of the adhesive sleeve and press both lips together.

3. Place the sensors on the patient according to the appropriate placement guides (see ESO/UGI Sensor Locations on page 54, SB Sensor Locations on page 55, or COLON 2 Sensor Locations on page 56).

Necessary Equipment and Accessories

To attach the sensor array to the patient, you need the following equipment:

- Sensor array
- Sensor Location Guide (ESO/UGI, SB, COLON)
- Adhesive sleeves, to hold each one of the sensors securely in place
- Razor and disinfectant (not supplied), to shave the area of the sensors on the abdomen

Note
Sensor arrays must be applied directly to smooth skin. Anything that comes between the patient's skin and the sensors, including hair or air, and any changes in the sensors' arrangement, may interfere with the quality of the data.

Warning
Do not use the sensor array if it is torn or damaged.

To attach the sensor array:

1. **DR3 only**: With the patient standing and exposing the thorax and abdominal area, place the sensor array loop on the left shoulder. If the loop is too long, gather and fasten the surplus in the fastener.

2. Ask the patient to lie down.

3. Use the appropriate Sensor Location Guide to identify the location of each sensor on the patient's body and mark it with a dot.

4. The sensor array sleeves should be applied to hairless skin. If needed, wipe the patient's skin with disinfectant and shave the areas where sensors are to be applied.
5. With the sensor array connector at the patient's side, lay the prepared sensor array on the patient's abdomen and match the letters and colors on each sensor wire to the letters and colors on the Sensor Location Guide.

6. To attach each sensor, remove the protective backing from its adhesive sleeve.

**Note**
Since the sensors are placed on the body according to anatomical reference points, the distances between sensors may vary from patient to patient.

If you are using a sensor array with a downlink loop, adjust the downlink loop to remove excess cable so that it fits closely to the patient's body. To prevent damage to the wires do not forcibly bend the downlink loop in any way.

7. When the patient gets dressed, make sure that the sensor array connector remains outside of the patient's clothing and make sure that the patient is not uncomfortable with the equipment.
## ESO/UGI Sensor Locations

<table>
<thead>
<tr>
<th>Sensor Label</th>
<th>Sensor Color</th>
<th>Sensor Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Black</td>
<td>Upper Sternum (on the bone)</td>
</tr>
<tr>
<td>B</td>
<td>Yellow</td>
<td>Xiphoid process</td>
</tr>
<tr>
<td>C</td>
<td>Brown</td>
<td>Intersection of left 7th intercostal space and left mid-clavicular line</td>
</tr>
</tbody>
</table>
SB Sensor Locations

For DR3:

For DR2:

Standard Sensor Location Guide

Pediatric Sensor Location Guide
### PillCam Capsule Endoscopy

#### Fitting Equipment on the Patient

<table>
<thead>
<tr>
<th>Sensor Label</th>
<th>Sensor Color</th>
<th>Sensor Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Black</td>
<td>Intersection of right 7th intercostal space and right mid-clavicular line</td>
</tr>
<tr>
<td>B</td>
<td>Yellow</td>
<td>Xiphoid process</td>
</tr>
<tr>
<td>C</td>
<td>Brown</td>
<td>Intersection of left 7th intercostal space and left mid-clavicular line</td>
</tr>
<tr>
<td>D</td>
<td>Blue</td>
<td>Right lumbar region at umbilical level</td>
</tr>
<tr>
<td>E</td>
<td>Purple</td>
<td>Above umbilicus (navel)</td>
</tr>
<tr>
<td>F</td>
<td>White</td>
<td>Left lumbar region at umbilical level</td>
</tr>
<tr>
<td>G</td>
<td>Green</td>
<td>Right mid-inguinal region</td>
</tr>
<tr>
<td>H</td>
<td>Red</td>
<td>Left mid-inguinal region</td>
</tr>
</tbody>
</table>

### COLON 2 Sensor Locations

#### Diagram of Sensor Locations

**Sensor Location Guide for PillCam® COLON 2**

<table>
<thead>
<tr>
<th>Sensor Label</th>
<th>Sensor Color</th>
<th>Sensor Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Black</td>
<td>Intersection of right 7th intercostal space and right mid-clavicular line</td>
</tr>
<tr>
<td>B</td>
<td>Yellow</td>
<td>Mid upper region of right gluteus</td>
</tr>
<tr>
<td>C</td>
<td>Brown</td>
<td>Intersection of left 7th intercostal space and left mid-clavicular line</td>
</tr>
<tr>
<td>D</td>
<td>Blue</td>
<td>Right lumbar region at umbilical level</td>
</tr>
<tr>
<td>E</td>
<td>Purple</td>
<td>Suprapubic region</td>
</tr>
<tr>
<td>F</td>
<td>White</td>
<td>Left lumbar region at umbilical level</td>
</tr>
<tr>
<td>G</td>
<td>Green</td>
<td>Right mid-inguinal region</td>
</tr>
<tr>
<td>H</td>
<td>Red</td>
<td>Left mid-inguinal region</td>
</tr>
</tbody>
</table>
Preparing for PillCam Capsule Endoscopy

Before dispensing the PillCam capsule, the equipment must be prepared.

Caution
- Make sure that there is no other PillCam capsule or other diagnostic capsule in the patient’s gastrointestinal tract.
- Verify that the capsule expiration date has not passed (see the date next to the icon on the packaging).
- If you are performing the procedure for the first time, read the capsule package insert.

Attaching the Sensors to the PillCam Recorder

The PillCam recorder is worn by patients during the procedure in the recorder pouch with shoulder strap or in the recorder belt with suspenders. Make sure that these accessories fit the patient comfortably.

Recorder Pouch

To fit the recorder pouch:
1. With the patient standing, hang the recorder pouch from the patient’s shoulder as displayed in the illustration.

![Recorder Pouch Illustration]

2. Adjust the shoulder strap so that the recorder hangs at the patient’s side at waist level with the supplied strap securing the recorder to the waist.
**PillCam Recorder Belt**

To fit the recorder belt:

1. With the patient standing, place the belt around the patient’s waist.

2. Adjust the belt to fit the patient. Add the belt extension if needed.

3. Make sure that the PillCam recorder DR2 pouch is at the patient’s hip as shown here. The belt has a Velcro strap for attaching the pouch, allowing the patient to adjust the pouch as needed.

4. Adjust suspender length and location to fit the patient.

---

**PillCam Recorder DR2 and DR3**

To assemble PillCam recorder accessories:

1. Remove the PillCam recorder from the cradle. If the PillCam recorder is properly initialized and ready for the procedure, the capsule LED is constantly on in orange.

2. Verify that the battery is fully charged:
   - For PillCam recorder DR2, all battery LEDs should light up.
   - For PillCam recorder DR3, the battery icon on the screen should be ![](image.png).
3. Insert the PillCam recorder into its pouch. Instruct the patient to keep wearing the PillCam recorder during the examination.

The pouch or belt is ready and the patient can wear it.

**Warning**

When a PillCam recorder is connected to a sensor array worn by a patient:

- Do not connect the PillCam recorder to a computer that is connected to an electrical outlet.
- Do not put the PillCam recorder into a cradle or connect it to a charger.
- Attach the sensor connector to the PillCam recorder immediately prior to capsule ingestion.
- **PillCam recorder DR3 only**: make sure that the connector component is placed between the patient’s body and the PillCam recorder DR3 waist strap.
- **PillCam recorder DR2 only**: if the blue LED is blinking before you open the PillCam capsule box, reinitialize the PillCam recorder.

**Positioning PillCam Recorder DR3**

1. Make sure the PillCam recorder is on (navigation button LEDs blink once every 5 seconds).

2. With the patient standing, hang the pouch from the patient’s left shoulder to the right hip.

3. Insert the sensor connector into the PillCam recorder’s slot until you feel and hear a click.

If the sensor is not properly connected to the recorder, ![image](image.png) appears on the PillCam recorder screen (see *PillCam Recorder DR3* on page 209 for troubleshooting details).

4. If using a PillCam sensor array, tuck the vibrating connector component between the recorder pouch and the patient's abdomen. This will ensure that the tactile vibrating alerts will be felt by the patient.
**Positioning PillCam Recorder DR2**

1. If you are using the recorder pouch, hang it from the patient’s shoulder while the patient is standing. If you are using the recorder belt, secure it around the patient’s waist, while the patient is standing.

2. Make sure the locking handle at the back of the PillCam recorder is open.

3. Slide the two protrusions on the connector into the matching grooves in the PillCam recorder.

4. Verify that the connector is inserted completely, and then lock it by closing the handle on the PillCam recorder.

5. Make sure that the PillCam recorder is on (the battery LEDs light up once every 5 seconds).

---

*Note*

The sensor array connector and wire should hang over the top of the recorder belt.
Note

- Remind the patient about wearing and handling the PillCam recorder with care (see General Patient Guidelines During the Procedure on page 42).
- Make sure the patient has the printed instructions (see Printing the Patient Instructions on page 190).
- When securing the sensor belt, make sure the fabric of the patient's shirt is not folded beneath the front portion of the sensor belt.
- Make sure nothing other than a single, thin layer of fabric is allowed to come between the sensor belt and the abdomen.
- In order to avoid pulling the sensor belt out of position, do not attach or anchor anything to the sensor belt.
- Be sure that the PillCam recorder is worn over the sensor belt and that the PillCam recorder pouch is not attached to the PillCam sensor belt.
- Another layer of clothing may be worn over the sensor belt as long as the sensor belt connecting wire can be attached to the PillCam recorder.
Preparing the PillCam Recorder

The PillCam recorder is used to receive and store the captured images from the PillCam capsule during the capsule endoscopy procedure for subsequent download to RAPID. The video created from the downloaded data can then be reviewed by the physician.

There are two PillCam recorder models: DR3 and DR2. The DR3 model is the newest model and works with all types of PillCam capsules and provides advanced functions of real-time viewing during the procedure. The DR2 model is the previous model and it works with all types of PillCam capsules in a fixed frame rate mode.

Both recorder models are provided with a cradle (for charging and connecting to a PC) and a pouch (to allow the patient to wear the PillCam recorder during the procedure).

Functions

Initialization

Initialization is a mandatory operation before the procedure. With the PillCam recorder connected to RAPID, the patient and procedure data are uploaded to the PillCam recorder so that the ensuing study and procedure data are personalized. The initialization of the PillCam recorder is performed through the RAPID check-in process (see Performing Patient Check-in on page 43), while the PillCam recorder is connected to RAPID through its cradle. The PillCam recorder is a passive element in this process and no control or operation on it is required.

Pairing for DR3

Pairing is performed before PillCam capsule ingestion, the capsule and PillCam recorder are made to connect so the PillCam recorder is tuned to the transmissions only from the paired capsule.

Pairing for PillCam recorder DR3 may be performed either through the check-in process in RAPID by entering the capsule ID during check-in, or directly using the recorder control buttons before ingestion (see PillCam Recorder—Capsule Pairing (DR3 only) on page 80). Pairing is mandatory when working with a PillCam recorder DR3 in order to enable recording.

Real-Time Viewing

Real-time viewing is an optional function whereby the images captured by the capsule and received by the PillCam recorder are displayed to the user in real-time for review by the physician. The PillCam recorder DR2 provides this functionality only in conjunction with a dedicated tablet PC connected to it during the procedure. The PillCam recorder DR3 provides this functionality both through a dedicated
tablet PC but also autonomously by its built-in display. Appropriate controls on the recorder activate and control the operation of this function.

Regimen Reminder
Regimen Reminder is a reminder function whereby the PillCam recorder alerts the user to perform dietary instructions during a PillCam COLON 2 procedure. For more details see Post-Ingestion Patient Instructions on page 187.

Download
Download is the transfer of the stored raw procedure data from the PillCam recorder to RAPID and the creation of a RAPID video for subsequent review.

Before you perform your first PillCam procedure, make sure that you are familiar with the controls and functions of the PillCam recorder.

PillCam Recorder DR3

General
The PillCam recorder DR3 battery is limited to 400 recharge cycles. RAPID will display a notification at approximately 385 cycles prompting you to replace the battery. Contact customer service for a replacement battery when the battery notification appears, or when the battery reaches 3 years of service; whichever occurs first.

RAPID will alert the user when the number of recorder uses is close to the allowed limit.

Note
SD Card: The SD card in the PillCam recorder DR3 may not be used externally to perform a patient check-in. Use of SD cards not supplied by Given Imaging in the PillCam recorder DR3 may cause the device to malfunction or lead to data corruption or loss.

Caution
The SD card should never be removed or reinserted when the PillCam recorder DR3 is ON.
Turning On and Off

The illustration below shows the PillCam recorder DR3 sitting in the cradle:

The PillCam recorder DR3 is automatically ON when it is in its cradle.
When removed from the cradle, it may be turned off and on again using the On/Off button.

The On/Off button is on the left side of the PillCam recorder DR3:

- To turn on, press and hold the On/Off button for 5 seconds until you see the startup screen. All LEDs start to flash. (The full start-up sequence takes about one minute.)
- To turn off, press and hold the On/Off button for 5 seconds until the PillCam recorder DR3 beeps and the screen turns off and the button LEDs turn black.

Note Automatic Shutdown:

- After the PillCam recorder DR3 has been checked in, it goes into standby mode ready to receive capsule signals when removed from its cradle. If after 90 minutes no capsule pairing is performed, the PillCam recorder DR3 automatically shuts down.
- After starting to receive signals from a paired capsule, if there is a gap of 30 minutes with no signal reception from the paired capsule, the PillCam recorder DR3 will shut down.

Note

When the PillCam recorder DR3 is on, its screen backlight goes into an off mode if the screen or recorder controls are idle for more than 3 minutes. If the PillCam recorder DR3 is on, but the screen is off, press any key to turn the screen on. Once the PillCam recorder DR3 screen is activated, proceed with pressing the desired function button.
Regimen Reminder

Regimen Reminder is a reminder function, whereby the PillCam recorder alerts the patient to perform dietary instructions during a PillCam COLON 2 procedure. The alerts are timely instruction numbers that appear on the recorder screen together with some audio and tactile alerts to draw the patient's attention to the alerted instruction number. The patient is required to acknowledge the alert by pressing an acknowledge button on the recorder and execute the associated instruction detailed on a patient instruction sheet. The PillCam recorder DR3 is programmed during the initialization to remind the user according to an uploaded regimen instruction set which is also printed out and handed to the patient. The timing of the regimen instructions is synchronized to the moment of PillCam recorder DR3 pairing with the PillCam capsule.

The last instruction alerted is displayed on the screen of the PillCam recorder DR3.

Charging

Charge the PillCam recorder DR3 by placing it in the cradle. The cradle charges the PillCam recorder DR3 and also connects it to the PC for performing patient check-in and creating videos. There are two LEDs at the base of the cradle:

- The top LED is orange when the PillCam recorder DR3 is in the cradle.
- The bottom LED is orange while charging and green when the PillCam recorder is fully charged.

There is a power connector on the back panel of the cradle:
The PillCam recorder is ready for operation when:
- the battery is at least 80% charged (eight or more bars displayed on battery icon),
- it has been removed from the cradle,
- it is connected to the sensor belt or sensor array.

**Warning**

Never connect the PillCam recorder to the sensor array or the sensor belt while the PillCam recorder is in the cradle.
Do not use the DR3 cradle for any USB devices except the PillCam recorder DR3.

**Controls**

**Main Display**

The main display of the PillCam recorder DR3 displays the relevant information during the different phases of the capsule endoscopy procedure. After Initialization (after check-in) and before pairing with the capsule, the recorder display shows the relevant procedure information data, as follows:

After pairing with the capsule, the display shows the relevant procedure information data, as follows:
To activate real-time viewing (only after pairing), use the navigation buttons located under the icons at the bottom of the display: press the button below the camera icon, then the left button, and then the right button.

When a regimen instruction alert is activated, the instruction number appears all over the main screen and remains until the Acknowledge button is pressed. The graphic indication in the top right corner of the displayed alert indicates that an acknowledge response is required by pressing the acknowledge button.

Error messages appear similarly over the main screen (see Error Messages on page 73).

**LED Display**
The top of the PillCam recorder has a small screen on which the capsule and message LEDs are displayed. These LEDs indicate the status of the PillCam recorder and the capsule endoscopy procedure. For example, when the capsule LED on the PillCam recorder blinks in blue, this means that PillCam recorder is receiving data from a capsule.

For a complete list of all capsule and message LEDs, see PillCam Recorder DR3 LEDs on page 70.

**Acknowledge (ACK) Button, Designated for Patient Use**
During a capsule endoscopy procedure, patients press the Acknowledge button in response to PillCam recorder message alerts that appear on the recorder display. This ensures that the patient acknowledges the instruction message. This can include regimen instruction messages during post-ingestion regimen (see Post-Ingestion Patient Instructions on page 187).

- The acknowledge button will simultaneously blink with the display of any regimen reminder popup in PillCam recorder DR3 LCD display and it will keep blinking until patient pressed the acknowledge button for 3 sec or the popup display has reached its time out duration.
- At the end of 3 sec continuous pressing on the acknowledge button the blinking will go off.
Navigation Buttons

The navigation buttons are used to interact with the recorder by moving a cursor on a menu of icons on the recorder LCD screen and to make a selection during the capsule pairing process (see PillCam Recorder—Capsule Pairing (DR3 only) on page 80) and when selecting display modes. The icon above the navigation button at the bottom of the display area indicates the functionality of the button. The table below shows the navigation buttons and their actions.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action when pressed</th>
<th>Icon</th>
<th>Action when pressed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm/select</td>
<td></td>
<td>AFR</td>
<td>Manually activate AFR mode in PillCam COLON 2 capsule and activate instruction #1 if gastric passage of the capsule is detected and the AFR mode was not entered automatically</td>
</tr>
<tr>
<td>Scroll up the cursor</td>
<td></td>
<td></td>
<td>Activate Real-Time viewing (followed by pressing the left then right buttons within 6 seconds)</td>
</tr>
<tr>
<td>Scroll down the cursor</td>
<td></td>
<td></td>
<td>Mark displayed frame</td>
</tr>
<tr>
<td>Exit Real-Time viewing</td>
<td></td>
<td></td>
<td>Switch video head (in Real-Time viewing mode)</td>
</tr>
</tbody>
</table>

Button Pressing Indication

The following audio (beep) and visual feedbacks alert the user when pressing buttons on the PillCam recorder DR3:

- **If the backlight is off:** Pressing any button for the first time or turning on the PillCam recorder DR3 turns the backlight on. This action is not accompanied by audio feedback.

- **If the backlight is on:**
  - Momentarily pressing a button that affects a function, such as volume control, Real-Time viewing combination, scrolling up/down or left/right, and selecting buttons, results in audio (beep) feedback.
  - Continuously pressing a button (i.e. press the Acknowledge button for 3 seconds), results in audio (beep) feedback at the end of the required duration (i.e. at the end of 3 seconds).
  - Momentarily pressing a button that is designed to activate a function after continued pressing (i.e. Acknowledge), is not accompanied by audio or visual feedback.

- If the volumes is set to “off”, no audio indications should play.
Battery and Capsule Icons

The battery icon on the left side of the status line at the top of the display indicates the status of the battery in 10% increments. These icons appear in the top status line of the PillCam recorder DR3 screen.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Battery Status</th>
<th>Icon</th>
<th>Capsule Reception Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍃</td>
<td>Battery fully charged</td>
<td>🍃</td>
<td>Signal weak, recording with noise</td>
</tr>
<tr>
<td>🍃</td>
<td>Battery charge level at 10% intervals</td>
<td>🍃</td>
<td>Signal strong, recording with noise</td>
</tr>
<tr>
<td>🍃</td>
<td>Battery empty, PillCam recorder shuts down</td>
<td>🍃</td>
<td>Signal weak, but recording OK</td>
</tr>
<tr>
<td>🍃</td>
<td>Battery charging</td>
<td>🍃</td>
<td>Signal strong, and recording OK</td>
</tr>
</tbody>
</table>

PillCam Recorder DR3 LEDs

The status indications of the LED indicators on the top of the PillCam recorder DR3 for the most common PillCam recorder events are as follows:

<table>
<thead>
<tr>
<th>LEDs</th>
<th>PillCam Recorder DR3 Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>🍃</td>
<td>PillCam recorder DR3 is being checked in. Blinking rate = very fast.</td>
</tr>
<tr>
<td>🍃</td>
<td>PillCam recorder DR3 is checked in and ready to receive capsule signals.</td>
</tr>
<tr>
<td>🍃</td>
<td>PillCam recorder DR3 is checked in and receiving signals from an unpaired capsule. Blinking rate = capsule frame rate.</td>
</tr>
<tr>
<td>🍃</td>
<td>PillCam recorder DR3 is receiving paired capsule signals and recording. Blinking rate = capsule frame rate.</td>
</tr>
<tr>
<td>🍃</td>
<td>Recording done and raw data is available for downloading.</td>
</tr>
<tr>
<td>🍃</td>
<td>PillCam recorder DR3 has started downloading.</td>
</tr>
<tr>
<td>🍃</td>
<td>PillCam recorder DR3 has completed downloading.</td>
</tr>
</tbody>
</table>
Know Your PillCam Recorder

<table>
<thead>
<tr>
<th>LEDs</th>
<th>PillCam Recorder DR3 Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Blinks in yellow/orange every 5 seconds" /></td>
<td>PillCam recorder DR3 has stopped receiving capsule signals for more than 5 seconds.</td>
</tr>
<tr>
<td><img src="image" alt="Constant on in white with error message" /></td>
<td>PillCam recorder DR3 has stopped recording because the memory card is full.</td>
</tr>
<tr>
<td><img src="image" alt="Blinking in green" /></td>
<td>There is an instruction on the PillCam recorder DR3 screen.</td>
</tr>
<tr>
<td><img src="image" alt="Constant on in red" /></td>
<td>PillCam recorder DR3 is malfunctioning.</td>
</tr>
<tr>
<td><img src="image" alt="Blinking in red" /></td>
<td>PillCam recorder DR3 detects capsule signal, but is not recording it. This is a malfunction. Check the sensor connection or have patient move to a different location.</td>
</tr>
<tr>
<td><img src="image" alt="Blinking in blue" /></td>
<td>The navigation buttons blink in blue every 5 seconds when the PillCam recorder DR3 is on, either in or out of the cradle, and the LCD screen is off. To turn the LCD screen back on, press any button on the PillCam recorder DR3.</td>
</tr>
</tbody>
</table>

### Navigation Buttons Legend

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action when pressed</th>
<th>Icon</th>
<th>Action when pressed</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mark displayed frame." /></td>
<td>Mark displayed frame.</td>
<td><img src="image" alt="Activate Real-Time viewing (followed by pressing the left then right buttons within 6 seconds)." /></td>
<td>Activate Real-Time viewing (followed by pressing the left then right buttons within 6 seconds).</td>
</tr>
<tr>
<td><img src="image" alt="Switch video head (in Real-Time viewing mode)." /></td>
<td>Switch video head (in Real-Time viewing mode).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Screen Icons

These icons appear as recorder status on the rightmost icon of the top status line of the PillCam recorder DR3 screen:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Explanation</th>
<th>Icon</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="No capsule is paired." /></td>
<td>No capsule is paired.</td>
<td><img src="image" alt="No sensor is connected." /></td>
<td>No sensor is connected.</td>
</tr>
<tr>
<td><img src="image" alt="Pairing succeeded." /></td>
<td>Pairing succeeded.</td>
<td><img src="image" alt="PillCam recorder DR3 is checked in." /></td>
<td>PillCam recorder DR3 is checked in.</td>
</tr>
</tbody>
</table>
### Check-in Screen Icons

After performing patient check-in, these icons appear on the PillCam recorder screen data area:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Explanation</th>
<th>Icon</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Patient name" /></td>
<td>Patient name</td>
<td><img src="image" alt="Procedure type and capsule ID" /></td>
<td>Procedure type and capsule ID</td>
</tr>
<tr>
<td><img src="image" alt="Patient ID" /></td>
<td>Patient ID</td>
<td><img src="image" alt="Regimen Delay first instruction status indicator and navigation button designator" /></td>
<td>Regimen Delay first instruction status indicator and navigation button designator</td>
</tr>
</tbody>
</table>

### Icon Explanation

- **Data has not downloaded.**
  - PillCam recorder DR3 is waiting for check-in.
- **Data has downloaded.**
  - Indicates that AFR mode was activated in the capsule (PillCam SB 3 or COLON 2), after the PillCam recorder DR3 detected gastric passage.
- **End of procedure.**
  - In Real-Time Viewing mode, an End of Procedure notification appears on the top right corner of the screen.
- **End of procedure icon appears on the main screen and indicates that the procedure has ended and equipment may be removed. It occurs when a predefined reception gap from the paired capsule is encountered.**
- **Regimen reminder numbers appear on the main screen to alert the user to perform dietary instructions.**
  - In Real-Time Viewing mode, the Regimen Reminder number appears on the top right corner of the screen.
**Error Messages**

During operation, the following messages may appear in the PillCam recorder main screen.

<table>
<thead>
<tr>
<th>Popup</th>
<th>Explanation</th>
<th>Popup</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>No approved memory card is detected. Verify you are using an approved card.</td>
<td><img src="image2.png" alt="Image" /></td>
<td>Do not remove the PillCam recorder DR3 from the cradle.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Memory card is write-protected.</td>
<td><img src="image4.png" alt="Image" /></td>
<td>Sensor hardware failure. Consult a technician.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>Memory card error. Remove and reinsert card.</td>
<td><img src="image6.png" alt="Image" /></td>
<td>Wrong sensor type.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td>Insufficient memory on card.</td>
<td><img src="image8.png" alt="Image" /></td>
<td>Fatal error. Consult a technician.</td>
</tr>
</tbody>
</table>
PillCam Recorder DR2

**General**

The PillCam recorder DR2 battery is limited to 350 use cycles. Contact customer service for a replacement battery when necessary.

Note

Once the number of uses exceeds 350, the following message appears (in the log file only): **DR2 battery must be replaced before further use. Contact customer support to arrange replacement.**

**Turning On and Off**

This illustration shows the front and back view of the PillCam recorder DR2:

The On/Off button is on the top left side on the back of the PillCam recorder DR2:

- To turn on, press and hold the on/off button until you hear a long beep followed by a short one and the LEDs start flashing.
- To turn off, press and hold the On/Off button until you hear a beep and the LEDs turn off.

Note

**Automatic shutdown:** After the PillCam recorder DR2 has been checked in, it goes into standby mode ready to receive capsule signals when removed from its cradle and starts recording as soon as a signal is received from a transmitting capsule. If after removal from the cradle no signal is received for 90 minutes, the PillCam recorder DR2 automatically shuts down.

After starting to receive signals from a capsule, if there is a gap of 60 minutes of no signal reception, the recorder shuts down.
Charging

The cradle provided with the PillCam recorder DR2:
- Charges the PillCam recorder when it is placed in the cradle
- Charges a spare battery externally when a stand-alone battery is placed in the cradle
- Performs battery maintenance by discharging the battery when needed (the cradle detects when the battery needs refreshing and automatically discharges it before recharging)

To charge the PillCam recorder DR2:
1. Insert the PillCam recorder DR2 into the cradle.
2. Push it all the way down into the cradle and make sure you hear a series of beeps, indicating that connection is complete.

There are four connections on the back panel of the cradle. Only two of them are used with standard operation of the cradle: the power connector and the USB cable connection.

The cradle also connects the PillCam recorder to the Personal Computer (PC).
- The green LED on the cradle indicates that the PillCam recorder DR2 is fully charged and ready for use.
- The red LED, when lit continuously, indicates a defective battery.
- The red LED, when blinking, indicates that there is a problem with the cradle.

PillCam Recorder DR2 LEDs

When the PillCam recorder DR2 is on, it starts recording as soon as it receives a signal from a PillCam capsule. When the capsule LED blinks, the PillCam recorder DR2 is receiving data. When the signal from the PillCam capsule is too weak, the LED does not blink.
These are the LED indicators and their statuses and colors for the most common PillCam recorder DR2 events and statuses:

<table>
<thead>
<tr>
<th>LEDs</th>
<th>PillCam Recorder DR2 Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PillCam recorder is ON but not initialized. PillCam recorder does not capture capsule signals.</td>
</tr>
<tr>
<td>2</td>
<td>PillCam recorder is initialized with patient data and ready to capture capsule signals. PillCam recorder shuts down if no capsule signals are received for more than 30, 60, or 90 minutes, depending on the PillCam recorder software version.</td>
</tr>
<tr>
<td>3</td>
<td>PillCam recorder is exchanging status or data with RAPID or RAPID RT. LED blinking rate varies according to the communication flow.</td>
</tr>
<tr>
<td>4</td>
<td>PillCam recorder is capturing capsule signals. Blinking rate = capsule frame rate.</td>
</tr>
<tr>
<td>5</td>
<td>PillCam recorder has stopped capturing capsule signals for more than 5 seconds.</td>
</tr>
<tr>
<td>6</td>
<td>PillCam recorder is detecting a capsule in sleep mode. Blinking rate = every five seconds (in any color).</td>
</tr>
<tr>
<td>7</td>
<td>PillCam recorder is malfunctioning.</td>
</tr>
<tr>
<td>8</td>
<td>PillCam recorder is synchronizing with a capsule. This is normal functioning.</td>
</tr>
<tr>
<td>9</td>
<td>PillCam recorder detects capsule signal, but is not recording it. This is a malfunction. Check the sensor array connection or have patient move to a different location.</td>
</tr>
</tbody>
</table>

**Battery charge level:**
- **maximum**: When charging, the battery LEDs do not blink.
- **25%**: When PillCam recorder is out of the cradle, the battery LEDs blink once every 5 seconds.
- **below 10%**:
Connecting a PillCam Recorder to a Personal Computer (PC)

The PillCam recorder needs to be connected to a PC with RAPID in the following cases:

- **Connect for initialization:** For initialization before the procedure: to check-in a patient.
- **Connect for downloading:** For downloading data from the recorder after the procedure: to create a video or copy the video data from the recorder to the computer.
- **Connect for charging:** For charging the PillCam recorder after the procedure: to prepare the recorder for the next procedure.
- **Connect for upgrading:** When the software version of the PillCam recorder is lower than the latest one internally specified in RAPID, the user is prompted to allow a recorder upgrade the first time the recorder is connected to RAPID for check-in. It is highly recommended to allow the upgrade. The latest software versions for both PillCam recorder DR2 and PillCam recorder DR3 are stored in RAPID and when prompted and allowed, the appropriate upgrade will be performed.

The PillCam recorder is connected to the PC only through its cradle, each model through its cradle. The PillCam recorder is passive during these cases and no controls need be operated on it.

Connecting a PillCam Recorder to the External Real-Time Viewer

The PillCam recorder may be connected to an external real-time viewer, which is a dedicated tablet PC with real-time viewing software and special setup, for viewing in real-time the images captured and stored in the recorder. This functionality exists for both recorder types, PillCam recorder DR2 and PillCam recorder DR3 (the latter has also the built-in capability to perform real-time viewing through the recorder’s display).

For a real-time viewing session, both recorder types connect to the external real-time viewer (tablet PC) through a USB cable, while the tablet PC or anything connected to it must not be connected, directly or indirectly to any wall outlet. The real-time viewing software in the tablet PC controls the session and the PillCam recorder is passive in this configuration. There is no need to use any control button of the recorders.
Setting *Delay First Instruction* in PillCam Recorder

Before ingestion of the PillCam COLON 2 capsule, you need to make sure that the settings match the procedure circumstance: patient stays in clinic after ingestion or is instructed to go home immediately after ingestion. If the patient stays in clinic, the *Delay first instruction* flag on the PillCam recorder DR3 needs to be OFF, otherwise it needs to be ON. If this flag has not been set properly during check-in, it needs to be set before ingestion directly on the PillCam recorder prior to pairing with the PillCam COLON 2 capsule by using the right navigation button with the icon above it to toggle the flag. The default setting for a PillCam recorder DR3 checked-in with RAPID v8.3, without changing the *Delay first instruction* field during check-in, is ON—first instruction delayed. Repetitive use of the right button will toggle the status of the PillCam recorder DR3 and its status will show in the fourth icon (from above) in the left most side of the fourth procedure data line.

![Delay first instruction—Off](image1)

![Delay first instruction—On](image2)

The fourth line status icon and the button designation icon in the lower right corner of the screen above the right navigation button will always be opposite. After pairing, the Delay first instruction icon will disappear and the status will not be changeable any more.
PillCam Recorder—Capsule Pairing (DR3 only)

PillCam recorder DR3 operates only with capsules that were paired to it. This allows the PillCam recorder to recognize images from the correct capsule. Pairing is initiated when the PillCam recorder recognizes transmission from a designated capsule. From that point on, the recorder is associated with the capsule. The recorder and capsule are then paired.

**Warning**

The PillCam recorder starts recording *only after it is paired with the capsule.* If pairing is not complete, no video can be produced. Make sure you see the **Pairing Success** icon on the screen and the capsule LED on top of the recorder blinking in **BLUE** before capsule ingestion.

Designation of the capsule to be used in the procedure may be performed during patient check-in or immediately before capsule ingestion. The following section describes these two scenarios.

**Capsule Designation During Patient Check-in**

While entering the patient and procedure data during check-in, type the capsule ID in the Capsule ID field or use a barcode scanner. The capsule ID is displayed on the capsule package.

During recorder initiation, the unique capsule ID will be transferred into the PillCam recorder together with the rest of the initiation data. It will appear on the PillCam recorder LCD together with the rest of the patient data.

As long as no transmission from the checked in capsule is received, pairing is not done. The **Ready for pairing** icon remains in the top right corner of the screen.

If there are PillCam capsule transmissions received by the PillCam recorder, which are not from the designated capsule, the capsule IDs of these other capsules (only of the checked-in capsule type) are temporarily displayed on the PillCam recorder screen. **Ready for pairing** icon remains in the top right corner of the screen.

When you open the designated capsule box, just before ingestion, the capsule starts blinking and transmitting, each capsule type in its unique way. The PillCam recorder will automatically pair to the designated capsule and start recording when it receives transmissions from it.

The **Pairing success** icon will appear in the top right corner of the screen.
Capsule Designation Before Capsule Ingestion

There are two situations when you need to perform capsule designation manually immediately prior to ingestion:

- if designation was not performed during check-in, or
- if designation was performed, but the designated capsule is not available for the procedure.

As long as there are PillCam capsule transmissions received by the PillCam recorder but are not from a designated capsule, the capsule IDs of these other capsules (only of the checked-in capsule type) are temporarily displayed on the PillCam recorder screen. The Ready for pairing icon remains in the top right corner of the screen.

To designate and pair a capsule to be used in the procedure before capsule ingestion:

1. Open the capsule box lid—the capsule starts blinking, each capsule in its unique blinking pattern (see System Specifications on page 217). Right after opening the lid, the blinking rate for PillCam SB 3 and PillCam COLON 2 capsules should still be 2 fps per head, the same as for PillCam SB 2. For PillCam SB 2 (fixed 4 fps variant) the blinking rate should be 4 fps. For PillCam UGI, the blinking rate is 35 fps per head. Hold the capsule close to the sensors worn by the patient during this pairing process.

2. When the Ready for pairing icon is displayed in the top right corner of the screen and when the PillCam recorder detects your PillCam capsule, its ID code is displayed on the screen (alone or in addition to IDs from other capsules).

3. If only one capsule ID appears on the PillCam recorder screen, check the capsule ID shown in the PillCam recorder screen against the capsule ID displayed on the PillCam capsule package. If the codes match, press the middle navigation button, above which appears on the screen.

4. If more than one capsule ID appears on the PillCam recorder screen, use the navigation buttons (located below or icons on the screen) to scroll to your capsule ID and press the middle navigation button (located below icon on the screen) to designate and initiate pairing of your capsule with the PillCam recorder.
The **Pairing success** icon will appear in the top right corner of the screen.

### Note
- If a PillCam COLON 2 capsule blinks slower than 1 blink per second during the pairing procedure, return it to its box so that it stops blinking and start over.
- If, at any time before ingestion, the capsule does not blink for at least 20 seconds, do not use this capsule. Instead, use a different capsule and repeat the pairing procedure.

### Note
If after designating the capsule:
- the patient does not ingest it within ten minutes, or
- you suspect that the capsule is defective.

Return the capsule into its box. When you close the lid, if the capsule stops blinking, it is deactivated.

If the capsule continues blinking, rotate it around its axis, without removing it from its place holder in the box until it stops blinking when you close the lid.

To use this capsule later (if it is not defective), you must repeat the pairing process.

---

## Capsule Ingestion

Capsule ingestion is the process of having the patient swallow the PillCam capsule.

### Multiple Procedures

When performing more than one PillCam capsule endoscopy procedure in the same vicinity, follow these guidelines to prevent signal interference with other procedures:

- **After patient check-in,** keep the PillCam recorder in the cradle without sensors attached until capsule ingestion procedure begins. Return it to the cradle when the procedure is complete.
- **DR2 only:** If the blue PillCam recorder LED is blinking before you open the box of the capsule you intend to use, repeat check-in with the PillCam recorder (see *Performing Patient Check-in* on page 43).
- Perform only one capsule ingestion at a time with no other active PillCam recorder or capsules present in the room.
- Attach sensors to the PillCam recorder immediately prior to the ingestion after sensors are properly positioned on the patient.
- Do not permit patients wearing PillCam recorders to stay directly next to other patients with ingested capsules.
- To minimize the potential for radio frequency interference from the capsule after it is removed from the box, verify that the capsule LEDs are blinking and have the patient ingest it immediately.
- Once the RAPID video is created, check to be sure the video is complete.
**PillCam Recorder DR3**

1. Make sure that the capsule and the capsule LED on the PillCam recorder are blinking in time with each other.

2. Check the color of the capsule LED on the PillCam recorder:
   - If (blue), go to step 3.
   - If (white), pair the capsule with the PillCam recorder and verify the pairing success icon appears in the top right corner of the PillCam recorder screen and the capsule LED blinks blue.

3. Have the patient swallow the capsule with a sip of water. The ingestion procedure may take several minutes.

**PillCam Recorder DR2**

1. Make sure that the capsule and the capsule LED on the PillCam recorder are blinking in time with each other.

2. Position the patient on the bed, with a pillow (6 cm or 2.5 inch high) under the head to facilitate drinking and ingestion.

3. Instruct the patient not to talk during the procedure.

4. To verify that the system is operating properly, hold the capsule in front of the patient's abdomen very close to the sensors (practically touching through the clothes one of the sensors). Hold it for at least 15 seconds and check that the capsule LED on the PillCam recorder blinks at the same rate as the capsule.

5. Have the patient swallow the capsule with a sip of water.
After Capsule Ingestion

PillCam ESO/UGI
The patient must stay at the medical facility until the end of the procedure (approximately 90 minutes after ingestion of the capsule).

The procedure ends when the End of Procedure screen appears on the PillCam recorder. The PillCam recorder also beeps and vibrates when the End of Procedure alert appears. In ESO/UGI capsule procedures, the End of Procedure icon appears when 10 minutes have passed without paired capsule reception in the PillCam recorder DR3.

At the end of the procedure, remove the PillCam recorder and sensors from the patient. The patient may then be released and can return to a normal daily routine.

PillCam SB
Once the patient has ingested a PillCam SB capsule, the patient may leave the clinic. Make sure that the patient knows which activities to avoid during the procedure and how to return the PillCam recorder and sensors.

PillCam Recorder DR3
The procedure ends when the End of Procedure screen appears on the PillCam recorder. The PillCam recorder also beeps and vibrates when the End of Procedure alert appears.

In SB capsule procedures, the End of Procedure icon appears when 25 minutes have passed without paired capsule reception in the PillCam recorder DR3.

At the end of the procedure, remove the PillCam recorder and sensors from the patient. The patient may then be released and can return to a normal daily routine.

PillCam Recorder DR2
The procedure lasts as long as the blue PillCam recorder LED is blinking, or until the capsule is excreted. The PillCam recorder DR2 LED should blink for at least six hours, unless the PillCam SB capsule was excreted.

Note
When the capsule LED on the PillCam recorder blinks orange, this indicates that the PillCam recorder is no longer receiving capsule signals.

At the end of the procedure, remove the PillCam recorder and sensors from the patient. The patient may then be released and can return to a normal daily routine.

PillCam COLON (DR3 only)
After ingestion, explain the Patient Guidelines (see General Patient Guidelines During the Procedure on page 42) to the patient.

Explain to the patient what to do when the PillCam recorder beeps or vibrates (see Post-Ingestion Patient Instructions on page 187).

The procedure ends when the End of Procedure screen appears on the PillCam recorder. The PillCam recorder also beeps and vibrates when the End of Procedure alert appears.
In COLON capsule procedures, the appearance of the End of Procedure icon depends on how much time has passed without paired capsule reception in the PillCam recorder DR3:

- During the first 5 hours of the procedure, 25 minutes of no paired capsule reception.
- Between 5 hours and 10 hours of the procedure, decreasing incrementally from 25 minutes to 10 minutes of no paired capsule reception.
- After 10 hours into the procedure, 10 minutes of no paired capsule reception.

At the end of the procedure, the PillCam recorder and sensors may be removed from the patient. The patient may then return to a normal daily routine.

**Real-Time Viewing with PillCam Recorder DR3 Only—Internal Mode**

To activate real-time viewing with PillCam recorder DR3, press the middle navigation button below the Real-Time icon, then immediately press the left then right buttons one after the other.

The following screen appears on the PillCam recorder.

---

**Note**

Using Real-time Viewing on the PillCam recorder with an external real-time viewer (laptop) is not supported.
In procedures with AFR mode capsules (PillCam SB 3 and PillCam COLON 2), the AFR icon appears above the right navigation button while the capsule is not in AFR mode to allow the user to manually activate the AFR mode of the capsule even before automatic activation. After activation of the AFR mode in the capsule (either manually or automatically), the recorder status icon in the top status line changes from paired to AFR . The icon displayed above the right navigation button is the mark icon that allows the marking of the displayed image for automatic creation of a thumbnail and to facilitate further scrutiny of the image off-line in the created video.

In procedures with non-AFR capsules (PillCam SB 2 and PillCam ESO/UGI) the icon that appears above the right navigation button in real-time viewing is the mark icon .

**For colon visualization procedures:** instruction #1 on the PillCam recorder screen appears after the capsule enters the small bowel, usually within two hours of ingestion. The AFR icon simultaneously appears in the status line at the top of the PillCam recorder screen, designating the fact that the PillCam COLON 2 capsule passed into the AFR mode operation.

If the system does not show instruction #1 or the AFR icon two hours after ingestion, you can monitor the capsule location in the GI tract using the real-time viewing. The system will activate by default the AFR mode and instruction #1 at 4 hours post-ingestion at the latest.

If you need to verify (after instruction #1 on the PillCam recorder screen) that the capsule has left the stomach, use the real-time viewer:

- If capsule is still in the stomach, repeat real-time viewing to check capsule location every 30 minutes until you can confirm that it has left the stomach.

- If you visually confirm that the capsule has left the stomach while the AFR indication in the top right corner of the status line still hasn’t changed to AFR, press the right navigation button under the AFR icon AFR at the right bottom of the screen for 5 seconds. This triggers instruction #1 and activates recording mode AFR frame rate. The AFR icon AFR appears at the top right corner in the status line of the screen. The video created from this procedure will start at this point. The mark icon mark will appear above the right navigation button instead of the AFR icon.

- Once instruction #1 occurs, the PillCam recorder automatically continues to provide instructions according to the post-ingestion regimen selected during check-in.

---

**Note**

**For colon visualization procedures:**

- If the PillCam recorder does not detect that the capsule has entered the small bowel (either automatically or by the manual procedure described in step 2, above), the following message appears when opening the video: **Gastric-to-SB passage not detected.** In this case, the video is very short (the first 3 minutes only).

- Some patients may require close supervision to ensure they comply with post-ingestion instructions. Other patients may be able to function independently as long as they have access to all needed doses of laxatives and/or prokinetics and are capable of following instructions during the procedure.
When in Real-Time viewing the PillCam recorder screen turns off and returns to the main screen after:

- 2 minutes of inactivity for colon visualization procedures/SB procedures,
- 30 minutes of inactivity for ESO/UGI procedures.

**Note**
AFR should be activated only after visually confirming entry into the small bowel

### Real-Time Viewing with PillCam Recorder DR2 Only—External Mode

To activate real-time viewing with external RAPID Real-Time viewer, connect either PillCam recorder model you are using to the external real-time viewer through the respective USB cable and activate the RAPID Real-Time viewer. For instructions on the operation of the RAPID Real-Time viewer, see the user manual for RAPID Real-Time viewer.

### Removing Equipment from the Patient

If the patient has not already removed equipment, do so as follows:

1. Disconnect the sensors from the PillCam recorder.
2. Remove the PillCam recorder from the patient.
3. Remove the sensors from the patient.
4. Remove the PillCam recorder from the pouch and place it in the cradle.
5. After each procedure, make sure to clean the equipment (see PillCam Sensor Cleaning on page 205) and charge the PillCam recorder (see Charging on page 203).
Chapter 7
Creating RAPID Videos

PillCam Recorder Download

After the capsule endoscopy examination, the video data in the PillCam recorder must be copied to a computer and compiled into a video. There are two ways of doing this:

- Copy the data and compile the video as a single task. This method is the default; it is very convenient, but takes longer to complete and free up the PillCam recorder.
- Copy the data only and perform compilation later. This method requires some additional steps, but makes the PillCam recorder available faster (see Copying Data from a PillCam Recorder on page 93).

When creating a video, the RAPID software:

- Creates a folder for the new video. This folder is inside the preset default folder (see RAPID Video Files on page 143).
- Displays the images being copied from the PillCam recorder during video creation.
- Creates the RAPID video from this raw data and saves it in the new folder. The new video name and its folder name are the same.
- Notifies you once video creation is complete so you may disconnect the PillCam recorder.

Note

- In the rare case that the video creation fails, RAPID prompts you to save the raw data for customer support.
- You can reduce the file size while copying data (see Video Data Management Section on page 174).
- When downloading from four recorders simultaneously ensure that there is at least to 40 gigabytes of hard disk space.
- Make sure that the computer power settings are not set to sleep or to hibernate modes.

Caution

Connection of the PillCam recorder to the RAPID software for patient check-in, video download, and recorder upgrade must be done using the appropriate cradle.
Creating a Video from the PillCam Recorder

To create a video from the PillCam recorder:

1. Place the PillCam recorder in the cradle. Make sure that the cradle is connected to the computer on which RAPID is installed and open.

2. From the Home screen, click **Recorder Download**.

3. Click the Recorder bar that corresponds to the PillCam recorder with the desired data:
   - When the correct Recorder bar is activated and you click on the **Identify Recorder** button, the corresponding PillCam recorder LEDs blink.
   - The relevant patient information is displayed on the Recorder bar.
   - PillCam recorder's last use, such as **Recording, Creating video...**
   The **Create Video** and **Check-in Patient** buttons become available.

4. Click **Create Video**.
If there is enough space on the PC’s hard disk, the new video is created. If not, you are prompted to free up space (see Freeing Space on Your Computer on page 195).

During video creation, in the PillCam recorders window, the Create Video button becomes the End video creation button. The Recorder bar displays the following:

- The status and progress bar.
- The patient name and ID.
- The name of the video to be created.
- The battery status.
- The Do not remove recorder message flashes below the battery status until all data is copied or compiled into a video.

The images that are being copied to the computer are displayed in the Compiling Images window above the function buttons.

Creating a Video from USB Storage Device or DVD

RAPID supports video creation from media (a removable USB storage device or DVD). This can be useful if you have copied raw data from the PillCam recorder.

To create a video from a media:

1. Plug the USB storage device into one of the USB 2.0 ports of the PC, or insert the DVD into the DVD drive.
2. From the Home screen, click Recorder Download.

The Procedures screen appears.

3. Click the Raw Data Files tab.

Find the bar that corresponds to the USB storage device you want to select. The relevant patient information is displayed on the button.

4. Click Create Video.

5. After a video has been created, click Safely Remove to safely remove the USB storage device.
**Batch Video Creation**

RAPID can perform multiple video creations for any combination of up to four PillCam recorder cradles, and for any number of raw data files. Once the process begins, the videos are created consecutively.

**From PillCam Recorders**

Place PillCam recorders into the connected cradles. In the **Recorders** screen, click **Create Video** for each one, separately. The order in which you click **Create Video** determines the order in which the videos are created. If you cancel one of the video creations after activating it, this PillCam recorder is skipped and the next one starts automatically.

**From Raw Data Files/USB Storage Devices**

Connect USB Storage devices. In the **Raw Data Files** screen, click **Create Video** for each one of the devices or any raw data files already on the computer. The order in which you click **Create Video** determines the order in which the videos are created. If you cancel one of the video creations after activating it, this raw data file is skipped and the next one starts automatically.

**Pause/End Video Creation**

During video creation, the **End video creation** button becomes available.

To cancel video creation:

1. Click **End video creation**.
2. Click **Yes** to end the compilation, or click **No** to continue compilation.

**Managing RAPID Video Data**

You can copy the video data from the PillCam recorder to the computer, a USB storage device, or a DVD without compilation into a video. Video data management is disabled by default.

To enable video data management:

1. From the Home screen, select **Tools > Settings**.
2. Select the **Video** tab.
3. Under **Video Data Management**, **Disable video data management** is selected by default. Select either **Copy raw data** or **Compile raw data**.

You can copy the video data from the USB storage device or a DVD onto a workstation for video creation (see *From Raw Data Files/USB Storage Devices* on page 92).

## Copying Data from a PillCam Recorder

**To copy video data from a PillCam recorder:**

1. Place the PillCam recorder in the cradle. Make sure that the cradle is connected to the personal Computer (PC).

2. From the Home screen, click **Recorder Download**.

   The **Procedures** screen appears with the **Recorders tab** on top.

3. Click the **Recorder** bar that corresponds to the PillCam recorder with the desired data:

   - When the correct **Recorder** bar is activated and you click on the **Identify Recorder** button, the corresponding PillCam recorder’s LEDs blink.
   - The relevant patient information is displayed on the **Recorder** bar.
   - PillCam recorder's last use is displayed.

   The **Manage Video Data**, **Create Video**, and **Check-in Patient** buttons become available.
4. Click **Manage Video Data**.

5. Select the location for the copied data.
   Click **Change** if you wish to copy the data to a different location (on the computer, network, or external device) than the default (E:\datatransfer). To change the default directory, see Video Data Management Section on page 174.

6. Click **Start Copy**.
   During raw data copy the **Recorder** bar displays:
   - The **Compiling raw data** or **Copying data** message, depending on the video settings.
   - The status and progress bar.
   - The patient name ID.
   - The name of the video to be created.
   - The battery status.
   - The **Do not remove recorder** message flashes below the battery status until all data is copied.

Once the process is complete, a message appears on the screen notifying you that the data copy is complete. The PillCam recorder may be disconnected at this point.
Managing Data Files

The Raw Data Files screen allows you to manage and monitor all video data files on your PC or connected USB storage device.

To open the Raw Data Files screen, select Recorder Download from the Home screen. The Procedures screen appears. Select the Raw Data Files tab.

A list of raw data files appears; their status and location are displayed in the recorder bar.

On the right side, the following buttons appear:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Video</td>
<td>Creates a video from the video data file that was copied to the computer.</td>
</tr>
<tr>
<td>Delete file</td>
<td>Deletes the video data file that was copied to the computer.</td>
</tr>
<tr>
<td>Copy or Burn File</td>
<td>Copies the video data file to a CD/DVD, to a different folder, or a USB storage device.</td>
</tr>
<tr>
<td>Safely Remove</td>
<td>Ejects the USB device once the video data file is copied and deleted from a USB storage device. <strong>This button appears only if raw data files are connected to the computer via a USB device.</strong></td>
</tr>
</tbody>
</table>

**Note**
Label all USB storage devices used for Video Data Copy or for transport of RAPID videos, stating that they may contain clinical data and should not be used for other purposes.
**Batch Data Copy**

The RAPID software can perform multiple video data copy for any combination of up to four PillCam recorder cradles and USB storage devices, and for any number of video data files.

**From PillCam Recorders**

Place PillCam recorders into the connected cradles. In the [Recorders](#) screen, click [Manage Video Data](#) for each one, separately.

**From Video Data Files/USB Storage Devices**

Connect USB Storage devices. In the [Raw Data Files](#) screen, click [Copy or Burn File](#) for each one of the devices or any video data files already on the computer.

**Backing up Data**

When you have confirmed that the video was created successfully, you may delete the raw data files from your computer. We recommend this since these raw data files are very large.

Back up the RAPID folders (which contain created videos) by saving them on removable discs (CD/DVD or USB storage device). After saving them on removable media, you may delete them from the PC's hard disk if they are not to be reviewed on that PC.

**Note**

Make sure that the RAPID software is completely shut down before removing the PillCam recorder from its cradle.
Loading a Study with the Study Manager

The Study Manager allows you to conveniently access and manage patient studies. The studies are organized in the Study Manager in a way that enables easy access and management of studies, sorting, and searching by different criteria such as patient name and procedure dates.

The Study Manager connects to a directory of studies, called an Archive, at different locations, i.e. on the local computer or on a network, on a removable drive connected to the computer, or on a CD/DVD containing the studies. These studies are represented in a multi-line format where each line represents a separate capsule procedure.

To access the Study Manager:

- From the Home screen, click View Study and select Study Manager in the drop-down list.
- From one of the RAPID screens, click File > Study Manager or click the Study Manager icon: located on the Quick Access Toolbar.
The image below displays the Study Manager layout, divided into the following sections:

- Archives
- Studies
- Status Bar
- Action buttons
- Search
Archives

The Archives section displays the current procedure study archives that are accessible in the RAPID software. The Study Manager can connect to procedure study archives located on the local computer, on an accessible network, or a removable storage media such as a flash drive or a CD/DVD. The different archive icons are explained below:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Fixed Drive Icon" /></td>
<td>An archive on a fixed drive, such as the computer's hard disk or a drive on the network. The default archive is the one selected in Settings &gt; Video &gt; Video directory. The archive is added and defined by the user using the Add button. This is explained below in Adding an Archive on page 99.</td>
</tr>
<tr>
<td><img src="image" alt="USB Drive Icon" /></td>
<td>A portable drive containing procedure studies connected to the computer's USB. Portable drives connected to the USB are automatically detected and cannot be user defined. Using the mouse, navigate to the USB connected device in My Computer, right click and select Properties. Type the desired volume name and click OK.</td>
</tr>
<tr>
<td><img src="image" alt="CD/DVD Icon" /></td>
<td>Procedure studies stored on a CD/DVD in the computer's DVD bay. CD/DVD archives are automatically detected and cannot be user defined.</td>
</tr>
</tbody>
</table>

Adding an Archive

The instructions below demonstrate how to add an archive containing procedure studies that can be accessed from the RAPID software. Portable drives connected to the computer's USB and studies contained on a CD/DVD are detected and added automatically. The archives on the Study Manager can be renamed or deleted but this will not affect the source directory of the archive.

**Note**
Adding an archive provides a visual link to the directory using the Study Manager. It does not copy the data locally to your computer. Removing an archive using the Delete button does not delete data from the directory, but only the path to the directory.

**To add an archive:**

1. Click the **Add** button at the bottom left of the Study Manager screen. The Add Archive screen appears.

   ![Add Archive Screen](image)

2. Enter the archive path and the archive name that will appear below the archive.
   - To browse for the archive on the local computer or on the network, click the **Browse** button.
• The **Browse For Folder** screen appears. Navigate to the desired archive and click **OK**.

3. **Click Finish.**

When the Study Manager scans the archive, the archive icon will display **Scanning...** below the archive.

The status bar will display **Loading studies...** until all studies are loaded and the status bar will display **Loading studies successful.**

**Archive Options**

**Note**
During archive scanning, studies that already appear in the Study Manager screen can be opened.

When right-clicking on a selected archive in the Study Manager the following options are available:

- **Remove**: Remove the archive path from the Study Manager. To remove the CD/DVD from the disk drive or any portable drive from the USB connection click the Eject button.

  **Note**
  DO NOT remove the USB storage device until after any actions performed with it are completed.

- **Rename**: Rename the selected archive.
- **Move Up**: Move the selected archive up on the archive list display.
- **Move Down**: Move the selected archive down on the archive list display.

**Studies**

The study lines displayed are links to the studies located in the selected archive. Each line represents a link to the study.

**Note**
In some cases, especially when working with network archives, you may not immediately see the updated Study file in the Study Manager, after making changes to the file. In this event, click the Refresh button in the top right corner of the Study Manager to make sure the most recent data is shown.
**Study Columns**

By default, the studies are sorted by the last modified study, the *Video Created* column. The column that is sorting is represented by an arrow. In the example below the studies are sorted by *Video Created*, the date that the video was created.

The studies are identified by several parameters that define the study, such as patient name, capsule procedure type, and referring physician. Additionally, a check mark in the following columns indicates the availability of the following:

- **Video Created**: Study includes a video of the procedure.
- **Findings**: Study includes a findings file created for this procedure.
- **Reports**: Study includes a report of the procedure.

**Study Options**

When right-clicking on a selected study in the Study Manager, the following options are available:

- **Manage Columns** enables the adding, deleting and creating of Study Manager columns (see *Managing Columns* on page 104).
- **Update Patient Details** changes or updates all the patient and procedure information even after a video is created. Click *Save* when finished.
- **Print Regimen** opens a print preview layout of the Regimen for this procedure (see *Print Layout of the Post-Capsule Ingestion Instructions* on page 190).
- **Open Video Only** opens the procedure video without the findings. If any findings are added during review, when trying to save you will be prompted to overwrite any existing findings file (see *Open* on page 107).
- **Export Table Information** saves the selected archive data to a static line and column format Excel file displaying all the studies for that archive.
- **Show all search results** displays the screen of results of the search performed (see *Search Function* on page 103).

**Understanding the Status Bar**

A status bar at the bottom of the screen shows the number of studies displayed, the number of studies selected, the amount of free space on the selected archive, and loading status of the studies.
### Action Buttons

The action buttons located on the bottom of the Study Manager screen enable several commands like opening a study in RAPID, deleting studies, and export. To perform an action on a study, select the study by clicking the row containing the relevant study and click one of the following action buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds an archive to the Study Manager screen (see <em>Adding an Archive</em> on page 99).</td>
</tr>
<tr>
<td>Eject</td>
<td>Ejects a CD/DVD from CD drive and ejects any flash drive connected to USB. This will remove the archive from the Study Manager.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens the video and findings of the selected study in the RAPID software (see <em>Open</em> on page 107).</td>
</tr>
<tr>
<td>Export</td>
<td>Exports the selected study or specific files of the study to a CD/DVD or another archive (see <em>Export</em> on page 107).</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected study (see <em>Delete</em> on page 111). Deleting a study in the Study Manager deletes all data including procedure videos from the source directory.</td>
</tr>
<tr>
<td>Open report</td>
<td>Opens the report of the selected study (see <em>Open</em> on page 107).</td>
</tr>
<tr>
<td>Offline studies</td>
<td>Opens Offline study archive which displays the list of the studies which were stored on a removable storage media but are now not accessible (see <em>Offline Studies</em> on page 112).</td>
</tr>
<tr>
<td>Close</td>
<td>Closes Study Manager screen. This can also be performed by clicking the Escape button on the computer's keyboard.</td>
</tr>
</tbody>
</table>

### Note

For Delete and Export commands you can select multiple studies to perform the command. Click the row of the first study, press and hold SHIFT on your keyboard and select the last study you wish to select. If not all the studies are in rows next to each other, press and hold CTRL on your keyboard and select the studies one by one. You can then either click **Delete** or **Export**. The number of selected studies is displayed in the Status bar.
Search Function
At the top of the Study Manager screen, the following search and filter functions enable to search for a study in a selected archive:

- **Text**: Search by entering part of the name or the entire name of the patient, findings, procedure, or other free text.
- **Capsule Type**: Filter the search by selecting from the drop-down list the type of capsule procedure.
- **Procedure Date**: Filter the search by selecting from the drop-down list the procedures performed in a specific time window (in the last days or weeks or even by a specific date).

After entering one or more search criteria the Study Manager will search and display only relevant studies. The criteria that were searched will be highlighted in green.

In the example below, the following search criteria was entered:

- **Text**: bleeding
- **Capsule Type**: SB
- **Procedure Date**: All

All SB capsule procedures were displayed and highlighted. Additionally, one of the procedures displays a highlighting on the Findings. Right-clicking the study and selecting **Show all search results** displays additional information regarding the text searched **bleeding** and where it is located. In this example, the **bleeding** text was located in the Findings, under the **Reason for Referral**.
Additionally, if opening, deleting, or exporting the study, the finding will remain highlighted to allow for its selection as shown below:

To clear the search fields and again see all studies in the selected archive, click **Reset**.

To refresh the search view click **Refresh** to ensure that the latest data is displayed in the Study Manager.

### Managing Columns

You can determine what information is displayed about each study. By default, Study Manager displays the following columns containing information entered during the Check-in process:

- Last Name
- First Name
- ID
- Gender
- Capsule Type
- Procedure Date
- Referring Physician
- Ordering Physician
- ICD Code
- Video Created
- Findings
- Report

These columns are mandatory and cannot be changed or removed. There are also columns that you can optionally add by selecting from a list of additional check-in information fields. You can also add and name a new column (User Column).

**To add or remove columns:**

1. Right-click anywhere in the area where the studies are displayed and select **Manage Columns**. The **Manage Columns** screen appears. On the right is the list of currently **Displayed Columns** in the...
Reviewing and Interpreting RAPID Videos

2. To change the left to right order of the displayed columns in the Study Manager screen, select the column you wish to move in the window on the right and click or .

3. Select any column names that are listed in Available Columns on the left side and click the right arrow to display them in the Study Manager screen. They will be added to the end of the list in the window on the right. The position in the list can also be changed.

4. Select any columns that are listed in Displayed Columns and click the left arrow to remove them from the Study Manager screen.

5. To create a new column, click Create.

6. Type in the name of your new column and click Save. The new column will appear in the Available Columns list with a user column icon next to it.

7. To display this new column, select it and click the right arrow . It will appear at the bottom of the Displayed Columns list.

8. To change the name of your column, select it and click Rename.

9. To remove the column from the Study Manager, select it and click Delete.

10. In the Study Manager, the User Column will require manual input of the data. To enter data in your column, first select the relevant study. Click in the cell of the study in your column. Type in your...
text in the separate window that opens. When you are done, click OK. In the example below, a user column named **Reviewed by** was created.

**Note**

Created user columns can be available to other users. Make sure the users have the same path defined in **Shared data directory** in the **Settings**.
Using the Study Manager

Open
You can open videos and other files in the study from the Study Manager.

To open:

- **Study** (both the video and the findings): Either double-click the line representing the study or click the study and then click the Open button at the bottom of the screen. If more than one findings file is associated with the selected video, a second screen opens prompting you to select the related findings file you wish to open.

- **Video only**: Right-click anywhere in the Study Manager screen and select Open Video Only. The video of the selected study opens. The Settings screen enables further options for the Study Manager, such as opening findings automatically.

- **Report**: Click Open Report at the bottom of the screen. The report associated with the selected study opens as a PDF file.

  **Note**  
  When you open a RAPID video while another video is still open, the RAPID software automatically closes the previously opened RAPID video. If you made changes to the findings of the open video, you are asked to save changes before closing the video.

Export
The Export function allows you to save a study or one of its files in a different place or under a different name, to reorganize your archives. This includes:

- Burning a study or a file to a CD/DVD
- Saving a study or a file to another archive, such as a USB storage device
- Saving a study or a file to a specific location
- Saving a study as Zip file
**Burning a Study to a CD/DVD**

The Study Manager allows you to burn a study or specific files of a study to a disc, with the following restrictions:

- No multi session disc burning: once a disc is burned, you can not add any other data to it.
- You can burn either the whole study (all the files in the folder) or one single file.

For advanced options, see *CD/DVD Burning* on page 197.

**To save a study to a disc:**

1. Insert a blank CD/DVD in the drive.

2. Open the Study Manager by clicking 🗂️ at the top of the screen, or select **View Study > Study Manager** from the Home screen.

3. Select a study from the list on the Study Manager to export to CD/DVD.

4. Click **Export**. The following screen appears.

![Export Study Screen](image)

**Note**

Exporting does not move the study files but creates a copy of them to the desired location.

5. Select either **Entire study** or **Specific files**. If you select **Specific files**, a window opens inside the screen showing the files for selection.

   If you wish to remove all personal patient information, select the check box **De-identify** at the bottom of the screen.

   The size of the file is displayed below the check box.
6. Click **Next**.

7. Select **Specific location** under **Select destination** and click **Next**.
   The following screen appears.

8. Browse for the CD/DVD drive on your computer.

9. Type in a volume name for your disc.

10. Click **Save**. A screen appears showing the progress bar and **Exporting study**.
    When the progress bar is full, the last screen appears with the message **File export successful**.

11. Click **OK**. RAPID will eject the CD or DVD when the burning operation is complete.

12. Write the volume name on the disc.
**Saving a Study to Another Archive**

The Study Manager allows you to save a study to another archive, such as a USB storage device. When you connect a USB storage device to one of the USB ports of the computer, the Study Manager treats it as an archive and the icon 🛡️ appears on the left side of the screen.

---

**Note**

USB storage devices used for Raw Data Copy or for transport of RAPID videos should be labeled as such, stating that it may contain clinical data and should not be used for other purposes.

---

1. Select the relevant study and click **Export**. The Export Study screen appears.

2. Select either **Entire study** or **Specific files** under Select data to export. If you select Specific files, a window opens inside the screen showing the files you can select.

3. If you wish to de-identify the video in the study, select the check box **De-identify** at the bottom of the screen. Any reports created for this study also will be included in this export so make sure that sensitive data is already de-identified if needed (see Report Ribbon on page 147).

4. Click **Next**.

5. Select **Another archive** under Select destination and click **Next**.

6. Click the relevant USB icon and click **OK**.

7. A screen appears showing the progress bar and **Exporting study**.

8. When the progress bar is full, the last screen appears with the message **File export successful**. Click **OK**.
Reviewing and Interpreting RAPID Videos

Only after saving data on a USB storage device is complete, take special care to correctly unplug the device. Improper removal of a USB device may cause loss of data and computer instability.

To safely remove a USB storage device:

1. Click the icon on the left side of the screen to select the USB storage device.
2. Click Eject.
3. When the message that you can safely remove the hardware appears, unplug the USB storage device.

Saving a Study as a Zip File

The Zip function of Study Manager uses WinZip to zip the files, a measure that ensures all files in a RAPID study stay together for convenient handling such as sending by email.

To zip files:

1. Select the relevant study and click Export.
2. Select either Entire study or Specific files under Select data to export. If you select Specific files, a window opens inside the screen showing the files for selection.
3. If you wish to de-identify the video in the study, select the check box De-identify at the bottom of the screen. The report will not be de-identified.
4. Click Next.
5. Select Zip file under Select destination and click Next.
   The Save screen appears.
6. If you would like to save to another location click Browse and navigate to the desired location and click Save.
7. A screen appears showing the progress bar and Saving zip file.
8. When the progress bar is full, the last screen appears with the message Zip study successful. Click Close.

Delete

The delete function allows you to remove studies entirely or partially from archives.

To delete a study:

1. Select the relevant study and click Delete.
   The Delete Files screen appears.
2. If you wish to delete the entire study, select the check box Delete entire study at the top.
3. If you wish to delete specific files, select them and click **Delete**.

![Image of delete study dialog box]

**To delete multiple studies:**

1. Select the relevant studies by clicking on one and holding the Control button on the keyboard and selecting another study.

2. Once the studies to be deleted are selected, click the **Delete** button.

   An attention screen appears for confirmation of the deletion.

   ![Note: Deleting a study in the Study Manager deletes all data including procedure videos from the source directory. This cannot be undone.]

**Offline Studies**

The Offline studies screen displays information about studies stored on removable storage media, such as CDs, DVDs, and some USB storage devices, that have been connected to the computer during use of RAPID and are currently disconnected from the computer. It allows you to browse for studies in archives which are currently not connected to the computer.

The offline study list is updated when the removable storage media is disconnected or reconnected. A reconnected study no longer appears in the **Offline Studies** list. Once reconnected, the removable media containing the study is displayed in the left side of the Study Manager screen.

Preexisting studies will appear in the **Offline Studies** list only after they have been connected and then disconnected from the computer during use of RAPID.
Offline studies information includes the **Volume Name** and **Volume Type** or kind of media. Volume names for CDs and DVDs are allocated at the time the disc is burned. For USB devices, a unique name (rather than the name designated by the manufacturer) must be allocated before use.

In order to be able to locate a desired study, be sure to mark the disc or other media with its volume name.

**To access an offline study:**

1. Find the study in the **Offline Studies** list.
2. Locate the volume listed.
3. Connect it to the computer.

To save the **Offline Studies** list, use the Backup/Restore feature for Offline Studies (see *Backup/Restore Offline Studies* on page 193).

**Note**

DO NOT remove the USB storage device until after any actions performed with it are completed.
Overview of the RAPID Interface

In the RAPID v8.3 software, a wide band spans the top of the main program window. This ribbon is comprised of three tabs. Each tab on the ribbon has different buttons and commands that are organized into ribbon groups. This ribbon replaces the menus and toolbars in previous RAPID versions.

When opening a RAPID video the RAPID user interface displays the **View** tab. This tab contains many of the most frequently used commands for viewing a RAPID procedure video.

The ribbon interface is designed to help you quickly find the commands that you need to complete a task. Commands are organized in logical groups, which are collected together under the **View** and **Report** tabs.

When working with study videos, the controls you need for viewing, annotating, and creating reports are arranged in ribbons, which group similar functions together.

There are three basic components to the ribbon:

- **Ribbon Tabs:** There are three ribbon tabs, **File**, **View** and **Report** that span across the top. Each one represents an activity area.

- **Ribbon Groups:** Each tab has several groups that show related items together.

- **Commands:** A command is simply a button, a box to enter information, or a menu.

The RAPID interface enables multiple ways to access functions:

- by clicking a button,
- by right-clicking to select an option,
- by using the menu options.

**Dialog Box Launchers**

Some ribbon groups have a small diagonal arrow in the lower-right corner that when clicked will display certain options that are not otherwise visible. In the RAPID interface, there are three screen launchers to show additional options:

- in the **View** screen, in the **Preview** ribbon group,
- in the **Report** screen, in the **Configure** ribbon group,
- in the **Report** screen, in the **Image Data** ribbon group.
Quick Access Toolbar

The Quick Access Toolbar is the small area to the upper left of the ribbon that contains a set of frequently used commands.

By default, the following common commands are displayed in the Quick Access Toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Home]</td>
<td>Closes the current study and returns to the Home screen.</td>
<td>![Open]</td>
<td>Browses to open a new video.</td>
</tr>
<tr>
<td>![Manager]</td>
<td>Opens the Study Manager.</td>
<td>![Save]</td>
<td>Saves the Findings.</td>
</tr>
<tr>
<td>![Atlas]</td>
<td>Opens the Atlas.</td>
<td>![Previous]</td>
<td>Goes to the previous image.</td>
</tr>
<tr>
<td>![Next]</td>
<td>Goes to the next image.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To remove the command shortcut from the toolbar, right-click the command and select **Remove from Quick Access Toolbar**.

When right-clicking the Quick Access Toolbar, there are two other options to select from:

- **Show Quick Access Toolbar below the Ribbon**: Moves the toolbar below the ribbon. To return the toolbar above the ribbon, right-click the toolbar again and select **Show Quick Access Toolbar above the Ribbon**.

- **Minimize the Ribbon**: Hides the ribbon temporarily but displays the ribbon tab. To temporarily show the ribbon click once on the desired tab. Clicking anywhere on the screen will hide the ribbon again. To restore the ribbon, click on the **File, View or Report** tabs or right-click the Quick Access Toolbar and uncheck **Minimize the Ribbon**. Optionally, click the minimize button ▼ on the top right of part of the ribbon and click it again ▼ to restore.
## File View

The **File** menu contains several commands that enable you to open a video or findings, save a video, connect to the Study Manager, or connect to the RAPID Help. The table below displays the **File** menu commands. You can click on the command, or if available a secondary command appears when hovering the mouse over a command.

<table>
<thead>
<tr>
<th>Button</th>
<th>Menu command</th>
<th>Secondary commands</th>
</tr>
</thead>
</table>
| ![Open](image.png) | Clicking the **Open** button launches the Windows screen to browse and open a video. Optionally, hover over the button to display secondary commands. | **Open Video from selected folder**
| | | **Open Findings related to the currently open study** |
| ![Save](image.png) | Click to save video or hover over the button to display secondary commands. Make sure there are no spaces at the beginning or end of the file name. If spaces are included, the **Save** option will be grayed out. | **Save Findings**
| | | **Save Findings As**
| | | **Save Video As**
| | | **Save De-Identified Video As** |
| ![Close](image.png) | Close video or findings. | **Close Video**
| | | **Close Findings** |
| ![Study Manager](image.png) | Click to open the Study Manager. | |
| ![Recent Videos](image.png) | Click to load recently viewed video or hover over the button to display recently viewed videos to choose from. | |
Reviewing and Interpreting RAPID Videos

Overview of the RAPID Interface

### View Screen

The **View** screen is used for viewing videos created from PillCam capsule endoscopy procedure. It is accessed by clicking the **View** tab.

The **View** tab in the RAPID software allows for viewing the RAPID video, marking and annotating thumbnails of interest, and adding any comments to the study.

The **View** screen enables the following functions to review the patient study:

- Preview and review the patient procedure video using the RAPID video player.
- Use viewing layouts and image adjustment features to enhance or to focus on the video image.
- Annotate thumbnails for later viewing and commenting.
- Designate thumbnails as anatomical landmarks GI tract.
- Use the Localization feature to show the localization track and display the gastric passage times.

<table>
<thead>
<tr>
<th>Button</th>
<th>Menu command</th>
<th>Secondary commands</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Tools" /></td>
<td>Hover over the button to display secondary commands.</td>
<td><strong>User Dictionary</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image2" alt="Export" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image3" alt="Import" /></td>
</tr>
<tr>
<td><img src="image4" alt="Help" /></td>
<td>Click the <strong>Help</strong> button to load the RAPID Online Help. Hover over the button to display secondary commands.</td>
<td><strong>Help</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image5" alt="Online Help" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image6" alt="Help Center" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image7" alt="About" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Customer Support</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image8" alt="Contact Us" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image9" alt="Collect Analysis Files" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image10" alt="RAPID Log" /></td>
</tr>
</tbody>
</table>
• Display Progress Indicator to show viewing progress of the small bowel

View Ribbon
The View ribbon is divided into several groups enabling many different functions. The buttons and commands are organized in the following logical groups:

• Preview/Review
• Viewing Layouts
• Image Adjustment
• Zoom
• Show

Preview/Review Groups
Below is a description of the Preview/Review group buttons and the commands that can be performed for viewing the capsule endoscopy video. This group of buttons enable to preview the video and then to review and read the complete video using the Viewing Layouts described in the next buttons grouping below. For a complete explanation on the use of the features described, refer to the cross-reference provided, if available.
Preview Group buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Collage view" /></td>
<td><strong>Collage view for COLON 2 procedures only:</strong> In the Collage view relevant parts from selected images of interest are cropped and arranged in a matrix to provide an overview of the most interesting image elements from the study video. This layout contains 8 rows and the maximum number of the columns that can fit on the display (dependent on resolution). Use the navigation buttons or the scroll wheel on the mouse to view the next matrix. When hovering on an image in the collage, the complete image with both the previous and next images will be displayed on the left side of the screen. Click an image to select that image and view the enlarged image on the left, without hovering. A blue border appears around the selected image. To return to hovering mode, click the image with the blue border again. &lt;br&gt;&lt;br&gt;The Collage View must be enabled in the <strong>Settings</strong> (see Research Tools Section on page 175). <strong>Collage view is not intended for diagnostic review and should not be used as a substitute for reviewing the video in one of the other viewing layouts.</strong></td>
</tr>
<tr>
<td><img src="image" alt="SBI mode" /></td>
<td><strong>SBI mode:</strong> Sets the Suspected Blood Indicator (SBI) previewing mode to show marked images suspected of containing blood for fast review in sequence. SBI image locations are marked on the color bar (see <strong>SBI View</strong> on page 129).</td>
</tr>
<tr>
<td><img src="image" alt="QuickView mode" /></td>
<td><strong>QuickView mode:</strong> Sets the QuickView previewing mode to show only significant images that may be of interest in the video stream to provide fast previewing and landmarking of a video. The number of images to be considered <strong>images of interest</strong> can be set as percentage of the video by the user. This provides for fast previewing and landmarking of a small bowel video. The RAPID scans all images and scores them according to the possible level of significance. Then according to the percentage level set by the user it displays a short video to provide an overview of the case prior to full review (see <strong>QuickView</strong> on page 125). <strong>The QuickView feature is not intended to detect pathology in lieu of a physician and should not be used as a substitute for reviewing the entire video.</strong></td>
</tr>
<tr>
<td><img src="image" alt="Complementary QuickView mode" /></td>
<td><strong>Complementary QuickView mode:</strong> Sets the Complementary QuickView previewing mode to show the complementary part of the video (that is, everything that was not included in QuickView) (see <strong>Complementary QuickView</strong> on page 126). Only a review of both QuickView and Complementary QuickView is equivalent to a full video read. <strong>The Complementary QuickView feature is not intended to detect pathology in lieu of a physician and should not be used as a substitute for reviewing the entire video. Review of both QuickView and Complementary QuickView is required for full video review.</strong></td>
</tr>
</tbody>
</table>
**Review Group Buttons**

**Button** | **Function**
---|---

**Standard Review mode:** This button sets the standard review mode for PillCam SB 3 (AFR), PillCam COLON 2, PillCam ESO 2, and PillCam ESO 3/UGI procedure videos. Display rate can be set by the user by moving the viewing speed slider.

**A-mode Review mode:** This button sets the review mode to show the A-mode (Automatic) video created for all PillCam SB 2 as well as for all PillCam SB 3 with PillCam recorder DR2 procedure videos.

**M-mode Review mode:** This button sets the review mode to show the M-mode (Manual) video created sequentially from all captured images for PillCam SB 2 as well as for all PillCam SB 3 with PillCam recorder DR2 procedure videos if creation of M-mode video is enabled in Settings.

By default, creation of manual mode video is disabled during download. To enable manual mode, see *Video Creation Section* on page 174.

**Viewing Layout Group**

This ribbon group contains tools for customizing the video display from one video head: Single, Dual, Quad, and Mosaic view. The tools maximize reading efficiency by simultaneously displaying consecutive images in one easily viewed image.

**Note**

Dual and Quad views are available only when viewing the video from one video head (that is, from one end of the capsule).

**Button** | **Function**
---|---

**Single view:** Shows the video in Single view, one single frame on the screen.

**Dual view:** Shows the video in Dual view, which displays two consecutive frames side by side at the same time. Frames 1 and 2, then frames 3 and 4, then frames 5 and 6, etc. This is different than dual-head capsule videos that display a single frame from each of the two capsule heads simultaneously side by side.

**Quad view:** Shows the video in Quad View, which displays four consecutive frames. The order of the images is presented in a clockwise fashion.
### Image Adjustment Group

This ribbon group contains the controls for preset or custom adjustment of the displayed video image. This includes controls adjusting for sharpness, brightness, color, and FICE or Blue-processed image.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Off</strong></td>
<td>Turns Image Adjustment off.</td>
</tr>
<tr>
<td><strong>On</strong></td>
<td>Turns Image Adjustment on.</td>
</tr>
<tr>
<td><strong>Adjust</strong></td>
<td>Opens the Image Adjustment screen.</td>
</tr>
</tbody>
</table>

Image Adjustment provides an alternative image view via a single click using proprietary technology with enhanced sharpness and contrast. **Sharpness**, **Color**, and **Brightness** controls enable customizing of the image to user preferences. When clicking the **Adjust** button the following screen appears:

![Image Adjustment Screen](image)

- Click on the buttons labeled FICE or Blue for pre-set image enhancements.
- Use the sliders to adjust the sharpness, brightness and color of the image.

**Mosaic view** shows the video in Mosaic view, which displays 18 consecutive frames on the screen. The order of the images is from top to bottom for each column, moving from left to right.

The time indicator shows the time for the top left image in the display.

*Mosaic view is not intended for diagnostic review and should not be used as a substitute for reviewing the video in one of the other layouts.*
### Button | Action
--- | ---
![Off] | No image adjustment.

FICE 1, FICE 2, or FICE 3. FICE viewing tool aids the reader in observing tissue surface characteristics and vascularity and by visually enhancing suspected structures. All FICE settings are available when viewing SB videos; only FICE 1 is available when reviewing a COLON 2 video.

Blue Mode provides another view of the mucosa that may assist in the interpretation process by rendering a bluish image to enhance contrast.

Clicking this button applies the factory presets for image adjustment: Sharpness: 3; Brightness: 0; Color: 0.

Clicking this button AFTER you have made your own adjustments using the sliders preserves your setting for the next time you click ![On].

---

**Note**
The image adjustment tools have not been cleared by FDA for polyp diagnosis purposes.
To adjust the video image appearance:

1. Click in the ribbon to turn on Image Adjustment to the factory presets, or, if you saved your preferences earlier, to your own presets.

2. If you wish to adjust the image otherwise, click in the ribbon. The following screen appears:

3. Select any of the active buttons FICE 1, FICE 2, FICE 3 or Blue for these preset image adjusters.

4. To adjust the image yourself, click Configure "On" Button. The screen expands.

5. The "On" state means that image adjustment is applied to the image. The expanded screen shows the settings currently in effect.

6. Use the Sharpness, Brightness and Color sliders to get the desired result, as shown by the video image of the open video that provides a preview of the changes you are making.

7. Click Save to save your settings. The next time you turn on the Image Adjustment, these settings are applied.

8. If you wish to return to the factory preset, click Reset.

9. Click Close to close the Image Adjustment screen.
**Zoom Group**
This ribbon group contains the controls for displaying the video image at different zoom levels.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Fit the image size to the window." /></td>
<td>Fits the image size to the window.</td>
</tr>
<tr>
<td><img src="image" alt="Changes the zoom of the video view by sliding left or right and displays the current zoom in percentage." /></td>
<td>Changes the zoom of the video view by sliding left or right and displays the current zoom in percentage.</td>
</tr>
</tbody>
</table>

**Show Group**
This ribbon group enables the display or hiding of video viewing features. Using the check boxes next to the features you can enable or disable the following:

- **Show Thumbnails**
- **Show Localization**
- **Show SB Progress bar** (SB videos only)
- **Show Comments Editor**
- **Dynamic Player Control**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Click to show all features in the Show group. Clicking again will only show the features that were previously enabled." /></td>
<td>Click to show all features in the <strong>Show</strong> group. Clicking again will only show the features that were previously enabled.</td>
</tr>
<tr>
<td><img src="image" alt="Shows the video in full screen on the computer screen, without any of the other elements of the View screen, including the ribbons. To return to normal view, press ESC. Pressing F11 on the keyboard has the same functionality." /></td>
<td>Shows the video in full screen on the computer screen, without any of the other elements of the <strong>View</strong> screen, including the ribbons. To return to normal view, press ESC. Pressing F11 on the keyboard has the same functionality.</td>
</tr>
</tbody>
</table>
Using RAPID to View a Video

To view a video, you can open a video from Study Manager by clicking View Study, and then selecting Study Manager on the RAPID home screen. Open a selected study by double-clicking it or click once and then click the Open button. The Study Manager provides a list of the videos available for viewing. The Study Manager organizes the studies in a way that enables easy access and management of studies, sorting, and searching by different criteria such as patient name and procedure dates. Refer to Using the Study Manager on page 107 for more information.

To view a video, you can also click the File menu on the RAPID interface and browse for your study in the file system.

Reading a Capsule Endoscopy Video

Before loading a RAPID Capsule Endoscopy video to the RAPID software it is important to review the patient history prior to reading the video in order to:

- Consider all possible indications as per the patient history.
- Prepare for identification of relevant pathology as per the possible indications identified.

To read PillCam studies efficiently, the reading process is broken into 3 components:

- **Preview:** Scan the capsule endoscopy video using QuickView mode to establish a preliminary interpretation. This can be followed by a Complementary QuickView scan to perform a complete review of the video. You may also augment your preview by previewing in SBI mode to quickly scan the bleeding-suspicious images.

- **Review:** Review the complete capsule endoscopy video in normal viewing mode.

- **Report:** Complete a Patient Report that summarized the interpretation of the study. Refer to Creating a PillCam Capsule Endoscopy Report on page 146.

QuickView

Use the QuickView feature to perform a fast preview of the video. QuickView makes RAPID video review more efficient by displaying only images that may be of interest in the video stream to provide fast previewing and land marking of a small bowel video. The number of images to be considered images of interest can be set as percentage of the video by the user. The RAPID scans all images and scores them according to the possible level of significance. Then according to the percentage level set by the user it displays a short video to provide an overview of the case prior to full review. The recommended viewing speed is 7-10 frames per second using Single View layout.

Scan the entire video in QuickView mode to:

- Establish approximate landmarks for the first gastric, first duodenal, and first cecal images.
- Capture thumbnails of images of interest.
- QuickView may be used to review gastric and colon images.

**Note**
The QuickView feature is not intended to detect pathology in lieu of a physician and should not be used as a substitute for reviewing the entire video.

- The absence of a particular frame from the QuickView display should not be interpreted to mean that no abnormal finding is present in that frame.
- SBI images are also included in the QuickView.
• The QuickView by no means replaces a thorough viewing of the entire video by a qualified physician.
• Using the mouse scroll wheel in this mode also displays each frame of this mode one by one.
• In the QuickView mode, the video navigation buttons change to the following:


• The user can determine the number of images of the RAPID video to be viewed in the QuickView mode, by changing the percentage rate of images to be shown and hence the sampling rate, which is by default 10%.

To change the QuickView sampling rate:

1. From the View screen, click the dialog box launcher ( ) of the Preview ribbon group. The following screen appears:

![QuickView Settings dialog box]

2. Type in the desired sampling rate (between 2% and 80%) for the QuickView and click OK to save it.

Note
When viewing a video in CQV mode, you cannot change the QuickView sampling rate.

Complementary QuickView
After viewing the video in QuickView mode, click the CQV (Complementary QuickView) button to view rest of the video not shown in QuickView mode. In Complementary QuickView mode (CQV) RAPID displays only the images that are not included in the QuickView mode. Playing a video from start to end in QV mode and then in CQV mode results in viewing all video images.

Viewing a Video
If not using QuickView and Complementary QuickView combination to view a RAPID video, you can use the View button to scan the video from start to finish if you are using a PillCam SB 3, PillCam COLON 2, or PillCam ESO/UGI capsule. If you are viewing a PillCam SB 2 video, you can select the A-mode (default) or M-mode button to set your viewing mode. In all modes, you can move through a video by using the navigation buttons below the video image:

• Play forward or backward by clicking the play buttons .
• Speed up or down the video display using the viewing speed slider .
• View the next or previous image by using and .
• View the last image or first image of the video by using and.

• Clicking and holding the slider on the time bar and dragging it to move the video forwards or backwards.

• Clicking the time bar moves the video image to that specific location.

To go to a specific frame of the video:
1. Select numbers of the time indications.
2. Type the desired time unit in the format HH:MM:SS.
3. Press ENTER. The video automatically progresses to the exact video image of the time specified.

Dynamic Player Control

The Dynamic Player Control in RAPID allows you to control the speed at which you view the video, using your computer mouse.

Use the controls as follows:

• Click anywhere in the rectangle around the backward or forward arrow to play the video in the required direction. Click again to stop the video.

• While the video is playing, move your mouse cursor UP and DOWN to control the speed at which the video plays. When you stop the video, a number appears showing the rate at which you are viewing the frames.
• The Dynamic Player Control includes a Turbo Mode function which allows speeding up viewing a segment of the video. To view the video in Turbo Mode, while the video is playing, click and hold the mouse button. The playing speed accelerates and the rectangle changes to orange.

• The orientation indicator appears briefly above the backward/forward arrows to show the viewing direction when you switch between the backward or forward arrows.

• The orientation indicator appears above the backward/forward arrows when you pause viewing, and shows your current viewing location. Use the mouse wheel to scroll backward/forward in the video. Click the gray location indicator to go back to the previous location, and continue viewing from that point.

• The Area of rapid change alert is available in COLON 2 videos only. The Approaching area of rapid change notification appears when you approach a segment of the video where the capsule travels at a higher speed. This notification is followed by the Area of rapid change alert. When this alert appears, you can use the Dynamic Player Controls to adjust viewing speed.

This option is available when the Enable Reviewer Alert option is enabled under Tools > Settings.

Note
The Reviewer Alert functionality is only available for COLON 2 videos compiled with RAPID v8.3.

Dual Head View

PillCam ESO/UGI and PillCam COLON capsules have two video heads and by default, two images are displayed: one for each head of the capsule. Note that two images displayed thus side-by-side is not DualView: the two side-by-side images are from different video heads. The capsule icon as shown below is both the control and the indicator for the dual head video display mode. The icon consists of three buttons: left (green if active), right (yellow if active) and the middle (activates both displays green and yellow).

<table>
<thead>
<tr>
<th>Capsule Icon</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Image" /></td>
<td>Default view for COLON and ESO/UGI videos: images of both heads are displayed. Click either the far left side or the far right of the icon to view one single video.</td>
</tr>
<tr>
<td><img src="image2" alt="Image" /></td>
<td>View only the images from one head. Click the other side to view the video from the other head. Click the middle of the icon to return to viewing both videos.</td>
</tr>
</tbody>
</table>
When typing thumbnail comments in PillCam ESO/UGI and PillCam COLON videos, the comments appear green for thumbnails captured from the left represented capsule video head and yellow for thumbnails captured from the right represented capsule video head.

**SBI View**

The Suspected Blood Indicator (SBI) feature automatically marks images suspected of containing blood and provides the ability to review them in sequence. SBI image locations are marked on the Color Bar.

In the SBI mode, RAPID shows the SBI marked images. The video control buttons turn red and you can play the SBI-images-only back and forth by the controls. SBI images are also included in the QuickView.

This viewing mode feature is available only:
- After the first landmark is entered for the first duodenal image or any later landmark.
- If suspected images are found.
- The RAPID video is a PillCam SB video.

The Suspected Blood Indicator (SBI) feature is a guide to areas of suspected fresh GI bleeding. The SBI display feature becomes available only from the first duodenal image on. Hence the SBI feature is available only after labeling the first image of the Duodenum.

When SBI is activated, red ticks appear above the time bar and they indicate the location of SBI images.

SBI lines are not displayed in the area before the first duodenal image, which becomes gray.

**To display the SBI images:**

1. Identify and label the first image of the duodenum (see Using Localization and Landmarks on page 137).

2. Click . The video navigation buttons turn red.

3. Use the video navigation buttons to view the SBI images.

**Time Bar/Color Bar**

The Time bar/Color bar displays:
- The total length of the video and the average color for easy anatomical segmentation of the corresponding image. The unit of time is hours, minutes, and seconds.
- The slider moves along the time bar as the video is played. You can also use the slider to move the video forwards or backwards.
- Moving your mouse over the time bar displays the time at the position of the cursor. If the mouse stays at a location on the time bar for longer (about 2 seconds), the image at that location is
displayed in a small window, with the time indication of that image at the top. If the video is in dual head view (ESO/UGI, COLON), two images appear, one for each head.

- You can move the video display to a certain location by clicking that location on the color bar.
- SBI indicators (small red ticks) appear in the top part of the Time bar/Color bar (see SBI View on page 129). The area before the landmarked first duodenal image is gray.
- GI divisions are colored in a narrow strip below the Color Bar according to defined Landmarks. The regions have specific colors.

<table>
<thead>
<tr>
<th>Color</th>
<th>Region of GI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>Esophagus</td>
</tr>
<tr>
<td>Turquoise</td>
<td>Stomach</td>
</tr>
<tr>
<td>Orange</td>
<td>Small intestine</td>
</tr>
<tr>
<td>Green</td>
<td>Colon (large intestine)</td>
</tr>
</tbody>
</table>

- Lines in region-specific colors connect the location on the time bar and the thumbnails.
- Before defining the landmarks, the narrow strip below the Color Bar is gray.

Time Indication
The time indication box displays the time of the frame in hours, minutes, and seconds after the capsule starts acquiring images in the procedure.

Creating and Annotating Thumbnails
Thumbnails are images captured from the video. Some images are automatically created, such as those that are marked during real-time viewing with PillCam recorder DR3. These thumbnails have the default annotation of Thumbnail marked in recorder. When reviewing the video, the physician may capture any image of interest for further scrutiny. The images appear at the bottom of the screen. Double-click on the video image in the center of the screen to designate it as a thumbnail. Alternatively, click the Capture Thumbnail button located next to the video player buttons to add an image that appears on the screen to the thumbnails.

Note
The thumbnails and associated comments are saved in the Findings file (see Working with Findings on page 143).

Each thumbnail appears in the Thumbnail section.
**To create a thumbnail:**
Double-click the video display, or click the **Capture Thumbnail** button.

**To view a thumbnail in the video display:**
Double-click the thumbnail.

The RAPID automatically displays the desired image on the screen, the cursor in the Time Bar jumps to the thumbnail location in the video. The thumbnail in the thumbnail section will be highlighted with a blue filled outline.

**To view the adjacent images:**
- In the **View** screen, use the and buttons to view the adjacent images, or roll the mouse wheel forward or backward.
- In the **Report** screen, roll the mouse wheel forward or backward to view adjacent images of the video to capture these as new thumbnails.
- In the **Report** screen, use the and buttons to view the adjacent thumbnails.

**To scroll through the thumbnails:**
If there are more thumbnails than fit on the screen, RAPID allows you to scroll through the thumbnails by several alternative modes:
- An arrow appears on either side of the thumbnail section. Click and hold either of the arrows to scroll left or right.

- When you hover with your cursor in the thumbnail section, a scrollbar appears on the bottom allowing you to drag the bar to sideways to scroll through the thumbnails.
- Using your mouse, click and hold on the thumbnail section and drag the thumbnails to either side to scroll.

Thumbnails can also be annotated, saved, exported as images, deleted or selected for inclusion in the capsule endoscopy report.

**Thumbnail Status**
The thumbnails are displayed on the bottom of the View screen. Visual appearance designates different statuses:

<table>
<thead>
<tr>
<th>Thumbnail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt=" Thumbnail Description" /></td>
<td>This is a thumbnail without any visual effects.</td>
</tr>
<tr>
<td><img src="image" alt=" Thumbnail Description" /></td>
<td>Dark blue background means that the thumbnail is selected so operations can be performed on it. For multiple selections hold down the CTRL button on the keyboard and click the desired thumbnails with the mouse. For multiple selection of consecutive thumbnails, hold down the SHIFT key and select the first and last desired thumbnail. All available actions (displayed by right-clicking on a thumbnail) will operate on all selected thumbnails.</td>
</tr>
</tbody>
</table>
Thumbnail | Description
---|---
| The external blue border means that the thumbnail is selected for inclusion in the report.

| The internal border means that this thumbnail is the currently displayed video image.

Mouse-over a thumbnail without effects gives it a light blue background. Also, a checkbox becomes available in the top left corner for selecting the thumbnail for the report, as well as the edit button in the top right corner.

**Thumbnail Comments**

To add a comment to a thumbnail, use one of the following methods:

- Click the check box **Comments Editor** in the ribbon of the View screen.
- Right-click the thumbnail when in the View or Report screen and select **Edit Thumbnail Comment**.
- Hover over the thumbnails and click ![checkbox](image) in the top right corner of the thumbnail to open the thumbnail editor.

**Comments Editor**

The **Comments Editor** at the left side of the screen enables the user to type in their comments about a specific thumbnail or about the whole study.

**Note**

You can toggle to and from right-to-left writing, as supported by Windows convention by pressing the ALT and SHIFT keys simultaneously.

**Editing Tools**

When typing comments in the comments editor the following two tools are available:

- **GI Dictionary**: simplifies efficient report creation via a pre-populated and customizable database of terms and phrases. RAPID software preserves the GI Dictionary customizations from previous versions during software upgrade.
Reviewing and Interpreting RAPID Videos

a. Type a part of a word anywhere during text editing on the screen.

b. The dictionary is context sensitive and shows the closest approximations of words starting with the same letters.

c. If the matching word exists, the cursor highlights the word. Press SHIFT + ENTER to enter the complete word without further typing, or double-click it in the GI Dictionary.

d. All keyboard commands for the user dictionary:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift + Up Arrow</td>
<td>Move the selection cursor inside the dictionary up</td>
</tr>
<tr>
<td>Shift + Down Arrow</td>
<td>Move the selection cursor inside the dictionary down</td>
</tr>
<tr>
<td>Shift + Enter</td>
<td>Inserts the current selected dictionary phrase to the text box.</td>
</tr>
<tr>
<td>Control + R Shift</td>
<td>Align the text to right side</td>
</tr>
<tr>
<td>Control + L Shift</td>
<td>Align the text to the left side</td>
</tr>
<tr>
<td>ESC</td>
<td>Temporarily close the GI Dictionary</td>
</tr>
</tbody>
</table>

- **Spell checker:** if the spell checker is activated, a red wavy line appears below any word not recognized by RAPID. To select one of the suggested corrections, right-click and select the desired option.

**Note**
If you write more than 256 characters in the text box of a thumbnail comment, the final printout of the thumbnail comment may be split between two pages. Any thumbnail after that will start on a new page, leaving the space after the split comment blank.

To enable or disable the GI Dictionary or the Spell Checker:

1. From the Home screen, select **Tools > Settings**.

2. On the **General** tab, under the **Regional Settings**, select the check box next to the feature.
**Thumbnail Editor**

Clicking the edit button in the top right corner of a thumbnail loads the **Thumbnail Editor**.

Buttons on the left of the thumbnail editor are tools to affect markings on the thumbnail (see *Markings Buttons Group* on page 152) that also appear in the ribbon of the **Report** screen.

At the bottom, you can type your comments into the **Comment** box. Alternatively, use the comments editor to type your comments for the thumbnail.

The **Thumbnail Comments** box is also located on the left side of the screen in the **View** screen if checked in the **Show** ribbon group. It is displayed automatically in the **Report** screen.

If a thumbnail is selected to be included in the patient report, any comments entered for the thumbnail will appear below it in the report.

**Marking Tools**

You can add marks to a thumbnail to point out or emphasize certain areas of interest.

| Note | Marks on a thumbnail are saved together with the thumbnail and appear as such in the report and on the thumbnail itself. |

To access marking tools:

- **View screen**: click in the top right corner of a thumbnail. The thumbnail appears enlarged with all the marking tools at its left side.
- **Report screen**: all the marking tools are in the **Markings** ribbon group.

**Mark Circle**

Creates a circle around an area of interest:

1. Click 🔍.
2. Place cursor over area of interest.
3. Click and drag without releasing to create a larger circle to include area of interest.

**Mark Arrow**

Creates an arrow pointing to an area of interest:

1. Click .
2. Place cursor to the side of the area of interest.
3. Click and drag without releasing toward area of interest. The arrow points to region of interest.

**Undo Mark**

Clears the last mark created. Click repeatedly to successively clear all marks.

**Circumference Scale**

*(For ESO/UGI procedures only)* RAPID provides an optional circumference scale for estimating the circumferential involvement of esophageal varices in the Report screen. The circumference scale displays 12 equivalent ticks on the image periphery.

1. Click in the ribbon of the Report screen.

2. Point the cursor and click anywhere on the circle to rotate the scale to facilitate estimation of the circumferential involvement of a finding.

3. You can rotate the grid as follows:
   a. Move the cursor over the periphery of the image. The cursor changes into a 4-arrow cursor.
   b. Click and drag the scale around to match it to the varices you want to measure.

**Polyp Size Estimation**

*COLON 2 procedures only:* Tool for estimating the size of a suspected polyp. To use this feature, activate it as follows.

**To activate Polyp Size Estimation:**

1. From the Home screen, select **Tools > Settings**. The **Settings** screen appears.
2. Select the Video tab and in the Research Tools section, click the checkbox next to Enable Polyp Size Estimation.

3. Click Apply or OK.

To use Polyp Size Estimation

1. Click in the ribbon.

2. Place cursor at one end of a polyp.

3. Click and drag (without releasing) to create a double pointed arrow from one end to the other end of the polyp for which you wish to estimate the size.

4. The size estimate appears at the end where you release the mouse button. If you make more than one size estimate for the same image, the estimates are counted: #1, #2, etc.

5. To remove a marking, click the Undo Mark button . The last marking disappears. Click repeatedly to successively clear all marks.

Note
The Polyp Size Estimation measurement is only an estimate. Use discretion when making diagnostic or treatment decisions.
# Using Localization and Landmarks

**Landmarks**

Landmarking an image labels it as one of the anatomical landmarks along the GI tract. A different default landmark menu is displayed for each RAPID video type, as follows:

<table>
<thead>
<tr>
<th>Video type</th>
<th>Landmarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESO/UGI video</td>
<td>First esophageal image</td>
</tr>
<tr>
<td></td>
<td>Z-Line image</td>
</tr>
<tr>
<td></td>
<td>First gastric image</td>
</tr>
<tr>
<td>SB video</td>
<td>First gastric image</td>
</tr>
<tr>
<td></td>
<td>First duodenal image</td>
</tr>
<tr>
<td></td>
<td>First ileocecal image</td>
</tr>
<tr>
<td></td>
<td>First cecal image</td>
</tr>
<tr>
<td>COLON video</td>
<td>First cecal image</td>
</tr>
<tr>
<td></td>
<td>Last cecal image</td>
</tr>
<tr>
<td></td>
<td>Hepatic flexure image</td>
</tr>
<tr>
<td></td>
<td>Splenic flexure image</td>
</tr>
<tr>
<td></td>
<td>First rectal image</td>
</tr>
<tr>
<td></td>
<td>Last rectal image</td>
</tr>
</tbody>
</table>

**To create a landmark:**

Right-click on video image you identify as the landmark and select the correct landmark label.

If, for the video you are viewing, you wish to enter a landmark other than the default landmarks, select **Capture Other Landmarks**. This option displays all the landmarks for selection.
Suggested Flexure Landmarks for COLON Videos

This feature is available (active) only if a PillCam sensor array was used during the procedure. If a PillCam sensor belt was used, this option is inactive and grayed out. After you have marked the first cecal image, RAPID can suggest the Colon Flexure landmarks.

1. Right-click anywhere on the video images and select **Suggest Colon Flexure Landmarks**.
   
   Two new thumbnails appear in the thumbnail section with the captures: ?Hepatic flexure? and ?Splenic flexure?
   
2. Double-click the suggested flexure thumbnails for review.
   
3. To accept the suggested flexure landmarks, right-click the thumbnails and select the appropriate landmark option.

Suggested Landmarks for PillCam SB 3 Videos

To use this feature to suggest the SB 3 landmarks:

1. Right-click anywhere on the video images and select **Suggest Small Bowel Landmarks**.
   
   Two new thumbnails appear in the thumbnail section with the captures: ?First Duodenal Image? and ?First Cecal Image?
   
2. Double-click the suggested thumbnails for review.
   
3. To accept the suggested landmarks, right-click the thumbnails and select the appropriate landmark option.

Localization

Localization provides the approximate location and track of the PillCam capsule in the GI tract via a two-dimensional representation. The Localization feature is available for SB and COLON videos.

![Note]

Localization is **only** available for procedures performed with a sensor array. The Colon Location Diagram is available for COLON 2 videos even if performed with the sensor belt, but the localization feature will not appear.

When at least one landmarked thumbnail has been captured and created for the first image of one of the anatomical landmarks along the GI tract, the localization feature is enabled, and:

- A sketch of the estimated track of the capsule in the GI tract in the abdomen area is displayed in gray.
- A small white circle with a black dot on the capsule track indicates the estimated position of the current frame being viewed.
The capsule track is segmented into the GI tract segments according to user landmarking: stomach, small intestine, large intestine. The part of the GI tract that is already viewed becomes colored according to the same color codes as on the lower part of the time bar, as follows:

<table>
<thead>
<tr>
<th>Section of GI tract</th>
<th>Color</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gastric</td>
<td>Blue</td>
<td>Indicates the stomach. The entrance to the stomach is marked by a blue dot.</td>
</tr>
<tr>
<td>Small bowel</td>
<td>Orange</td>
<td>Indicates the small bowel. The entrance to the small bowel is marked by a green dot.</td>
</tr>
<tr>
<td>Cecal</td>
<td>Green</td>
<td>Indicates the large intestine. The entrance to the large intestine is marked by a yellow dot.</td>
</tr>
</tbody>
</table>

Defined landmarks on the capsule track are seen as small circles of the same color as the underlying GI region.

You can move the video display to a certain location by clicking that location on the localization track. Hovering the mouse over a point on the localization track for 2 seconds shows the images at that location in a separate window. The time indication of these images appears at the top.

If instead of the localization track, a small sketch of the abdomen appears with a red X in the upper left corner, this means that the Localization feature is not enabled due to the detection of a faulty sensor.

When viewing an ESO/UGI video, the PillCam logo appears instead of the localization track.

**PillCam Progress Indicator**

The PillCam Progress Indicator appears only:

- for SB videos,
- after you have landmarked the first duodenal image and the first cecal image,
- in automatic (A) mode for SB 2 and SB 3 (AFR) videos.

The PillCam Progress Indicator graphically presents the progress of reviewing the small bowel. The slider on the left side shows an estimate of the percentage of the small bowel viewed.
The right side graph represents an estimate of the redundancy or similarity of the images captured by the capsule as it moves through the small bowel (and may indicate where the capsule moved slowly through the bowel).

![Level of image similarity](image)

You can move the video display to a certain location by clicking that location on the Progress Indicator. Hovering the mouse anywhere on the Progress Indicator loads an image from that location in a pop up window. The top of the window shows the progress of the SB reviewed in percentage.

Colon Location Diagram
The Colon Location Diagram, a three-sided localization diagram, represents the three colon sections: ascending (or right) colon (on the left side), transverse colon (on the upper side), and descending (or left) colon (on the right side). This feature is available for PillCam COLON videos of procedures performed with a sensor array as well as a sensor belt in addition to the localization track. It displays the colon segment containing the displayed image by highlighting the corresponding section in the diagram. The Colon Location Diagram becomes active after you landmark the first cecal image. Once you have landmarked the Hepatic and Splenic Flexures, either independently by identifying these landmarks or by accepting the suggested landmarks in RAPID if the procedure was performed with a sensor array, the section containing the currently displayed images lights up on the Colon Location Diagram.

![Colon Location Diagram](image)

**Note**
Colon Location Diagram function is only an aid for the physician, and the accuracy is dependent on the physician's ability to identify the four anatomical images that separate the right, transverse, and left colons.
Passage Times
Passage time is the time the capsule spent in a given region of the GI tract. Calculation of passage times is enabled only after you segment the video from the GI tract by labeling the first images of the different sections of the GI tract. When you identify and label the first and last images of the gastric, SB, or cecal section of the GI tract, the RAPID software calculates the relevant passage times based on the time tags of the landmarked thumbnails.

The RAPID software displays this data at the bottom of the Localization Display section.

Note
The estimation of the passage times is based solely on the physician's identification of the first image of each section of the GI tract.

Comparing Thumbnails
There are three scenarios to compare images in RAPID v8.3:

- **Atlas comparison:** Compare a RAPID video thumbnail to Atlas images (see Comparing Video Images to Atlas Images on page 154).
- **One thumbnail comparison:** Compare a thumbnail to itself in different display modes (i.e. FICE or Blue mode).
- **Two thumbnail comparison:** Compare two different thumbnails in the same video.

To compare a thumbnail to itself (One frame comparison):

1. Click the thumbnail you wish to examine.
   A dark blue background appears around the thumbnail.

2. Right-click the thumbnail and select Compare Thumbnails.
   A separate window appears, showing the same thumbnail duplicated, side by side.
3. Use the **Image Adjustment** tools at the top of the window of one of the thumbnails to compare the two images.

![Image Comparison](image.png)

**Note**
You can scroll through the video by moving your mouse wheel in either direction. Both sides will move together.

**To compare two images in the same video:**

1. Click the first thumbnail you wish to use for comparison.

![First Thumbnail](thumbnail1.png)

2. Hold down the CTRL key on your keyboard and select the second thumbnail.

![Second Thumbnail](thumbnail2.png)

3. While still holding down the CTRL key, right-click either one of the selected thumbnails and select **Compare Thumbnails**. A separate window appears, showing both thumbnails side by side.

![Compare Thumbnails](compare_window.png)
RAPID Video Files

A RAPID study is the collection of files associated with a specific PillCam Capsule Endoscopy procedure. A RAPID study is contained in a folder that contains the RAPID video file.

The *.gvi file and the RAPID study name consists of several elements separated by spaces. The components are derived from Patient Check-in information transferred from the PillCam recorder during the video creation:

- Patient’s last name
- Patient’s middle initial
- Patient’s first name
- Patient’s ID number in parentheses
- Examination date in the following format: (DD MMM YYYY)

For example: the RAPID folder with the name Doe F. John (12345) 21 Feb 2008, which resides in E:\videos, contains the file named Doe F. John (12345) 21 Feb 2008.gvi.

You may save a RAPID folder and a RAPID video to a removable media (USB storage device or disc) for one of the following reasons:

- To back up a RAPID study.
- To copy a RAPID study from the hard disk in order to free space on the computer.
- To move a copy of a RAPID study onto another computer or to another physician.

To save a RAPID study to a CD/DVD, see *Burning a Study to a CD/DVD* on page 108.

To save a RAPID study to a USB storage device, see *Saving a Study to Another Archive* on page 110.

Working with Findings

A findings file contains:

- All the thumbnails with their comments or other annotations (see *Creating and Annotating Thumbnails* on page 130).
- A link to the check-in information.
- All the study comments (see *Editing Tools* on page 132).
- A link to the report, if created.
Saving Your Findings

It is possible to save your findings. You can open and view this file with the RAPID video on any computer with the RAPID software installed.

Note
Save the findings frequently to avoid accidental loss of data.

To save findings in new location:

1. Select File > Save > Save Findings As.
   The Save Findings As screen appears.

2. Select a location for saving:
   • If you intend saving to a disc, insert a formatted writable disc into the appropriate drive and select it from the screen.
   • If you intend saving on a USB device, plug in the USB device and select the USB device.
   • The default location is the RAPID folder of the currently displayed video.

3. Click Save.
   The findings file is saved. The name of the associated RAPID directory, the associated RAPID video file and the findings are saved.

To save findings to the last saved findings file:

Click the button in the Quick Access toolbar located at the top of the RAPID screen, or click Save Findings from the File menu.

The findings file is saved to the same location and under the same name.
Opening a Findings File

To open a findings file:

1. Select File > Open and then select Open Findings. If a findings file is open, RAPID asks if you want to save the current findings file. The Open Findings File window appears, showing the folder of the current video. A findings file can also be opened using the Study Manager (see Open on page 107).

2. Select the findings file you wish to open.

   To open a findings file stored in another location, navigate to the desired location by clicking Browse.

3. Click Open.

   Once the findings file is loaded, the saved thumbnails with their annotations appear in the Thumbnail section. If the findings contain landmarks, the following note appears: Calculation of passage times for the esophagus, stomach, small bowel and colon is based solely on your selection of the first image of the esophagus, stomach, duodenum, cecum and the last image of the rectum.

4. Click OK to continue.

Note

You may load only a findings file associated with the currently displayed video. If you attempt to load a findings file that is not associated with the loaded RAPID video, an error message appears notifying you of the mismatch.

If you load another findings file associated with the same video, the open findings file closes. A message appears asking you to save the open findings file before closing it.
Overview

After viewing the capsule endoscopy video and creating the findings, an interpretation of the study can be summarized in a patient report. This phase should be performed after the Preview and Review phases.

The data created during the Review phase is now stored in the corresponding video folder. The RAPID software's Report ribbon enables the creation of reports and exporting of video clips and images to another directory or to a CD for later use.

The Report ribbon enables the following functions to prepare the patient report and complement the patient study:

• Add additional thumbnails and study comments.
• Add markings (circles and arrows around lesions for emphasis and size estimates) to all thumbnails.
• Add comments to all thumbnails.
• Save images and create video clips for later use in presentations or referrals.
• Use the Atlas or Lewis Score clinical tools in the Report ribbon for diagnostic comparison or evaluation using a scoring index.
• Generate a patient report that can also be printed and emailed.
• Export the results or patient summary.
Reviewing and Interpreting RAPID Videos

Report Ribbon

The Report ribbon is divided into several groups enabling many different functions. The buttons and commands are organized in the following logical groups:

- Configure
- Report
- Image Data
- Markings
- Clinical Tools

In this chapter the groups will be explained in a different sequence than how it appears in the software in order to closely match the proper workflow that is used when interpreting the data.

Configure Buttons Group

The Configure group enables the selection of templates for report generation, the ability to de-identify patient information, to select/deselect all thumbnails, and view an enlarged view of captured thumbnails.

Template Selection for Report

The template drop-down list shows 4 templates that can be selected before generating a report. The 4 templates to be shown in the drop-down list can be configured from a pre-loaded library of 12 report templates of different variations. The templates differ from each other in the inclusion or exclusion of the Localization track, the SB Progress Indicator associated with each thumbnail and the size of thumbnails displayed in the final report. It is at the discretion of the user to configure which templates to use in the workflow. Only 4 of the 12 reports will be shown in the drop-down list in the Report ribbon. The selected report template will be used for each particular case. To configure the templates, see Report Templates Section on page 177.

Note: Upgrading the RAPID software from v7 to v8.3 will replace all templates and their configuration.
Other Commands in the Configure Buttons Group

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎥 Select All Thumbnails</td>
<td>Select all thumbnails for inclusion in the capsule endoscopy report or when saving clips and images.</td>
</tr>
<tr>
<td>🎥 Unselect All Thumbnails</td>
<td>Unselect all thumbnails to exclude them from the capsule endoscopy report or when saving clips and images.</td>
</tr>
<tr>
<td>🎥 Select Current Thumbnail</td>
<td>Select current thumbnail for inclusion in the capsule endoscopy report or when saving clips and images.</td>
</tr>
<tr>
<td>✅ De-Identify</td>
<td>Anonymize patient information in the printed or exported capsule endoscopy report.</td>
</tr>
<tr>
<td>🎥 Thumbnails View</td>
<td>Displays an enlarged view of captured thumbnails.</td>
</tr>
</tbody>
</table>

Thumbnails View

For easier viewing of captured thumbnails, RAPID includes a screen that displays an enlarged view of the thumbnails. You can use this screen to review and select thumbnails for inclusion in the report.

To view a screen with magnified thumbnails:
1. In the Report tab, select the Thumbnails View button.

An enlarged view of the thumbnails appears. Thumbnails that were selected in the regular view are also selected in this view. You can select or unselect thumbnails as required.

2. To return to the previous screen, click the Thumbnails View button again or click the X button in the upper right corner of the screen.
Configure Dialog Box

Allows defining thumbnail settings. When using the FICE or Blue Mode options when viewing thumbnails, you can include a “normal” thumbnail image alongside the FICE/Blue thumbnail when creating a report.

To include a normal image alongside the FICE or Blue thumbnail in the Report:

1. From the Report screen, click the dialog box launcher ( ) of the Configure ribbon group. The following screen appears:

   ![Configure Dialog Box](image)

2. Select the Include normal image alongside FICE or Blue thumbnail checkbox and click OK. When you generate a report, you will see both images, as in the example that follows.

   ![Example Image](image)

Report Buttons Group

Below is a description of the Report button group buttons and the commands that can be performed for managing the capsule endoscopy reports:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Print Preview" /></td>
<td>Preview the capsule endoscopy report before printing. Clicking this button opens a print preview page of the report. The buttons on top of the print preview screen also enable to print, save, save as, or email the report as an attachment.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Select the printer, number of copies, page range, and other printing options before printing. A version of the report is also saved after printing.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save the report with a date and time stamp in the current location with the current file name.</td>
</tr>
</tbody>
</table>
### Button | Function
--- | ---
Save As | Save the report in the user selected location with the selected name. Use only alphanumeric characters in the file name. Make sure there are no spaces at the beginning or end of the file name. If spaces are included, the Save option will be grayed out.
Send as Attachment | Send a copy of the capsule endoscopy report in an email message as an attachment, using your default email program.

The Export button drops down to display the following export options:
- Export the Results of the capsule endoscopy to a folder in a directory defined in Settings, for use by a hospital information system. This folder can contain thumbnail images and markings, video clips, PDF report, and an XML file containing the report data, including the path to these files. This option enables hospital administrators to later import the files with related attachments from this predefined directory. To enable this data sharing, the structure of the input and output of the files must be defined for the RAPID software. Consult the RAPID v8.3 IT Guide for more information.
- Export a Patient Summary of the capsule endoscopy to a folder in a directory defined in Settings. This folder can contain thumbnail images, PDF report, and video clips that can be played in Windows Media Player. This option enables the patient to keep the procedure data archived or to use as the summary for a physician referral.
For both export options above, the data can be exported to a drive directory (which is pre-defined in Settings) or to a CD. Simply check the box **Export to directory** and type the location to where to export. This can be done for both the **Results Export** and **Patient Summary Export**.

If the **Export to directory** is left unchecked, a screen prompting to select a location to export will be displayed each time you export. When exporting the results or patient summary, a copy of the report is also saved locally on the computer.

The checkbox **Include video clips in export data** will enable saving clips and images during export.
**Markings Buttons Group**

This ribbon group contains tools for marking the selected thumbnails. When viewing a procedure video, the Thumbnail Editor enables marking and annotating of selected thumbnails. The Markings buttons group in the Report tab enables deleting a thumbnail and marking already created thumbnails during the Preview and Review stages. Refer to (Marking Tools on page 134) for complete instructions on marking thumbnails.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="circle.png" alt="circle" /></td>
<td>Creates a circle around an area of interest.</td>
</tr>
<tr>
<td><img src="arrow.png" alt="arrow" /></td>
<td>Creates arrow pointing to area of interest.</td>
</tr>
</tbody>
</table>

**Enabled only for COLON 2 procedures:** Polyp Size Estimation (PSE) tool: Tool for estimating the size of a suspected polyp after boundaries are marked, and displays the results on the thumbnail next to the polyp. *Polyp Size Estimation is a tool for research purposes only and the values generated should not be used in making diagnostic or treatment decisions.*

**For ESO/UGI procedures only:** Activates Circumference Scale: Displays circular grid to estimate the circumferential involvement of suspected pathology such as esophageal varices (see Circumference Scale on page 135).

| ![undo](undo.png) | Undoes last graphical marking made on the thumbnail. |
| ![delete](delete.png) | Deletes selected thumbnail. |

**Clinical Tools Buttons Group**

The Clinical Tools button group provides access the two diagnostic tools, the RAPID Atlas and the Lewis Score that are available in RAPID.
RAPID Atlas

RAPID Atlas enables side-by-side comparisons of an image in a video to validated reference images with Atlas reference images. It provides a database of Capsule Endoscopy images from case studies. Reference images are searchable by Capsule Endoscopy Structured Terminology (CEST), by Diagnosis or by Lewis Score terms.

There are three ways to reach the RAPID Atlas:

- **Home screen**: Click Tools > Atlas.

- **View screen**: Right-click any thumbnail or video image and select Open Atlas.
• **Report screen:** Click the button on the **Report** ribbon.

**Note**
You can activate the RAPID Atlas regardless of whether or not a video is open. If there is no video open, the space for the **Current Image** in the top left corner is left blank.

If there are more than six images available in the RAPID Atlas under a certain category, a scroll bar appears at the bottom of the screen to allow you to scroll to the rest of the images.

**Note**
The RAPID Atlas by no means replaces careful diagnosis from a trained physician.

**Comparing Video Images to Atlas Images**
To compare an image from the current video (Current image) with any of the images from the RAPID Atlas, select CEST, Diagnosis or Lewis Score tabs to display images in that category.
Select from the images that appear on the right side of the screen by clicking on the image. A comparison screen with the current image and the Atlas provided image appears.

Both images appear enlarged, side by side. The **Current Image** on the left and the image from the RAPID Atlas on the right, including all the comments, case history and any additional available information on the Atlas image. If there is more text than available space on the screen, a scroll bar appears next to the text.

**Atlas Image Export**

You can export images from the Atlas to your computer as follows:

1. Right-click an image on the **Atlas** screen and select **Export**. The **Export Atlas Image** screen appears.

2. Browse for the location on your computer where you wish to save the image, if desired rename the image, and click **Save**.

**Lewis Score**

The Lewis Score is an aid to diagnosis that provides an approximate measure of degree and extent of mucosal damage based on direct visual imaging of the small intestine not provided by current methodologies. The index is based on quantitative and qualitative descriptors relating to three endoscopic variables: villous edema, ulceration, and stenosis. Combined with other clinical parameters (symptoms, patient and family history, previous diagnostic tests, lab values), the score could provide a threshold for differential diagnosis and be used to monitor the progress of treatment.

- An automated scoring system provides greater standardization of disease activity assessment.
- Provides an additional point of evaluation to assist in determining appropriate patient management.
- The Lewis Score facilitates communication and standardization for assessing disease states before, during, and after treatment.
- Monitoring therapy effectiveness with a standardized score has clinical value.
When clicking the Lewis Score button, a scoring index is displayed and the currently selected thumbnail is shown on the right side.

The tool is used for calculating the Lewis Score and is enabled only when all of the following conditions are met:

- The video is a PillCam SB video.
- Thumbnail images of the small bowel have been created.
- The first duodenal and first cecal images are marked as landmarks.

**To use the Lewis score:**

1. Click in the ribbon of the Report screen. The Lewis Score screen appears.
   - The current thumbnail is visible at the right side of the screen.
   - The Lewis score (which appears at the top of the screen) and the panel entitled Stenosis (next to the thumbnail), relate to the entire small bowel.
   - The left of the screen is divided into three tabs, relating to video tertiles. A tertile is one third of the small bowel as calculated by the transit time of the PillCam capsule in the small bowel. The 1st SB Tertile is the proximal third, the 2nd SB Tertile is the middle third, and the 3rd SB Tertile is the distal third of the small bowel.

2. Select the tertile you are referring to by clicking the appropriate tab. The selected tertile on the color bar and the thumbnails selected within it are in color, whereas the rest of the color bar and thumbnails are darkened.

3. Under Villi, select the:
   - Degree of Appearance
• Length of segment for Longitudinal extent
• Correct Distribution

4. Under Ulcers, select the:
   • Appropriate Number
   • Length of segment for Longitudinal extent
   • Correct range for Circumferential extent

5. Select the next tertile and repeat.

6. Under Stenosis, select:
   • The appropriate Number
   • Yes or No for Ulcerations
   • Yes or No for Traversed

The Lewis Score at the top of the screen updates automatically.

Lewis Score Glossary:

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appearance (of villi)</td>
<td>Edema where width of villi is equal or greater than height of villi. Evaluated villi in mucosa distinct and separated from an ulcer rather than contiguous to a mucosal break.</td>
</tr>
<tr>
<td>Circumferential Extent</td>
<td>Portion of the entire image involved by the lesion, based on the entire lesion including its collar. This value is entered for the largest ulcer in the tertile.</td>
</tr>
<tr>
<td>Few (ulcers)</td>
<td>2–7 lesions.</td>
</tr>
<tr>
<td>Lewis Score</td>
<td>A capsule endoscopy scoring index for small intestinal mucosal disease activity (<em>Aliment Pharmacol Ther</em> 27, 146-154).</td>
</tr>
<tr>
<td>Long segment</td>
<td>Equal to 11–50% of a tertile.</td>
</tr>
<tr>
<td>Multiple (ulcers)</td>
<td>8 or more lesions.</td>
</tr>
<tr>
<td>Short segment</td>
<td>Less than or equal to 10% of a tertile.</td>
</tr>
<tr>
<td>Tertile</td>
<td>One third of small bowel as calculated by the transit time of the PillCam capsule in the small bowel.</td>
</tr>
<tr>
<td></td>
<td>• 1st SB Tertile is the proximal third of the small bowel.</td>
</tr>
<tr>
<td></td>
<td>• 2nd SB Tertile is the middle third of the small bowel.</td>
</tr>
<tr>
<td></td>
<td>• 3rd SB Tertile is the distal third of the small bowel.</td>
</tr>
<tr>
<td>Whole segment</td>
<td>Greater than 50% of a tertile.</td>
</tr>
<tr>
<td>Ulceration</td>
<td>Mucosal break with white or yellow base surrounded by a red or pink collar.</td>
</tr>
</tbody>
</table>
Generating a Report

1. Click on the checkbox on the top left of the thumbnail to include it in the report.

- To unselect the thumbnail, click the checkbox again.

- Optionally, use the Select Current Thumbnail button to select or unselect the thumbnail.

- To select all the images, click Select All Thumbnails button.

- To unselect all images, click Unselect All Thumbnails button.

Note
Any disclosure of images taken by the PillCam Capsule Endoscopy System without the patient's consent might violate the patient's privacy rights. To export findings without patient information, click the De-Identify checkbox in the ribbon.

2. Check De-Identify to exclude any patient information from the report.

3. Select the desired template from the list in the ribbon.

4. If you have selected to request electronic signature feature option (see Electronic Signature on page 178), enter the Windows login password.

5. If you have marked thumbnails in FICE or Blue Mode, you can create a report that includes these thumbnails alongside the normal thumbnail. To do this, click the dialog box launcher of the Configure ribbon group and select the Include normal image alongside FICE or Blue thumbnail checkbox. Click OK to save the settings.
A report, like the one displayed below is generated and can be saved, printed or sent as an email attachment. The report template Image (M) + Localization + Progress Indicator is used to generate the below layout.

**Sample report:**

![Image Data Buttons Group](image)

**Image Data Buttons Group**

The **Image Data** ribbon group contains advanced tools for working with images, video clips and segments. Short RAPID video segments can be created and combined from different points in the procedure video. Images can be saved in JPEG format for viewing later. Additionally, video clips centered on selected images can be generated for the patient to be viewed in Windows Media Player.
### Button Function

<table>
<thead>
<tr>
<th><strong>Button</strong></th>
<th><strong>Function</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Clips/ Images</td>
<td>Create an image from a thumbnail or a video clip from a selection of thumbnails. Click the <strong>Save Clips / Images</strong> button and select from the different options in the drop-down list, and then choose the directory to save the file(s).</td>
</tr>
<tr>
<td><img src="image1.png" alt="Images Only" /></td>
<td>Creates (a) jpeg(s) of the selected thumbnail(s) and saves to a folder.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Video Clips Only" /></td>
<td>Creates mpeg video clip(s) surrounding the selected thumbnail, created from 50 before and 50 after the selected thumbnail. Video clips can be viewed in Windows Media Player. The number of images used in creating a video clip from a selected thumbnail is determined in <strong>Image Data</strong> settings. Click the dialog launcher on the bottom right of the <strong>Image Data</strong> button group. This will launch the <strong>Image Data</strong> screen.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Create Video Clip" /></td>
<td>Creates jpeg(s) as well as mpeg clip(s) of the selected thumbnail. Using this feature will create a jpeg image of each selected thumbnail and a video clip surrounding the selected thumbnail. The number of images used in creating a video clip from a selected thumbnail is determined in <strong>Image Data</strong> settings described above. The images and clips are saved to a selected directory.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Video Clips and Images" /></td>
<td>Creates a video clip from the first selected thumbnail to the last selected thumbnail. This feature is enabled only if at least two thumbnails are selected. Video clips can be viewed in Windows Media Player.</td>
</tr>
</tbody>
</table>

The default length of clips is 100 images. Change and select the number of desired images for each thumbnail (50, 100 or 150) and click OK. If upgrading from RAPID v7 and previous setting was 200 images for each thumbnail then need to redefine it in this screen.
<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Video Segment</td>
<td>Creates a short RAPID video segment from the first thumbnail to the last thumbnail selected. Video can only be viewed with RAPID software. The segment is saved in a folder with a copy of the findings file. Feature is enabled only if at least two thumbnails are selected.</td>
</tr>
<tr>
<td>Save Joined Segments</td>
<td>Joins RAPID video segments created from selected thumbnails. Video can only be viewed with RAPID software. The segment is saved in a folder with a copy of the findings file.</td>
</tr>
<tr>
<td>Compare Thumbnails</td>
<td>Enables comparing of a thumbnail to itself in different display modes (i.e. FICE or Blue mode) or comparing of two different thumbnails in the video. Refer to <em>Comparing Thumbnails</em> on page 141 for more information.</td>
</tr>
</tbody>
</table>

**Note**

To export video clips and images without patient information, click the **De-Identify** checkbox in the ribbon.
Setup Requirements

Set up your office to accommodate the new PillCam Capsule Endoscopy System. Review the following workstation specifications:

Four electrical outlets are required to connect the following components: workstation computer, monitor, printer, and one cradle. Each additional cradle requires an additional outlet.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You may use a Given approved power strip.</td>
</tr>
<tr>
<td>• You may connect your monitor directly to the workstation using a DVI cable (the DVI-VGA adaptor is not required).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not connect any component of the PillCam Capsule Endoscopy System to the same outlet together with any appliance or device that has a high power requirement (refrigerators, generators, devices with motors, etc.). When setting up the system, make sure that the total power requirements for all of the devices connected to a single outlet or circuit do not exceed the rated limit for that circuit. If you are not sure of the rated limit, please consult your maintenance department or an electrician.</td>
</tr>
</tbody>
</table>

Do not use a KVM (Keyboard, Video, Mouse) Switch with the PillCam Capsule Endoscopy System.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extra space is needed for air circulation and cable connectors behind the workstation.</td>
</tr>
</tbody>
</table>

RAPID Installation

Before installing RAPID on your computer, it is recommended to be aware of the following prerequisites and other information:

• Before installation, it is highly recommended to format the hard disk in NTFS format, if not already done.
• You need at least 1.5 GB free space on your computer to install RAPID.
• For high resolution monitors, RAPID v8.3 offers the capability to resize and maximize the video view.
The registration window will open during the first time RAPID is opened and not at the end of the installation process.

It is highly recommended to install anti-virus software on the computer running RAPID.

Note
At the end of the RAPID installation process, restart your computer.

Main Endoscopy System Components

Following is a list of items which you need to connect in order to set up the PillCam Capsule Endoscopy System:

- RAPID workstation
- Monitor
- Keyboard
- Mouse
- Printer
- PillCam recorder with cradle

Connecting the Components

Warning
The RAPID workstation has either an automatic or a manual voltage select switch. In case the workstation has a manual switch:
- Verify that the workstation’s voltage is set according to the local voltage prior to connecting the RAPID workstation to the wall outlet.
- If the voltage is not set according to the local voltage, do not connect the system. Call Given Customer Support.

Caution
Voltage mismatch will damage the RAPID workstation.

Note
For workstations use the monitor's native screen resolution according to the monitor user manual.
Connecting the PillCam Recorder Cradle

You can connect the cradle only to the USB 2.0 ports that are side by side in a separate slot on the back panel of the Workstation. If you are not using a Given Workstation, use a USB hub for connecting more than one cradle to your computer.

Note
If you use more than one cradle, make sure each one is connected to a different power outlet.

Starting RAPID for the First Time

Before using the RAPID software, you must configure and personalize it.

1. For the RAPID workstation, log in as follows:
   - Single-user mode: Log in with the username rapid and leave the password blank.
   - Multi-user configuration: Log in with your username and password (created for you by the administrator).

   Note
   RAPID installed not on a Workstation and RAPID Reader do not require login.

   Note
   RAPID workstation only: The Computer Locked screen appears whenever the workstation is idle for more than half an hour. Only two users can unlock it:
   - The user who was logged in when the RAPID workstation went into Autolock, by entering the appropriate password, or
   - The system administrator.

2. Click on the desktop.

   When you run the software for the first time, a license agreement in English (US) appears on your screen, which is the legally binding version. A translation in other languages is provided.
3. Read license agreement and click **Yes** to accept it. You may select another language to read it, but you must reselect English to accept the license agreement.

Unrestricted use of RAPID requires registration via the Given Imaging registration center. You must supply requested information to obtain the Registration Key. The registration screen appears at the end of the installation process:

![Registration Screen](image)

**Note**
Keep the registration window open until you finish the registration. Each time you open the registration window, a new System Key appears and any Registration Key based on a previous System Key will not be accepted. If you click **Later**, you can open and use the RAPID software, but after seven uses without registering, you must first perform registration in order to use RAPID.

4. Obtain a Registration Key via the Given Imaging registration center online or by phone:
   - **Online**: [https://portal.givenimaging.com/RapidRegistration](https://portal.givenimaging.com/RapidRegistration)
   - **By phone**: Call your local Given Imaging customer support center.

5. Be ready to provide the Given Imaging registration center with the following information:
   - System ID (from the registration screen)
   - System Key (from the registration screen)
   - RAPID DVD serial number (supplied with the DVD)
6. Enter the Registration Key received from the Given Imaging registration center using ONLY lower case letters and numbers.

7. Click OK.

**Note**
If you do not register during installation, the next six times you open RAPID, you will be asked to register. After seven uses without registering, you cannot use RAPID without first performing registration.

8. The Home screen appears:

**Note**
It is recommended to restart your computer at least once a month to ensure optimal performance.
Single or Multi-user Setting

When RAPID is installed in a network environment, you can limit the access to RAPID to a group of authorized users. The system administrator must first set up a network group with all the authorized users. Once this is done, you must set up RAPID to enable only the users from this network group to use RAPID.

To enable access to other RAPID users:

1. From the Home screen, select Tools > Settings.

The Settings screen appears.

2. Under the General tab, in the Permissions section, check RAPID users must belong to this network group: and type in the network group.

3. Click Apply to accept the new settings or click Cancel to close the Settings screen without making any changes. Clicking OK will accept the new settings and close the Settings screen.

Note

Multi-user setting enables the correct electronic signature for each user login.

RAPID Workstation Configuration

The RAPID workstation configuration is a stand-alone configuration on a dedicated workstation that cannot be connected to a network environment. The RAPID workstation supports multi-user configuration. This allows you to control access to the workstation and to make sure that only authorized personnel use the appropriate files on the workstation.

By default, the RAPID workstation is configured for a single user with the username rapid and a blank password. You can continue to use the RAPID workstation this way, or you can use the multi-user feature. To do so, the administrator (person who sets up and maintains your facility's PCs) creates additional users, each with a unique username and password, and defines the appropriate access for them.
A user can change the password (usually what the administrator creates is a temporary password) by pressing Ctrl+Alt+Delete and clicking **Change Password**.

For Dell T3500 workstations, the administrator logs in with the username *administrator* and password *administrator*.

### RAPID Settings

Before you can start using the PillCam Capsule Endoscopy System, you should configure the settings in RAPID. These include:

- Information about users (those people authorized to use RAPID)
- The names of medical personnel involved in PillCam procedures, so these appear on the report
- Preferences and customization of CE (capsule endoscopy) reports
- ...and more

These settings affect all PillCam procedures performed with your RAPID. For example, the medical personnel names you enter during configuration are available for selection at patient check-in performed on your PC or workstation. If you set units of measurement to centimeters and kilograms, all patient data is shown that way.

To reach the **Settings** screen, select **Tools > Settings** from the Home screen:

The RAPID software settings are divided by tabs that categorize the settings options into the following divisions:

- **General**
- **Video**
- **Report**
- **Check-in**
- **Other**

Each tab is also sub-divided into separate sections. In the explanations on settings below some of the information may also be available in the corresponding chapter of the feature. For instance, the Regimen format section describes in brief the two options for printing a regimen however the Regimen Manager section displays the printout examples for comparison.
General Tab
From the Home screen, select Tools > Settings. The Settings screen appears showing the General tab.

After making the changes to the settings, click Apply to accept the new settings or click Cancel to close the Settings screen without accepting any changes. Clicking OK will accept the new settings and close the Settings screen.

User Information Section
The physician name, facility name and address (where the procedure was performed) and the facility logo entered during configuration show on the endoscopy report.

To define user information:
1. From the Home screen, select Tools > Settings. The Settings screen appears.
2. In the User Information section, type in the Physician Name.

If you do not enter the physician name here, no physician name appears on the CE report.
3. If more than one physician uses this installation of RAPID, select **Clear physician name when new video opens**. If selected, you can manually enter the physician name for each video when needed.

4. In **Facility details**, type in the facility information (for example, address and telephone number).

5. To add your facility’s logo to reports, click **Change Logo**.
   
   a. Navigate to the logo file (jpeg image) you previously saved on your computer and select the file.
   
   b. Click **Open** to set the file as the report logo.
   
   c. To clear the selected logo and prevent any logo from appearing on the report, click **Clear Logo**.

6. Click **Apply** to accept the new settings or click **Cancel** to close the **Settings** screen without making any changes. Clicking **OK** will accept the new settings and close the **Settings** screen.

### Regional Settings Section

By default, the RAPID software is set to English and uses metric units of measure. You may change these settings.

**To change the language:**

1. From the Home screen, select **Tools > Settings**. The **Settings** screen appears.

2. Under the **General** tab, in the **Regional Settings** section, open the **Language** list and select the desired language.

   ![Regional Settings](image)

   3. **Enable spell check** is selected by default. Un-check to disable spell check.

   4. **Enable GI Dictionary** is selected by default. Un-check to disable the GI Dictionary.

   5. Open the **Full name format** list and select the desired name format.

   6. Click **Apply** to accept the new settings or click **Cancel** to close the **Settings** screen without making any changes. Clicking **OK** will accept the new settings and close the **Settings** screen.

**To change the unit of measure:**

1. From the Home screen, select **Tools > Settings**. The **Settings** screen appears.

2. Under the **General** tab, in the **Regional Settings** section, open the **Measurement units** list and select the desired measurement system.

---

**Note**

The Logo used in the report is copied to a RAPID directory. The original is not affected.
3. Click **Apply** to accept the new settings or click **Cancel** to close the Settings screen without making any changes. Clicking **OK** will accept the new settings and close the Settings screen.

**Permissions Section**
Enables the system administrator to specify a list of local or domain user groups that are allowed to open RAPID.

**To specify a user group for RAPID:**

1. From the Home screen, select **Tools > Settings**. The Settings screen appears.

2. Under the **General** tab, in the **Permissions** section, type in the user group you wish to allow access to RAPID.

   The domain must be entered in this format:
   
   `<domain name>\<group name>;<local group name>;<next group>`

   This feature is enabled only if **System Wide** check-box is selected.

**Video Tab**
From the Home screen, select **Tools > Settings**. Then select the **Video** tab.

After making the changes to the settings, click **Apply** to accept the new settings or click **Cancel** to close the Settings screen without accepting any changes. Clicking **OK** will accept the new settings and close the Settings screen.
**Video Creation Section**

You can copy the video data from the PillCam recorder to the computer, a USB storage device, or a DVD without compilation into a video.

**To determine video creation method:**

1. From the Home screen, select **Tools > Settings**.
2. Select the **Video** tab.
3. In **Video Creation**, under **Creation method** select either **Create video directly from recorder** or **First copy raw data, then create video**.

   **Note**
   Select **First copy raw data, then create video** to quickly release the PillCam recorder after the raw data is copied without waiting for full video compilation. You must manually clear raw data files because this video creation method can rapidly fill up your hard drive.

4. You can change the following directories by typing the desired location or clicking **Browse** to select a folder:
   - **Video directory**: destination location for created videos
   - **Raw data directory**: destination location for copying raw from the PillCam recorder

5. You can also enable the following feature with the video by selecting the check box **Allow Manual mode for procedures other than SB3 with DR3 (increases file size)**.

**Video Data Management Section**

**To enable video data management:**

1. From the Home screen, select **Tools > Settings**.
2. Select the **Video** tab.
3. Under **Video Data Management**, **Disable video data management** is selected by default.
4. Select:
   - **Copy raw data**: copy data ONLY. This takes less time, so the PillCam recorder is freed up sooner. The copied data can later be processed to create a video.
   - **Compile raw data**: process for video creation.
5. Click **OK** to accept the new settings or click **Cancel** to close the **Settings** screen without making any changes.
Research Tools Section

To enable video research tools:

1. From the Home screen, select **Tools > Settings**.

2. Select the **Video** tab.

3. Under **Research Tools**, select:
   - **Enable FICE Viewing** (for SB, ESO 3/UGI and COLON 2 videos only)
   - **Enable Polyp Size Estimation** (for COLON 2 videos only)
   - **Enable Collage Viewing** (for COLON 2 videos only)
   - **Enable Reviewer Alert** (for COLON 2 videos compiled with RAPID v8.3 only)
Report Tab

From the Home screen, select **Tools > Settings**. Then select the **Report** tab.

After making the changes to the settings, click **Apply** to accept the new settings or click **Cancel** to close the **Settings** screen without accepting any changes. Clicking **OK** will accept the new settings and close the **Settings** screen.
Report Templates Section

To configure which of the pre-loaded templates will appear ready to use in the drop-down list in the Report ribbon, go to Home screen > Settings > Report tab.

Every template file name contains a variation of the features that determine the layout of the patient report. The abbreviations of features in the filename are explained below:

- **Localization**: Include localization of the GI tract with an indication of the progress of the capsule during the time that the thumbnail was taken. This is available only for SB and COLON procedures performed with sensor array.

- **Progress Indicator**: Displays both the capsule progress and the time elapsed in the Small Bowel in percent (%) format.

- **Image (L)**: Displays large thumbnails on the report printout. Note that this will use up additional paper when printing the report.

- **Image (XL)**: Displays extra-large thumbnails on the report printout. Note that this will use up additional paper when printing the report.

The templates are defined by either an inclusion (+) or exclusion (-) of the features described above. So for example, the template file name **Localization + Progress Indicator + Image (M)** would generate a report displaying the localization of GI tract with the progress indicator next to the medium-sized thumbnails. The report printout sample on page 159 is based on this template.

As another example, the template **Image (L)** will display only large thumbnails, without localization of the GI tract and without progress indicator.

After selecting the desired templates in Settings, the default template name in the drop-down list would be the template file name. The template name can be edited by clicking once in the template name field.
and editing the name. Click **Apply** or **OK** to save the settings. The four templates selected and edited will appear in the **Report** tab drop-down list.

![Template name will appear on Report ribbon]

**Note**

From the four templates in the settings screen, the templates can be unselected so as not to display in the RAPID software by clicking the checkbox on the left side of the template file name in the Settings screen. By default, one template must be selected.

**Electronic Signature**

An electronic signature is a way to allow authorized personnel to approve and validate a document without having to physically print it out and sign it manually. With this feature you may produce a *signed* capsule endoscopy report with the signing physician's name appearing in the signature field, where the electronic signature feature is the only way to achieve this, thus signifying *signature* of the document. Electronic signatures are widely accepted as legally valid. By default, the electronic signature feature is disabled.

**To activate use of electronic signature in Settings:**

1. From the Home screen, select **Tools > Settings**. The **Settings** screen appears.

2. Select the **Report** tab.

3. In the **Report Templates** section, select **Request electronic signature** and click **Apply** or **OK**.

![Request electronic signature]
Use of the Electronic Signature
Once the electronic signature is activated, the signature will be displayed when creating or printing a report. The signature will appear as electronically signed by: your first and last name, as it appears in your user profile (in Windows).

As a result, whenever a report is saved, printed, exported or sent as an attachment by email, the following screen appears.

Enter your login password and click Sign.

Results Export and Patient Summary Sections
For both Results and Patient Summary Exports, the data can be exported to a drive directory (which is pre-defined in Settings) or to a CD. Simply check the box Export to directory and type the location to where to export. This can be done for both the Results Export and Patient Summary Export.

The checkbox Include video clips in export data will enable saving clips and images during export.

If Export to directory is left unchecked a screen pops up prompting you to select a location to export each time you export. When exporting the results or patient summary, a copy is also saved locally on the computer.

Regimen Format Section
The Regimen Manager enables two convenient print layout options for the post-capsule ingestion instructions. The desired default layout can be configured selecting either pocket format or page format (see Print Layout of the Post-Capsule Ingestion Instructions on page 190).
Check-in Tab

From the Home screen, select Tools > Settings. Then select the Check-in tab.

After making the changes to the settings, click Apply to accept the new settings or click Cancel to close the Settings screen without accepting any changes. Clicking OK will accept the new settings and close the Settings screen.

Configure Check-in Fields Section

To add frequently used Check-in fields such as physician name and ICD Code:

1. Select a Check-in field from the list at the top of the screen and enter the corresponding values for this field.

2. Click Add.

   In the window below the text box you can see all the values already entered for this check-in field.

3. Use the Move Up and Move Down buttons to organize the defined values.

HIS Information Directory Section

If a HIS system is available, type the desired location from which to import patient data for Check-in or click Browse to navigate to the desired folder.
Other Tab
From the Home screen, select Tools > Settings. Then select the Other tab.

After making the changes to the settings, click Apply to accept the new settings or click Cancel to close the Settings screen without accepting any changes. Clicking OK will accept the new settings and close the Settings screen.

Study Manager Section
Created user columns in the Study Manager are available for use by other users. In the Shared data directory, type the desired location of the shared path or click Browse to navigate to it.

Display capsule sub-type: Also shows the sub-type in the Capsule Type column of the Study Manager.

Open findings automatically: When opening a video from the Study Manager the findings file will open as well (if available).

Regimen Settings Section
Displays the Regimen Settings location configured for your system. If this needs to be changed, type the location of or click Browse to navigate to the desired folder.
Customer Support Section

This section explains how to configure the RAPID software to allow the collection of performance data for analysis by the Given Imaging support department. RAPID allows for a one-click extraction and sending of RAPID log files for convenient customer support access. This enables easier tracking and background information on the RAPID software being used in the event of a malfunction. In order to enable this feature, you must first enter the email address for your regional Given Imaging Customer Support.

To enter Customer Support details:
1. From the Home screen, select **Tools > Settings**. This opens the **Settings** screen.

2. Select the **Other** tab.

3. Under **Customer Support**, click the **Email** list and select your regional customer support center. If it is not listed, you can type in the email address manually.

![Customer Support](image)

To extract and send RAPID log files:
In the event that you are requested to send the log files to Given Imaging Customer Support the steps below should be followed:

1. From the Home screen, click **Help > Customer Support > Collect Analysis Files**.

   The following screen appears.
2. Click the **General, Video, Recorder, Capsule & Sensor** tabs and enter the information in the editable fields. If there is a video that needs to be sent as well, click the **Browse** button in **Video logs** and navigate to the video.

3. Click the **Email** button to send the data to Given Imaging Customer Support.

---

**Regimen Manager**

The Regimen Manager is a RAPID software tool for generating pre-capsule ingestion regimen instructions to give to the patient before the day of the procedure and post-capsule ingestion regimen instructions for the patient to follow during the capsule endoscopy procedure. The Regimen Manager allows the creation and maintenance of a library of different instruction sets appropriate for different circumstances to choose from. The post-capsule ingestion regimen instruction set is selected during Check-in from the regimen library. The instruction set is uploaded to the PillCam recorder DR3 and is used for creating timely alerts to the patient during the procedure. Currently only procedures using the PillCam recorder DR3 with PillCam COLON 2 capsule utilize regimen instructions during the procedure.

This section gives an overview of the Regimen Manager tool as well as the following:

- **Using the Regimen Manager** on page 183
- **Pre-Ingestion Patient Instructions** on page 185
- **Post-Ingestion Patient Instructions** on page 187
- **Printing the Patient Instructions** on page 190
- **Print Layout of the Post-Capsule Ingestion Instructions** on page 190

**Using the Regimen Manager**

To access the Regimen Manager from the Home screen select **Tools > Regimen Manager**. The Regimen Manager comes pre-loaded with several pre- and post-capsule ingestion regimens for you to use. Any regimen to be used must be in an **approved** status by the user. None of the pre-loaded regimens in the library are in an **approved** status. Any regimen in the library to be valid and selectable in the menu must be reviewed and made **approved** by a physician. You can approve a regimen only when it is opened and from within the opened regimen screen.
Open a regimen by double clicking it or selecting it and clicking the **Open** button.

If upgrading the RAPID software to version 8.3 all previously approved regimens will require approval again.

The buttons on the bottom of the **Regimen Manager** screen perform the following:

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new regimen to add to the regimen library.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens the selected regimen.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected regimen. All regimens, including the pre-loaded regimens can be deleted.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the selected regimen. This button becomes available only after a regimen is approved.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays a preview of the selected regimen before printing. This button becomes available only after a regimen is approved.</td>
</tr>
<tr>
<td>Import</td>
<td>Imports a regimen from a selected directory. The default directory is designated in <strong>Settings</strong>.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports a regimen to a selected directory. The default directory is designated in <strong>Settings</strong>.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Regimen Manager.</td>
</tr>
</tbody>
</table>
Pre-Ingestion Patient Instructions

A completely clean colon is essential for a successful examination. Therefore, the patient must carefully adhere to the preparation procedure for cleaning the GI tract. The Regimen Manager can be used to create instructions for the patient to follow before the planned PillCam COLON capsule endoscopy procedure. The instructions identify the type of medications and liquid intake that must be taken in order to prepare the colon prior to the procedure. These preparation instructions can be edited and printed out for the patient beforehand. There could be different instructions appropriate to different circumstances or available medications. Pre-capsule ingestion patient instruction sets can be created and edited to maintain a library of valid usable regimen instruction sets.

To edit and save pre-capsule ingestion regimen instructions:

1. From the Home screen, select Tools > Regimen Manager.

The Regimen Manager screen appears.

2. Select the Pre-capsule Ingestion tab. The Regimen screen appears displaying all available pre-ingestion regimens.

3. Open a regimen by double clicking it or selecting it and clicking Open.

   The Notes field on the top right allows the typing of information for the specific regimen. It will not appear on the printout.

4. To add an instruction to the regimen click Add Instruction and designate the appropriate start and end day and time of the instruction using the drop-down lists in the adjacent columns. When typing the instructions in Instructions for Patient a pop up screen appears if the text is too long.
5. Type any other information in the **Additional Instructions** field that will appear on the printout for that specific regimen.

6. The regimens contain editable instructions in the **Instructions for Patient** column. Clicking the instruction will prompt an editor. Information represented in brackets [ ] is generic and is intended for completion by local staff with consideration to local names of the solution. Make any changes and click **OK** to save the updated instruction.

7. If you wish to include your instructions for a liquid diet, check the **Clear liquid diet** check box. This will display the list of **Allowed** and **Not Allowed** food or drink items. To modify these lists, click the **Edit** button. Make necessary edits and then click **Save** and **Close**.
8. If you wish to include your instructions for a fiber diet, check the **Low fiber diet** check box. This will display the list of **Allowed** and **Not Allowed** food or drink items. To modify these lists, click the **Edit** button. Make necessary edits and then click **Save** and **Close**.

**Note**
The **Liquid Diet** and **Fiber Diet** instructions are shared across all pre-capsule ingestion regimens. Any changes to the instructions will apply to all the pre-capsule ingestion regimens.

9. If you want to print this regimen later after saving it, click **Approve Regimen**.

10. When you are finished, click **Save**. This adds the regimen you created to the library of regimens available.

**Post-Ingestion Patient Instructions**

In order to ensure a successful procedure after capsule ingestion, the patient must carefully adhere to the personalized Post-Capsule Ingestion Instructions. The post capsule ingestion regimen instruction uploaded to the PillCam recorder DR3 during check-in enables the patient to be alerted during the procedure as to specific medications or liquids that must be ingested at the specified times. Once a regimen is selected from the regimen library during the patient check-in stage (before capsule ingestion) the schedule of instructions are programmed into the PillCam recorder for that particular procedure in a numbered sequence.

Using a tactile and sound alert, the PillCam recorder will notify the patient of a scheduled event by displaying the event number on the LCD screen. The patient needs to refer to this number on the Post-Ingestion Patient Instructions printout given by the medical staff. The following section explains how to edit the Post-Ingestion Patient Instruction. Approved regimens can be selected during the patient check-in stage and can be printed (see *Performing Patient Check-in* on page 43).

**To edit and save a post-ingestion regimen:**

1. From the Home screen, select **Tools > Regimen Manager**.

2. Select the **Post-capsule Ingestion** tab. The **Post-capsule Ingestion Regimen** screen appears displaying all the post-ingestion regimens available.

3. Open a regimen by double clicking it or select it and click **Open**.
The **Notes** field on the top right allows the typing of information for the specific regimen. It will not appear on the printout.

4. To add an instruction to the regimen click **Add instruction** and select from the list the appropriate timing for the instruction. When typing the instructions in the **Instructions for Patient** a pop-up screen appears if the text is too long.

5. Type any other information in the **Additional Instructions** field that will appear on the printout for that specific regimen.

6. The **Recorder Display** column on the left lists the event numbers that will be displayed on the PillCam recorder LCD screen along with the corresponding alert.

7. The **Trigger** column on the right of the timing column indicates that the event will activate the recorder instruction. This can be delayed by using the drop-down list on the left of each trigger.
8. The regimens contain editable instructions in the **Instructions for Patient** column. Clicking the instruction will prompt an editor. Information represented in brackets [ ] is generic and is intended for completion by local staff with consideration to local names of the solution. Make any changes and click **OK** to save the updated instruction.

9. Any other important information can be entered in the **Additional Instructions** box. This information will appear in the patient printout.

10. When you are finished, click **Save**. This adds the regimen you created to the library of regimens available.

11. By default, the post-capsule ingestion regimen includes at least the following alerts and instructions:
   - **Alert 0**: An instruction #0 (based on time passed from capsule ingestion) to take prokinetics to facilitate passage of the PillCam COLON 2 capsule to the small bowel. Threshold of time passed from capsule ingestion for alert 0 can be modified in the regimen manager for a specific regimen.
   - **Alert 1**: An instruction #1 for taking laxative after detection by the PillCam recorder of PillCam COLON 2 passage into the small bowel. It coincides with the activation of the AFR mode in the PillCam COLON 2 capsule and the appearance of the AFR status icon in the right corner of the status line at the top of the PillCam recorder DR3 display. The appearance of alert 1 can be designated to appear either an additional 0 minutes or 15 minutes after original tentative alert 1 timing. Alert 0 will not occur if alert 1 was raised before it.
   - The **End of Procedure** (EOP) alert occurs when no more capsule images are received by the PillCam recorder or enough time has elapsed in the procedure. This may occur several minutes after capsule excretion or after the capsule battery was depleted without excretion in a long procedure.

In general, additional alerts and instructions can be inserted between alert 1 and the EOP alert to reflect the physician's preference for post-ingestion instructions in a PillCam COLON 2 procedure. These instructions can be entered and edited, saved and **approved** through the Regimen Manager and be made ready to be selected in the Check-in for a PillCam COLON 2 procedure.

---

**Note**

Alert times are designated by the PillCam recorder and the RAPID software. In rare cases, short delays may occur.
Printing the Patient Instructions

You may need to print both types of Patient Instructions for the patient:

- The pre-capsule ingestion instructions need to be handed to the patient 1 or 2 days prior to the ingestion and are needed for proper preparation of the patient for the procedure.
- The post-capsule ingestion instructions need to be printed and handed to the patient after capsule ingestion. The reminder numbers on the screen of the PillCam recorder DR3 correspond to numbered instructions in the post capsule ingestion patient instructions but the instruction is not detailed on the PillCam recorder screen. You must print the post-capsule ingestion patient instructions for the patient to allow the association of the alerted number with the instruction details.

To print the Pre-capsule Ingestion Regimen Instructions:

1. Select the Pre-capsule Ingestion tab. The relevant screen appears displaying all the regimens or patient instruction templates available.
2. Select your item and click Print.

To print the Post-capsule Ingestion Regimen Instructions:

- Click Print Regimen during the patient Check-in stage (see Performing Patient Check-in on page 43), the patient's details are included in the printout.
- You can also print out the personalized post-capsule ingestion instructions after completing the check-in by going to the Study Manager, right-clicking the patient details and selecting the Print Preview Regimen option.
- You can also print out the post-capsule ingestion instructions (without the patient's details) via the Regimen Manager, as follows:
  a. From the Home screen, select Tools > Regimen Manager.
  b. Select either the Post-capsule Ingestion tab or the Pre-capsule Ingestion tab. The relevant screen appears displaying all the regimens or patient instruction templates available.
  c. Select your item and click Print.

Note

RAPID will print the regimen only if the regimen you selected is approved by a physician (This Regimen is approved. appears next to the Approve Regimen button at the bottom).

Print Layout of the Post-Capsule Ingestion Instructions

The Regimen Manager enables two convenient print layout options for the post-capsule ingestion instructions. The desired default layout can be configured in the RAPID settings, by clicking the Report tab and selecting either pocket format or page format.
Print in Pocket Format

When enabled, the post-capsule ingestion instructions will be printed in a convenient pocket format with fold lines for folding to an easy to carry size (quarter fold). The pocket format will show the Instructions guide on one side and important contact information on the other.
Print in Page Format
When enabled the post-capsule ingestion instructions will be printed on a page layout displaying all information on one page.

Instructions During Your PillCam Procedure
Patient name: ____________________________
Patient ID: ______________________________
Procedure date: __________________________

When the recorder beeps and vibrates:
Check the number on the recorder screen and follow the matching instruction in the INSTRUCTION GUIDE table.

If you have any questions, please contact:

INSTRUCTION GUIDE
0. Ingest [ENTER LOCAL BRAND NAME OF 10mg METOCLOPRAMIDE] with a glass of water. Continue complete fast (no additional drinking) until next alert.
1. Dilute [ENTER LOCAL BRAND NAME OF 30ml SODIUM PHOSPHATE] in a glass of water and drink it. Drink at least 1 liter of water over the next hour. You may resume drinking all clear liquids freely.
2. Dilute [ENTER LOCAL BRAND NAME OF 15ml SODIUM PHOSPHATE] in a glass of water and drink it. Drink at least 1/2 liter of water over the next hour. You may continue drinking all clear liquids freely.
3. Insert [ENTER LOCAL BRAND NAME OF 10mg BIOSACIDYL SUPPOSITORY] according to instructions in package insert.
4. You may eat a light meal.
   End of Procedure. Please remove equipment from your body.

During the Procedure
• Do not remove or disconnect the equipment at any time.
• Avoid direct sunlight
• Avoid strong electromagnetic fields such as MRI devices or ham radios.

Additional Instructions
• Following capsule ingestion, maintain a complete fast (no drinking) until instructed to do otherwise by the recorder alert.
• Remember active throughout your exam, no sleeping.

Sensor Removal
• When "End of Procedure" appears on the recorder, use the non-adhesive tab to peel off each adhesive sleeve, leaving the sensor inside the sleeve. Do not pull the wires or remove the sensors from the sleeves. If using a sensor belt, simply remove the belt.
• Return all equipment (recorder, sensor, recorder pouch and strap) to your physician. Handle carefully.

Warning:
If you develop nausea, abdominal pain, or vomiting, contact your physician.

Additional Settings
This section describes advanced configuration features of the RAPID v8.3 software. The section is divided into the following sections:
• Backup/Restore Offline Studies
• Importing Reports
• Freeing Space on Your Computer
• Backup System Logs
• Advanced CD/DVD Burning
Backup/Restore Offline Studies

The RAPID Study Manager displays information about studies stored on removable storage media, such as CDs, DVDs, and some USB storage devices, that have been connected to the computer during use of RAPID and are currently disconnected from the computer. After clicking the Offline Studies button in the Study Manager a list of recently viewed studies which are currently not connected to the computer is displayed. The offline study list is updated whenever the removable storage media is disconnected or reconnected.

To back up the list of the Offline Studies to a database file, use the RAPID Backup & Restore Offline Studies utility.

To backup Offline Studies:
1. You can backup the Study Manager Offline Studies by clicking the Windows Start button and then selecting Given Imaging > Backup and Restore Offline Studies. The following screen appears.

2. Select Export Directory and click Next. The following screen appears.

3. In the following screen, click the Directory button to launch the Export directory screen.

4. Click the Browse button and navigate to the location to export the backup.

5. Enter the file name of the backup and click Save.
6. When the process is complete, a message appears that it was completed successfully. Click OK.

To import backup Offline Studies:

1. In order to restore Study Manager Offline Studies, click the Windows Start button > Given Imaging > Backup and Restore Offline Studies. The following screen appears.

2. Select Import directory and click Next.

3. In the following screen click the Directory button to launch the Import directory screen.

4. Navigate to the database file (with Microsoft Access *accdb file extension) and click the Open button to load the offline studies to the RAPID Study Manager.
Importing Reports

Reports generated by RAPID versions before RAPID 5 are not automatically displayed in the Study Manager. If you wish to be able to see them in the Study Manager, you must import them by doing the following:

To import reports:

1. Open the video of the relevant study.
2. Select File > Tools > Import RAPID 4 Reports.
   The following message appears: Ensure that the selected reports belong to this study.
3. Click OK.
   A Windows browser screen opens at the location of the currently open video, showing the reports that are in this folder.
4. Select the report(s) you wish to import. If the report is not in this folder, browse to the correct location and select the report.
5. Click Open. The Reports imported successfully message appears.
6. Click OK and repeat this procedure for all the studies performed before RAPID 5.

Freeing Space on Your Computer

Deleting Videos

If you start to create a video while there is not enough space on your computer, you will be prompted to empty the Recycle Bin and if more space is needed, to delete RAPID folders.

To free space for new videos, delete RAPID studies from your hard disk or from E:\Videos.

Note
It is recommended to back up the RAPID studies by saving them on removable media discs (see Burning a Study to a CD/DVD on page 108). You may then delete them from the computer’s hard disk at any time or when prompted to do so by the RAPID software. Failure to back up a RAPID video before deleting will cause the study to be permanently lost.

To delete videos from your hard disk:

1. From the Home screen click Tools > Delete Videos.
The **Delete Video Folder** window appears.

2. Select the video folder you wish to delete. The **Delete** button becomes available.
3. Click **Delete**. The selected RAPID folder and all its contents will be deleted.
4. Empty the Recycle Bin.

**Deleting Raw Data Files after Video Creation**

When creating videos in default mode, the RAPID software clears previous raw data files it may have copied to the computer in the video creation process. However, if you select the optional **Copy raw data** method for video creation in the **Settings** screen, raw data files are not automatically deleted after the video is created. As multiple raw data files can rapidly fill your disk, you must manually clear raw data files as follows:

**To clear raw data files:**
1. From the Home screen, click **Recorder Download** and select the **Raw Data Files** screen.
2. To confirm that you no longer need a raw data file, you can refer to the **Last Use** status, and you may delete files after **Successful video creation or data copy**.
3. Click the bar displaying the file you wish to delete and click **Delete file**.

**Backup System Logs**

The system log file records all system events on the Workstation, such as log in, print, delete, etc. The size of this file is limited, and when it reaches 80% of its capacity, the following message is displayed immediately after logging in: *The log files need to be backed up. Please notify RAPID Workstation administrator.*

Only the system administrator can back up the system log.

This message appears at every login, until the backup procedure is performed.
CD/DVD Burning

The Export function in the RAPID software allows you to save a study or one of its files in a different place or under a different name, if needed to reorganize your archives. This includes:

- Saving a study or a file to another archive, such as a USB storage device
- Saving a study or a file to a specific location
- Saving a study as a Zip file
- Burning a study or a file to a CD/DVD

For burning a single study to a disc (no multisession), see *Burning a Study to a CD/DVD* on page 108.

For burning files from more than one study use the CD burning program on your computer. Given Workstations have either **Roxio Drag-to-Disc 9** or **DirectCD 5**.

**Roxio Drag-to-Disc 9**

**Burning Procedure**

1. Insert a blank disc into the disc drive.

2. If you do not know where the files you wish to burn are located, open the Study Manager by clicking ⌘ at the top of the screen, or select **View Study > Study Manager** from the Home screen.

3. Move your mouse over the archive where the files reside and a tooltip appears with the location of the archive on the computer.

4. Minimize RAPID by clicking ⌘ in the top right corner of the screen.

5. Click the Drag-to-Disc icon on the desktop. The **Drag-to-Disc** screen appears.

6. Click ⌨ on the **Drag-to-Disc** screen and select **Format Disc** from the pop-up menu. The **Format Options** screen appears.

7. Type in the name of your disc in the box next to **Enter volume name** and click **OK**. The **Disc Preparation** screen appears.

8. As soon as the **Disc Preparation** screen disappears, double click **My Computer** on the desktop and browse for the location of the files you wish to copy to the disc.

9. Click and drag the files you wish to copy to the disc over the **Drag-to-Disc** screen. A progress bar appears to indicate the burning process.
10. Once the progress bar has disappeared, click on the Drag-to-Disc screen to eject the disc. The following screen appears.

![Drag-to-Disc Eject Options](image)

11. If you wish to add files to this disc later (multisession), click the top option and click **Eject**.

DirectCD 5

To burn a procedure:

1. Insert disc into disc drive.

2. Double click the DirectCD icon on the desktop.

3. In the **DirectCD** screen, click **Format**. The **Format** screen appears.

4. In the **Label** box, enter a name for your disc limited to 11 characters. This is the volume name in the Study Manager.

5. Click **Start Format**.

6. The DirectCD formats the disc.

Once formatting is done the disc behaves like a regular folder and you can save videos, findings and reports to this folder and the software will burn the CD. You can add more files anytime later.
## Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Play/Pause Video</td>
</tr>
<tr>
<td>Left arrow</td>
<td>Go to next image</td>
</tr>
<tr>
<td>Right arrow</td>
<td>Go to previous image</td>
</tr>
<tr>
<td>Page-Down</td>
<td>Go 10 images forward</td>
</tr>
<tr>
<td>Page-Up</td>
<td>Go 10 images backwards</td>
</tr>
<tr>
<td>Home</td>
<td>Go to first image</td>
</tr>
<tr>
<td>End</td>
<td>Go to last image</td>
</tr>
<tr>
<td>Enter</td>
<td>Capture Thumbnail</td>
</tr>
<tr>
<td>Control + T</td>
<td>Show Atlas</td>
</tr>
<tr>
<td>Control + M</td>
<td>Show Study Manager</td>
</tr>
<tr>
<td>Control + N</td>
<td>Open Video</td>
</tr>
<tr>
<td>Control + S</td>
<td>Save Findings</td>
</tr>
<tr>
<td>Control + O</td>
<td>Open Findings</td>
</tr>
<tr>
<td>Control + R</td>
<td>Report Preview</td>
</tr>
<tr>
<td>Control + P</td>
<td>Report Print</td>
</tr>
<tr>
<td>Control + I</td>
<td>Image Enhancement</td>
</tr>
<tr>
<td>Control + Shift + S</td>
<td>Set View Layout to Single</td>
</tr>
<tr>
<td>Control + Shift + D</td>
<td>Set View Layout to Dual</td>
</tr>
<tr>
<td>Control + Shift + Q</td>
<td>Set View Layout to Quad</td>
</tr>
<tr>
<td>Control + Shift + M</td>
<td>Set View Layout to Mosaic</td>
</tr>
<tr>
<td>Control + Shift + C</td>
<td>Set View Layout to Collage</td>
</tr>
<tr>
<td>Control + Shift + 1/2/3</td>
<td>Image Enhancement FICE 1/2/3</td>
</tr>
<tr>
<td>Control + Shift + B</td>
<td>Image Enhancement Blue</td>
</tr>
<tr>
<td>Control + Shift + N</td>
<td>Image Enhancement Normal</td>
</tr>
<tr>
<td>Control + mouse wheel up/down</td>
<td>Decrease/Increase video Viewing Speed</td>
</tr>
</tbody>
</table>
PillCam Recorder Maintenance

Use only a fully charged (eight or more bars displayed on the battery icon) PillCam recorder. In general, including first-time use, charging the PillCam recorder is an overnight process and should not be performed in the vicinity of the patient. When you receive the PillCam recorder after an examination, charge it immediately until the green LED is lit, and leave it in its cradle.

**Warning**
Charge the PillCam recorder *only* with the supplied cradle. Once you have placed it into the cradle, the PillCam recorder automatically starts charging.

**Caution**
The SD card should never be removed or reinserted when the PillCam recorder DR3 is ON.

**Disclaimer**
The PillCam recorder cradle is a non-medical device, used for charging the PillCam recorder from Given Imaging Ltd. For full specifications, see *System Specifications* on page 217.

**Important Safety Instructions**

**Note**
Before using the PillCam recorder cradle, read all instructions on cautionary markings on the cradle, on the battery, and on the PillCam recorder.

**Warning**
Changes or modifications to this equipment not expressly approved by the party responsible for compliance (Given Imaging Ltd.) could void the user’s authority to operate the equipment.

**Warning**
- The cradle is for indoor use only.
- Never charge non-rechargeable batteries.
- All cells containing mercury, cadmium, lithium or lead as electrochemical substances are subject to special waste disposal requirements.
- This charger is a class A product. In a domestic environment, this charger may cause radio interference.
PillCam Recorder DR3

The PillCam recorder DR3 cradle has the following LEDs:

<table>
<thead>
<tr>
<th>LED</th>
<th>Status</th>
<th>Battery pack is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>On</td>
<td>ready for use</td>
</tr>
<tr>
<td>Yellow/Orange</td>
<td>Blinking</td>
<td>charging</td>
</tr>
</tbody>
</table>

To charge the PillCam recorder:

1. Plug the power cable into the cradle and plug the power cable into the wall outlet.
2. Insert the PillCam recorder into the cradle.
   The bottom LED is orange when charging the battery. When the PillCam recorder is fully charged, the bottom LED turns green.
3. Leave the PillCam recorder in its cradle until the next examination.

Note
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
PillCam Recorder DR2

Charging

Make sure the PillCam recorder is at least 80% charged (eight or more battery bars displayed on the battery icon) for SB and COLON procedures, and at least 50% charged (five or more bars displayed on the battery icon) for ESO procedures.

The cradle has the following LEDs:

<table>
<thead>
<tr>
<th>LED</th>
<th>Status</th>
<th>Battery pack is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>On</td>
<td>ready for use</td>
</tr>
<tr>
<td>Orange</td>
<td>On</td>
<td>charging</td>
</tr>
<tr>
<td></td>
<td>Blinking</td>
<td>discharging</td>
</tr>
<tr>
<td>Red</td>
<td>On</td>
<td>faulty (malfunctioning)</td>
</tr>
</tbody>
</table>

To charge the PillCam recorder:

1. Plug the power cable into the cradle and plug the power cable into the wall outlet.
   All three LEDs turn on for a self-test that takes 5 seconds. After 5 seconds, all LEDs turn off and the cradle is ready for use.
   If during the self-test the red LED blinks, the cradle is faulty. Contact Given Imaging Customer Support.

2. Insert the PillCam recorder or its Li-Ion battery with its adaptor into the cradle.
   All three LEDs of the cradle blink for 4 seconds. When the orange LED is on, charging has started.
   As soon as the PillCam recorder or its battery pack are fully charged, the green LED turns on, and the orange LED turns off.

3. Leave the PillCam recorder in its cradle until the next examination.
4. To check the status of the PillCam recorder before an examination, remove it from the cradle and push the button on the back.

Manual Discharge
If the cradle detects that the battery needs refreshing, it automatically discharges the battery before recharging it. The orange LED on the cradle blinks during discharging. Discharging is an overnight process that may take up to 12 hours.

We recommend that you manually discharge the battery every three months, even if it is not used.

To discharge the battery:
1. Open RAPID.
2. Make sure the appropriate battery is inside the PillCam recorder.
3. Insert the PillCam recorder into the cradle.
4. From the **Procedures** screen, select the relevant PillCam recorder by clicking the **Recorder** bar. The buttons on the right side of the screen become available.
5. Click ![Recorder Information](image) to open the **Recorder Information** screen.
6. At the bottom of the screen, click **Start Discharge**. A message appears: **Recorder discharge may take more than 12 hours. Do you wish to continue?**
7. Click **OK**. While the battery is being discharged, its battery status indicates **Discharging**:
   - In the bottom left corner of the **Recorder Information** screen.
   - In the PillCam recorder DR2 bar in the **Recorders** screen.
   - The orange LED on the cradle blinks.
8. To return to other RAPID functions, click **Close**.
9. If you need to stop the discharge (also for automatic discharge) while it is in progress, return to the **Recorder Information** screen and click **Cancel Discharge**. If you stop the automatic discharge process in the middle, the battery LEDs may not indicate the correct battery status.

**Note**
Do not charge or discharge the battery in the vicinity of the patient.
PillCam Sensor Cleaning

This section includes instructions for cleaning the PillCam equipment.

Note
To clean the PillCam equipment surfaces, we recommend using alcohol wipes (up to 70%). Usage of other classes of disinfectants (Aldehydes, Oxidizing Agents, Quaternary Ammonium, Chlorine compounds, Iodophor, Phenolic compounds) may stain or damage the materials.

Cleaning the PillCam Sensor Belt

Note
Refer to the product insert supplied with your sensor belt for full instructions on fitting, usage, cleaning, and technical description.

Cleaning the PillCam Sensor Array

For mild cleaning (dirt, sweat), wipe the sensors gently with alcohol wipes (up to 70%). The alcohol will not remove the adhesive. Use alcohol sparingly and allow the sensor array to dry for 20 minutes.

To remove adhesive from the sensor array (not from the human body), use white benzene.

Warning
Use white benzene only in a well ventilated area according to all precautions and instructions on the label.

Alternatively, use one of the following medical adhesive removers to remove adhesive:

- B-508 Secure Solvent
- B-202 Hollister Solvent
- B-206 Detachol Adhesive Remover

Use all precautions as defined by the manufacturer.

Cleaning the Recorder Pouch

To clean the recorder pouch, wipe down all surfaces with alcohol (70% isopropyl or ethyl alcohol) making sure that all surfaces are exposed to alcohol for at least 1 minute.
# RAPID Video

## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| Short video | • Capsule  
• PillCam recorder battery  
• PillCam recorder mishandling | • Contact Customer Support  
• Send video on CD/DVD  
• Inform capsule lot#  
• Do not use the same PillCam recorder  
• Save the raw data locally on your computer |
| Gaps | • Capsule  
• Interference  
• Mishandling  
• Physiological | • Contact Customer Support |
| Bad image quality | • Stripes in video  
• Pixilation/confetti  
• Dark/red/orange image | • Send video on CD/DVD  
• Save the raw data locally on your computer |
| Video shorter than capsule operating time without either ingestion phase images or body exit images | • Capsule  
• PillCam recorder battery  
• Interference | • Send video on CD/DVD  
• Save the raw data locally on your computer  
• Contact Customer Support |
| No Localization | • Malfunction of the sensor array  
• Wrong sensor chosen in the check-in process | • Do not use the sensor  
• Contact Customer Support |
| Cannot open RAPID Atlas | Atlas installation incomplete or incorrect | • Reinstall Atlas  
• Save the raw data locally on your computer  
• Contact Customer Support |
| Cannot view COLON 2 video using RAPID v7.0 | COLON 2 video compiled in RAPID v8.0 cannot be viewed using RAPID v7.0 | Download and use RAPID Reader v8.0 to view video |
| Unable to perform various operations | RAPID computer is “stuck” typically after a prolonged period in the ON state without restarting | It is recommended to restart your computer at least once a month to ensure optimal performance |

## Saving and Opening Videos

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| Cannot locate video | • Video was not saved in E:\Videos  
• Video was not created  
• Incorrect patient’s name | • Search for video in RAPID Work Directories or in Study Manager (video creation)  
• Contact Customer Support |
### PillCam Capsule Endoscopy

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot locate findings</td>
<td>• Findings were not saved under patient’s folder</td>
<td>• Refer to Saving Findings File in Saving Your Findings on page 144</td>
</tr>
<tr>
<td></td>
<td>• Findings were saved with the wrong name</td>
<td>• Contact Customer Support</td>
</tr>
<tr>
<td>Study cannot be selected in Study Manager</td>
<td>Changing an archive location that appears in the Study Manager screen, the archive remains on the archives list but its study cannot be selected</td>
<td>Modify the archive location manually</td>
</tr>
<tr>
<td>Cannot open a video from an archive in Study Manager and an error message requests user to click the refresh button</td>
<td>Archive privileges set with no access to read or write</td>
<td>Allow Read and Write access to the archive folder</td>
</tr>
</tbody>
</table>

### Printer

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot print report</td>
<td>Printer is turned off</td>
<td>Turn printer on</td>
</tr>
<tr>
<td></td>
<td>Printer is not set as default printer</td>
<td>Set printer to Default Printer</td>
</tr>
<tr>
<td></td>
<td>Printer has a malfunction</td>
<td>Contact Customer Support</td>
</tr>
</tbody>
</table>

### CD/DVD

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot burn CD/DVD</td>
<td>CD/DVD is not blank or compatible with CD/DVD ROM</td>
<td>Contact Customer Support</td>
</tr>
<tr>
<td></td>
<td>Wrong burning procedure</td>
<td></td>
</tr>
<tr>
<td>Cannot eject CD/DVD</td>
<td>A video on the disc is open</td>
<td>Close the video and retry</td>
</tr>
</tbody>
</table>

### Sensor Array

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector is damaged</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sensor is torn from its wire</td>
<td></td>
<td>Contact Customer Support</td>
</tr>
<tr>
<td>Insulation of the sensor wire is damaged</td>
<td>• Mishandling • End of Life</td>
<td></td>
</tr>
</tbody>
</table>
## Sensor Belt

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector is damaged</td>
<td>• Mishandling the sensor belt</td>
<td>• Stop using this sensor</td>
</tr>
<tr>
<td>Insulation of the sensor wire is damaged</td>
<td>• End of Life</td>
<td>• Contact Customer Support</td>
</tr>
</tbody>
</table>

## Capsule

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| DOA (Dead On Arrival) | Capsule failure | 1 Send capsule to Given Imaging Ltd.  
  2 Open another capsule.  
  3 If second capsule from 10-pack is DOA, contact Customer Support. |

## Cradle

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| Cradle LEDs turn red                         | All LEDs are flashing red                  | 1 Disconnect cradle from mains power.  
  2 Reconnect cradle to mains power.  
  3 If problem persists, contact Customer Support. |
| Cradle orange LED is blinking, but cradle is not in discharge mode | Hardware/Software problem                  |                                            |
| PillCam recorder DR2 cannot be placed in cradle | Hardware malfunction                      | Contact Customer Support                    |

## PillCam Recorder DR3

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capsule LED blinking red</td>
<td>Interference</td>
<td>Refer to PillCam recorder DR3 LEDs Indications</td>
</tr>
<tr>
<td>Capsule LED blinking white</td>
<td>Capsule not paired yet</td>
<td></td>
</tr>
<tr>
<td>SD card errors</td>
<td>Wrong or damaged SD card</td>
<td></td>
</tr>
<tr>
<td>Sensor connection</td>
<td>Wrong or damaged sensor</td>
<td></td>
</tr>
</tbody>
</table>
| PillCam recorder freezes         | Possible static electricity discharge | * Perform Hard Reset on the PillCam recorder  
  * Contact Customer Support  |
### PillCam Recorder DR2

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot initialize PillCam recorder DR2</td>
<td>Wrong recorder bar is selected</td>
<td>Select correct recorder bar</td>
</tr>
<tr>
<td></td>
<td>Computer does not recognize PillCam recorder DR2</td>
<td>1 Check USB and power connection to the cradle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Contact Customer Support.</td>
</tr>
<tr>
<td>Cannot create video</td>
<td>Wrong recorder bar is selected</td>
<td>Select PillCam recorder DR2 Recorder bar</td>
</tr>
<tr>
<td></td>
<td>Error message is displayed</td>
<td>Send error message to Customer Support</td>
</tr>
<tr>
<td></td>
<td>Not enough free space... message is displayed</td>
<td>Delete PRRs from hard drive</td>
</tr>
<tr>
<td></td>
<td>Workstation freezes during video creation</td>
<td>Contact Customer Support</td>
</tr>
<tr>
<td>Capsule LED (right) does not blink in blue when capsule is activated (LED is orange)</td>
<td>• Capsule failure</td>
<td>1 Return capsule to blister.</td>
</tr>
<tr>
<td></td>
<td>• PillCam recorder DR2 failure</td>
<td>2 Activate second capsule.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 If problem persists, contact Customer Support.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 Send malfunctioning capsules to Given Imaging Ltd.</td>
</tr>
<tr>
<td>Capsule LED (right) blinks in orange once every five seconds when more than six hours have passed since ingestion</td>
<td>• Capsule failure</td>
<td>1 Wait until 8 hours have passed and take off the sensors.</td>
</tr>
<tr>
<td></td>
<td>• PillCam recorder DR2 failure</td>
<td>2 Send video on CD/DVD.</td>
</tr>
<tr>
<td>Capsule LED (right) blinks in orange once every five seconds when less than six hours have passed since ingestion</td>
<td>• Capsule failure</td>
<td>Contact Customer Support</td>
</tr>
<tr>
<td></td>
<td>• PillCam recorder DR2 failure</td>
<td></td>
</tr>
<tr>
<td>PillCam recorder DR2 shuts down during the procedure</td>
<td>PillCam recorder DR2 malfunction</td>
<td>1 Turn PillCam recorder DR2 off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Take out the battery pack and place it back in.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 Turn PillCam recorder DR2 on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 If problem persists, contact Customer Support.</td>
</tr>
<tr>
<td></td>
<td>Battery exhausted</td>
<td>Replace battery and continue procedure.</td>
</tr>
<tr>
<td>Problem</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cancelling Data Copy displays error message that</td>
<td>Cancelling the Data Copy in mid-sequence triggers Video Copy message</td>
<td></td>
</tr>
<tr>
<td>Video Copy was unsuccessful</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Error Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full name not defined for this user. Please contact your IT system administrator.</td>
<td>In order to enable electronic signatures in the CE report, the full name field (full name will appear in electronic signature) must be defined in the user's relevant Windows account. Possible reasons for this error message include: • Password Expired • Account Restrictions • Invalid Logon Hours • Account Lockout (or expired or disabled) Password must be changed.</td>
</tr>
<tr>
<td>Electronic signature failed. Please contact your IT system administrator.</td>
<td>In order to enable electronic signatures in CE report, the user's relevant Windows account must be enabled for remote connection login. Possible reasons for this error message include: • Password Expired • Account Restrictions • Invalid Logon Hours • Account Lockout (or expired or disabled)</td>
</tr>
<tr>
<td>You do not have permission to access the Regimen Manager. Please contact your system administrator.</td>
<td>In order to allow physicians to edit and approve their regimens, the following must be done: • In the Settings screen, under the Other tab, define an existing folder as the Regimens Directory. This folder must be open for read and write permissions for the relevant users.</td>
</tr>
<tr>
<td>Patient Check-in procedure failed. Reason: Failed to update recorder software version.</td>
<td>Turn the recorder off and then on before the next check-in attempt. If the upgrade fails again, contact customer support.</td>
</tr>
</tbody>
</table>

For LED behavior, see LED Display on page 68. For error messages displayed on the PillCam recorder screen, see Error Messages on page 73.
Low Signal

If a low signal is detected during the examination, the following message appears.

A low signal detected during the examination may be due to:

- Improper use of the sensor array/sensor belt
- A defective sensor array/sensor belt
- A PillCam recorder malfunction

If this message is displayed, Contact Customer Support.

Click **OK** to close the message.
## System Labeling

The following table lists the labels attached to various components of the PillCam Capsule Endoscopy System.

<table>
<thead>
<tr>
<th>Labeling</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>PillCam capsules are MR unsafe.</td>
<td></td>
</tr>
<tr>
<td>The PillCam capsule should not be stored and used near any powerful magnetic fields such as the one created by an MRI.</td>
<td></td>
</tr>
<tr>
<td>The PillCam capsule is intended for single use only.</td>
<td></td>
</tr>
<tr>
<td>Attention! Consult the documentation provided with the PillCam Capsule Endoscopy System.</td>
<td></td>
</tr>
<tr>
<td>Temperature limits</td>
<td>Non-ionizing radiation</td>
</tr>
<tr>
<td>Type BF equipment</td>
<td>RoHs</td>
</tr>
<tr>
<td>FCC compliance</td>
<td>Capsule ID</td>
</tr>
<tr>
<td>CE mark</td>
<td>IPX8 Ingress protection</td>
</tr>
<tr>
<td>C-Tick mark</td>
<td>Do not Iron</td>
</tr>
<tr>
<td>CSA mark</td>
<td>Latex free</td>
</tr>
<tr>
<td>Expiration date</td>
<td>Machine wash - warm</td>
</tr>
<tr>
<td>Recycle</td>
<td>Do not tumble dry</td>
</tr>
<tr>
<td>Lot number</td>
<td>Do not dry clean</td>
</tr>
<tr>
<td>Indoor use only</td>
<td>Do not use bleach</td>
</tr>
</tbody>
</table>
Capsule Labeling

Each box has a label at the bottom as shown below. Each capsule is marked with the expiration date, lot number, and a unique capsule ID code.

Essential Performance

PillCam Capsules

ON-Mode

Data transmitting to PillCam recorder is considered to be essential performance of the PillCam capsules. The PillCam capsules shall transmit data continuously monitored by on-line image display as received by PillCam recorder.

OFF-Mode

No unintentional transmissions are allowed.

PillCam Recorder DR2 and PillCam Recorder DR3

Data receiving by PillCam recorder is considered to be essential performance of the PillCam recorder DR2 and PillCam recorder DR3.

Warnings

- PillCam Capsule Endoscopy System and its components need special precautions regarding EMC and need to be installed and put into service according to the EMC information provided in the accompanying documents.
- Portable and mobile RF communications equipment can affect the PillCam video capsule and the PillCam recorder.
- PillCam video capsules and PillCam recorder should not be used adjacent to or stacked with other equipment and that if adjacent or stacked use is necessary, the equipment or system should be observed to verify normal operation in the configuration in which it will be used.
• PillCam video capsules and PillCam recorder may be interfered with by other equipment, even if that other equipment complies with CISPR emission requirements.

• Do not disassemble or modify the battery pack. The battery pack is equipped with built-in safety/protection features. Should these features be disabled, the battery pack can leak acid, overheat, emit smoke, burst and/or ignite.

• Do not use or leave the battery pack of the PillCam recorder near a heat source such as a fire or a heater (+80°C or higher). If the resin separator should be damaged owing to overheating, internal short-circuiting may occur to the battery pack, possibly leading to acid leakage, smoke emission, bursting and/or ignition of the battery pack.

• Do not immerse the battery pack in water or seawater and do not allow it to get wet. Otherwise, the protective features in it can be damaged, it can be charged with extremely high current and voltage, abnormal chemical reactions may occur in it, possibly leading to acid leakage, smoke emission, bursting and/or ignition.

• Do not recharge the battery pack near fire or in extremely hot weather. Otherwise, hot temperatures can trigger its built-in protective features, inhibiting recharging, or can damage the built-in protective features, causing it to be charged with an extremely high current and voltage and, as a result, abnormal chemical reactions can occur in it, possibly leading to acid leakage, overheating, smoke emission, bursting and/or ignition.

• To recharge the battery pack, use the PillCam recorder cradle and observe the recharging conditions. A recharging operation under non-conforming recharging conditions (higher temperature and larger voltage/current than specified, modified battery charger, etc.) can cause the battery pack to be overcharged, or charged with extremely high current, abnormal chemical reaction can occur in it, possibly leading to acid leakage, overheating, smoke emission, bursting and/or ignition.

• Do not pierce the battery pack with a nail or other sharp objects, strike it with a hammer, or step on it. Otherwise, the battery pack will become damaged and deformed, internal short-circuiting can occur, possibly leading to acid leakage, overheating, smoke emission, bursting and/or ignition.

• Do not strike or throw the battery pack. The impact might cause leakage, overheating, smoke emission, bursting and/or ignition. Also, if the protective feature in it becomes damaged, it could become charged with an extremely high current and voltage, abnormal chemical reactions can occur, which can lead to acid leakage, overheating, smoke emission, bursting and/or ignition.

• Do not use an apparently damaged or deformed battery pack. Otherwise, acid leakage, overheating, smoke emission, bursting and/or ignition of the battery pack may occur.

• If the battery pack leaks and the electrolyte gets into the eyes, do not rub them. Instead, rinse the eyes with clean running water and immediately seek medical attention. Otherwise, eye injury may result.

• If recharging operation fails to complete even when a specified recharging time has elapsed, immediately stop further recharging. Otherwise, acid leakage, overheating, smoke emission, bursting and/or ignition can occur.

• Do not put the battery pack into a microwave oven or pressurized container. Rapid heating or disrupted sealing can lead to acid leakage, overheating, smoke emission, bursting and/or ignition.

• If the battery pack leaks or gives off a bad odor, remove it from any exposed flame. Otherwise, the leaking electrolyte may catch fire and the battery pack may emit smoke, burst or ignite.

• If the battery pack gives off an odor, generates heat, becomes discolored or deformed, or in any way appears abnormal during use, recharging or storage, immediately remove it from the
equipment or cradle and stop using it. Otherwise, the problematic battery pack can develop acid leakage, overheating, smoke emission, bursting and/or ignition.

- The use of accessories, transducers and cables other than those supplied or approved by Given Imaging Ltd. as replacement parts for internal PillCam recorder components, may result in increased emissions or decreased immunity of the PillCam Capsule Endoscopy System.

### Cautions

- Do not use or subject the battery pack to intense sunlight or hot temperatures such as in a car in hot weather. Otherwise, acid leakage, overheating and/or smoke emission can occur. Also, its guaranteed performance will be lost and/or its service life will be shortened.

- The battery pack incorporates built-in safety devices. Do not use it in a location where static electricity (greater than the manufacturer’s guarantee) may be present. Otherwise, the safety devices can be damaged, possibly leading to acid leakage, overheating, smoke emission, bursting and/or ignition.

- The guaranteed recharging temperature range is 0°C to +45°C. A recharging operation outside this temperature range can lead to acid leakage and/or overheating of the battery pack and may cause damage to it.

- If acid leaking from the battery pack comes into contact with your skin or clothing, immediately wash it away with running water. Otherwise, skin inflammation can occur.

- For recharging procedures, refer to Charging on page 66.

- If you find rust, a bad odor, overheating and/or other irregularities when using the battery pack for the first time, return it to your supplier or vendor.
# System Specifications

## PillCam SB 2 Capsule

<table>
<thead>
<tr>
<th>Properties</th>
<th>Physical</th>
<th>Optical</th>
<th>Operational</th>
</tr>
</thead>
</table>
| Dimensions | Length: 26.3 mm  
Diameter: 11.4 mm | Illumination | Frequency |
|           | Weight: 2.9 g | 4 white light emitting diodes | 434.1 MHz |
|           | Material: Biocompatible plastic | # of imaging heads | Band width |
|           | Field of view: 156° (Optical field of view at 4.5 mm  
from top cover per ISO-8600-3)  
130° (Optical field of view from  
entrance pupil per FDA Method) | Effective visibility | Modulation |
|           | Effective visibility | Distance: 3 cm | MSK |
|           | Weight: 2.9 g | Min. detectable object | ERP [nW] |
|           | Field of view | 1 At least 0.1 mm | 16 |
|           | Frequency | Min. detectable object | ERP [nW] |
|           | Band width: 1.6 MHz | 434.1 MHz | 16 |
|           | Modulation | Frequency | ERP [nW] |
|           | ERP [nW] | Band width | Frequency |
|           | either 2 or 4 fps (two capsule versions) | either 2 or 4 fps (two capsule versions) | either 2 or 4 fps (two capsule versions) |
|           | Operating time | ≥ 8 hours | ≥ 8 hours |
|           | Chemical safety | Resistant to dissolution in pH=2 to pH=8 | Resistant to dissolution in pH=2 to pH=8 |
|           | Battery type | Silver Oxide batteries | Silver Oxide batteries |
|           | Operating | 20–40°C | 20–40°C |
|           | temperature | Storage temperature | Storage temperature |
|           | Storage temperature | 0–40°C | 0–40°C |

---

**Note**

- Specifications are subject to change without prior notice and without any obligation to users on the part of the manufacturer.
- Specifications are rounded to the appropriate decimal place.
### PillCam CapScope Endoscopy

## PillCam SB 3 Capsule

<table>
<thead>
<tr>
<th>Properties</th>
<th>Dimensions</th>
<th>Length: 26.2 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Diameter: 11.4 mm</td>
<td>Diameter: 11.4 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>3.0 g</td>
<td></td>
</tr>
<tr>
<td>Material</td>
<td>Biocompatible plastic</td>
<td></td>
</tr>
<tr>
<td>Physical</td>
<td>Illumination</td>
<td>4 white light emitting diodes</td>
</tr>
<tr>
<td></td>
<td># of imaging heads</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Field of view</td>
<td>156° ISO-8600-3</td>
</tr>
<tr>
<td></td>
<td>Effective visibility</td>
<td>156° (Optical field of view at 4.5 mm from top cover per ISO-8600-3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>136° (Optical field of view from entrance pupil per FDA Method)</td>
</tr>
<tr>
<td></td>
<td>Min. detectable object</td>
<td>At least 0.07 mm</td>
</tr>
<tr>
<td>Frequency</td>
<td>434.1 MHz</td>
<td></td>
</tr>
<tr>
<td>Band width</td>
<td>3.2 MHz @ 2.7 Mbps; 6.5 MHz @ 5.4 Mbps</td>
<td></td>
</tr>
<tr>
<td>Modulation</td>
<td>MSK</td>
<td></td>
</tr>
<tr>
<td>ERP [nW]</td>
<td>~20</td>
<td></td>
</tr>
<tr>
<td>Operational</td>
<td>Frame rate</td>
<td>2 fps or 2–6 fps</td>
</tr>
<tr>
<td></td>
<td>Operating time</td>
<td>&gt; 8 hours</td>
</tr>
<tr>
<td></td>
<td>Chemical safety</td>
<td>Resistant to dissolution in pH=2 to pH=8</td>
</tr>
<tr>
<td></td>
<td>Battery type</td>
<td>Silver Oxide batteries, Mercury Free</td>
</tr>
<tr>
<td></td>
<td>Operating temperature</td>
<td>20–40°C</td>
</tr>
<tr>
<td></td>
<td>Storage temperature</td>
<td>0–25°C</td>
</tr>
<tr>
<td>Downlink communication</td>
<td>Operating frequency</td>
<td>13.6 MHz</td>
</tr>
<tr>
<td></td>
<td>Receiver Bandwidth</td>
<td>± 150 kHz</td>
</tr>
</tbody>
</table>
PillCam UGI Capsule

<table>
<thead>
<tr>
<th>Properties</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Physical</strong></td>
<td>Dimensions</td>
<td>Length: 32.3 mm±0.5 mm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Diameter: 11.6 mm</td>
</tr>
<tr>
<td></td>
<td>Weight</td>
<td>2.9 g ± 0.1 g</td>
</tr>
<tr>
<td></td>
<td>Material</td>
<td>Biocompatible plastic</td>
</tr>
<tr>
<td><strong>Optical</strong></td>
<td>Illumination</td>
<td>4 white light emitting diodes on each side</td>
</tr>
<tr>
<td></td>
<td># of optical heads</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Field of view</td>
<td>172° ISO-8600-3</td>
</tr>
<tr>
<td></td>
<td>Effective visibility</td>
<td>Distance: 3 cm</td>
</tr>
<tr>
<td></td>
<td>Min. detectable object</td>
<td>At least 0.1 mm</td>
</tr>
<tr>
<td></td>
<td>Frequency</td>
<td>434.1 MHz</td>
</tr>
<tr>
<td></td>
<td>Band width</td>
<td>9.7 MHz</td>
</tr>
<tr>
<td></td>
<td>Modulation</td>
<td>MSK</td>
</tr>
<tr>
<td></td>
<td>ERP [nW]</td>
<td>8</td>
</tr>
<tr>
<td><strong>Operational</strong></td>
<td>Frame rate</td>
<td>18–35 fps</td>
</tr>
<tr>
<td></td>
<td>Operating time</td>
<td>90 min</td>
</tr>
<tr>
<td></td>
<td>Chemical safety</td>
<td>Resistant to dissolution in pH=2 to pH=8</td>
</tr>
<tr>
<td></td>
<td>Battery type</td>
<td>Mercury Free Silver Oxide batteries</td>
</tr>
<tr>
<td></td>
<td>Operating temperature</td>
<td>20–40°C</td>
</tr>
<tr>
<td></td>
<td>Storage temperature</td>
<td>0–25°C</td>
</tr>
</tbody>
</table>
## PillCam COLON 2 Capsule

<table>
<thead>
<tr>
<th>Properties</th>
<th>Physical</th>
<th>Optical</th>
<th>Operational</th>
<th>Uplink communication</th>
<th>Downlink communication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>Length: 32.3 mm + 0.5 mm</td>
<td># of optical heads</td>
<td>Operating time</td>
<td>Operating frequency</td>
<td>Operating frequency</td>
</tr>
<tr>
<td></td>
<td>Diameter: 11.6 mm</td>
<td></td>
<td>Minimum of 10 hours</td>
<td>434.1 MHz</td>
<td>13.6 MHz</td>
</tr>
<tr>
<td>Weight</td>
<td>2.9 g ± 0.1 g</td>
<td>Illumination</td>
<td>Chemical safety</td>
<td>Frame rate</td>
<td>Receiver Bandwidth</td>
</tr>
<tr>
<td>Material</td>
<td>Biocompatible plastic</td>
<td>4 white light emitting diodes on each side</td>
<td>Resistant to dissolution in pH=2 to pH=8</td>
<td>4–35 fps</td>
<td>± 150 kHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Field of view</td>
<td>Battery type</td>
<td>Data rate</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>172° ISO-8600-3</td>
<td>Silver Oxide batteries</td>
<td>2.7 Mbps and 8.1 Mbps</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Effective visibility</td>
<td>Operating temperature</td>
<td>Modulation type</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Distance: 3 cm</td>
<td>20–40°C</td>
<td>MSK/Digital data</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Min. detectable object</td>
<td>Band width</td>
<td>Effective radiated power</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>At least 0.1 mm</td>
<td>3.2 MHz @ 2.7 Mbps; 9.7 MHz @ 8.1 Mbps</td>
<td>-44.56 dBm</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Storage temperature</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0–25°C</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Uplink communication</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Downlink communication</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Operating frequency</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>13.6 MHz</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Frame rate</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4–35 fps</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Data rate</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2.7 Mbps and 8.1 Mbps</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Modulation type</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>MSK/Digital data</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Effective radiated power</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-44.56 dBm</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Downlink communication</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Operating frequency</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>13.6 MHz</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Frame rate</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4–35 fps</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Data rate</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2.7 Mbps and 8.1 Mbps</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Modulation type</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>MSK/Digital data</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Effective radiated power</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-44.56 dBm</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Downlink communication</td>
<td></td>
</tr>
</tbody>
</table>
### Sensor Array PillCam Recorder DR2

<table>
<thead>
<tr>
<th>Versions: SB, COLON, ESO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reception antenna</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Material</td>
</tr>
<tr>
<td>SB = COLON sensor array</td>
</tr>
<tr>
<td>ESO sensor array</td>
</tr>
</tbody>
</table>

### Sensor Array PillCam Recorder DR3

<table>
<thead>
<tr>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reception antenna</td>
</tr>
<tr>
<td>Sensor size</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Material</td>
</tr>
<tr>
<td>Antennas wire material</td>
</tr>
<tr>
<td>Transmission antenna</td>
</tr>
<tr>
<td>Size</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Material</td>
</tr>
</tbody>
</table>
### PillCam Recorder DR2/DR2C

<table>
<thead>
<tr>
<th>Properties</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical</td>
<td></td>
</tr>
<tr>
<td>Software</td>
<td>Proprietary firmware</td>
</tr>
<tr>
<td>Recording capacity</td>
<td>PillCam recorder DR2: 2fps for 10 hours</td>
</tr>
<tr>
<td></td>
<td>PillCam recorder DR2C: 4fps for 10 hours</td>
</tr>
<tr>
<td>Weight</td>
<td>500 g, including battery pack</td>
</tr>
<tr>
<td>Operational Power</td>
<td>6–10 V DC, 100–250 mA</td>
</tr>
<tr>
<td>Battery type</td>
<td>Internal, Li-Ion, 7.2 V, 4400 mAH</td>
</tr>
<tr>
<td>Battery Pack weight</td>
<td>200 g</td>
</tr>
<tr>
<td>Operating temp.</td>
<td>0–40°C</td>
</tr>
<tr>
<td>Storage temp.</td>
<td>0–55°C</td>
</tr>
<tr>
<td>Storage and Operating</td>
<td>Up to 85%</td>
</tr>
<tr>
<td>humidity</td>
<td></td>
</tr>
<tr>
<td>Storage and Operating</td>
<td>790–520 mmHg</td>
</tr>
<tr>
<td>pressure</td>
<td></td>
</tr>
</tbody>
</table>

### Cradle PillCam Recorder DR2

<table>
<thead>
<tr>
<th>Properties</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>890 g</td>
</tr>
<tr>
<td>Size (without battery inserted)</td>
<td>14 [D] x 165 [W] x 97 [H] mm</td>
</tr>
<tr>
<td>Color</td>
<td>Black</td>
</tr>
<tr>
<td>Power mains range</td>
<td>100 to 240 V</td>
</tr>
</tbody>
</table>
### PillCam Recorder DR3

<table>
<thead>
<tr>
<th>Properties</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical</td>
<td></td>
</tr>
<tr>
<td>Recording capacity</td>
<td>Up to 15 hours @ LCD OFF</td>
</tr>
<tr>
<td>Weight</td>
<td>500 g, including battery pack</td>
</tr>
<tr>
<td>Operational Power</td>
<td>3.5–4.2 V DC, 0.15–0.5 A</td>
</tr>
<tr>
<td>Battery type</td>
<td>Internal, Li-Ion, 3.8 V typical, 8800 mAh</td>
</tr>
<tr>
<td>Operating temp.</td>
<td>0–40°C</td>
</tr>
<tr>
<td>Storage temp.</td>
<td>0–55°C</td>
</tr>
<tr>
<td>Storage and Operating</td>
<td>Up to 85%</td>
</tr>
<tr>
<td>humidity</td>
<td></td>
</tr>
<tr>
<td>Storage and Operating</td>
<td>790–520 mmHg</td>
</tr>
<tr>
<td>pressure</td>
<td></td>
</tr>
<tr>
<td>Receiver (Rx)</td>
<td></td>
</tr>
<tr>
<td>Operating frequency</td>
<td>434.1 MHz</td>
</tr>
<tr>
<td>Bandwidth of the</td>
<td>10 MHz</td>
</tr>
<tr>
<td>receiving section in this</td>
<td></td>
</tr>
<tr>
<td>band</td>
<td></td>
</tr>
<tr>
<td>Transmitter</td>
<td></td>
</tr>
<tr>
<td>Operating frequency</td>
<td>13.6 MHz</td>
</tr>
<tr>
<td>Frequency band</td>
<td>ISM</td>
</tr>
<tr>
<td>Modulation type</td>
<td>Linear Chirp</td>
</tr>
<tr>
<td>Type of modulated</td>
<td>Digital data</td>
</tr>
<tr>
<td>signal</td>
<td></td>
</tr>
<tr>
<td>Effective radiated power</td>
<td>-27.4 dBi</td>
</tr>
</tbody>
</table>
### PillCam Recorder DR3 SDHC Memory Card

<table>
<thead>
<tr>
<th>Properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>24 mm x 32 mm x 2 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>2.5 g</td>
</tr>
<tr>
<td>Capacity</td>
<td>&gt;16 GB</td>
</tr>
<tr>
<td>Rating</td>
<td>Class 6: 40X or higher, 6 MB/sec minimum data transfer rate</td>
</tr>
<tr>
<td>Storage temp</td>
<td>-40°C–85°C</td>
</tr>
<tr>
<td>Security</td>
<td>Built-in write-protect switch prevents accidental data loss</td>
</tr>
<tr>
<td>Compatibility</td>
<td>SDHC host devices; not compatible with standard SD-enabled devices/readers</td>
</tr>
<tr>
<td>File format</td>
<td>FAT 32</td>
</tr>
</tbody>
</table>

### Cradle PillCam Recorder DR3

<table>
<thead>
<tr>
<th>Properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>250 g</td>
</tr>
<tr>
<td>Operating temp</td>
<td>0–45°C</td>
</tr>
<tr>
<td>Color</td>
<td>White &amp; Black</td>
</tr>
<tr>
<td>Power mains range</td>
<td>Input Voltage: Maximum 5.25 V, Min 4.75 V Input Current: Maximum 4 A, Min 100 mA</td>
</tr>
</tbody>
</table>

### DC Power Supply

<table>
<thead>
<tr>
<th>Properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>300 g</td>
</tr>
<tr>
<td>Input connector</td>
<td>3 pole AC inlet IEC320-C14C</td>
</tr>
<tr>
<td>Input Voltage</td>
<td>90–246 VAC</td>
</tr>
<tr>
<td>Output voltage</td>
<td>5 V DC, 5 A</td>
</tr>
<tr>
<td>Protections</td>
<td>Short circuit/Over load/Over voltage/Over temp.</td>
</tr>
</tbody>
</table>
RAPID for PillCam Software

<table>
<thead>
<tr>
<th>Software</th>
<th>RAPID proprietary, version 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Languages</td>
<td>English/French/German/Italian/Spanish/Portuguese/Dutch/Swedish/Finnish/Danish/Chinese-Mandarin/Korean/Russian/Greek</td>
</tr>
<tr>
<td>Data export</td>
<td>JPEG Images, (MPEG) Video clips, grml (Given proprietary) files, PDF Reports, generic XML-format Capsule Endoscopy report data</td>
</tr>
<tr>
<td>Displayed data</td>
<td>Single and multi images, Timebar, Colorbar with region specific color and other diagnostic data</td>
</tr>
<tr>
<td>Event marker</td>
<td>Annotated thumbnails</td>
</tr>
<tr>
<td>Viewing rate</td>
<td>5–80 fps</td>
</tr>
<tr>
<td>Viewing Modes</td>
<td>Single, Dual, Quad, Mosaic, and Collage view, Dual-head view (ESO/UGI and COLON)</td>
</tr>
<tr>
<td>Run Modes</td>
<td>View, Automatic, QuickView, SBI</td>
</tr>
</tbody>
</table>

Guidance and Manufacturer's Declarations

PillCam Capsules

<table>
<thead>
<tr>
<th>Guidance and manufacturer's declaration - electronic emissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The PillCam capsules are intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam capsules should assure that it is used in such an environment.</td>
</tr>
<tr>
<td>Emissions test</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>RF emissions</td>
</tr>
<tr>
<td>CISPR 11</td>
</tr>
<tr>
<td>RF emissions</td>
</tr>
<tr>
<td>CISPR 11</td>
</tr>
<tr>
<td>Harmonic emissions</td>
</tr>
<tr>
<td>IEC 61000-3-2</td>
</tr>
<tr>
<td>Voltage fluctuations/</td>
</tr>
<tr>
<td>flicker emissions</td>
</tr>
<tr>
<td>IEC 61000-3-3</td>
</tr>
</tbody>
</table>
**Guidance and manufacturer’s declaration - electronic immunity**

The PillCam capsules are intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam capsules should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD)</td>
<td>±6 kV contact</td>
<td>±6 kV contact</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td>IEC 61000-4-2</td>
<td>±8 kV air</td>
<td>±8 kV air</td>
<td></td>
</tr>
<tr>
<td>Electrical fast transient/burst</td>
<td>±2 kV for power supply lines</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>IEC 61000-4-4</td>
<td>±1 kV for input/output lines</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>Surge</td>
<td>±1 kV line(s) to line(s)</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>IEC 61000-4-5</td>
<td>±2 kV line(s) to earth</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>Voltage dips, short interruptions and voltage variations on power supply input lines</td>
<td>&lt;5% $U_T$ (&gt;95% dip in $U_T$) for 0.5 cycle</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>IEC 61000-4-11</td>
<td>40% $U_T$ (60% dip in $U_T$) for 5 cycles</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>70% $U_T$ (30% dip in $U_T$) for 25 cycles</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;5% $U_T$ (&gt;95% dip in $U_T$) for 5 sec</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>Power frequency (50/60 Hz) magnetic field</td>
<td>3 A/m</td>
<td>3 A/m</td>
<td>Power frequency magnetic fields should be at levels characteristic of a typical location in a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-8</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** $U_T$ is the AC mains voltage prior to application of the test level.
The PillCam capsules are intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam capsules should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conducted RF</td>
<td>3 VRMS 150 kHz to 80 MHz</td>
<td>Not applicable</td>
<td>Portable and mobile RF communications equipment should be used no closer to any part of a PillCam capsule, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter.</td>
</tr>
</tbody>
</table>
| Radiated RF   | 3 V/m 80 MHz to 2.5 GHz | 3 V/m           | \[ d = 1.2 \sqrt{P} \quad 80 MHz to 800 MHz \]
|               |                       |                 | \[ d = 2.3 \sqrt{P} \quad 800 MHz to 2.5 GHz \] |

Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.
Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.
Note 3: \( P \) is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer and \( d \) is the recommended separation distance in meters (m).
Note 4: Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey, should be less than the compliance level in each frequency range.
Note 5: Interference may occur in the vicinity of equipment marked with the following symbol:

![Symbol]

Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the PillCam capsules are used exceeds the applicable RF compliance level above, the PillCam capsules should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating the PillCam capsules.

Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
The PillCam capsules are intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The customer or the user of the PillCam capsules can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the PillCam capsules as recommended below, according to the maximum output power of the communications equipment.

<table>
<thead>
<tr>
<th>Rated maximum output power of transmitter [W]</th>
<th>Separation distance according to frequency of transmitter [m]</th>
</tr>
</thead>
<tbody>
<tr>
<td>150 kHz to 80 MHz</td>
<td>80 MHz to 800 MHz</td>
</tr>
<tr>
<td>d = 1.2√P</td>
<td>d = 1.2√P</td>
</tr>
<tr>
<td>0.01</td>
<td>Not applicable</td>
</tr>
<tr>
<td>0.1</td>
<td>Not applicable</td>
</tr>
<tr>
<td>1</td>
<td>Not applicable</td>
</tr>
<tr>
<td>10</td>
<td>Not applicable</td>
</tr>
<tr>
<td>100</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters (m) can be determined using the equation applicable to the frequency of the transmitter, where P is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

Note 1: At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.
# PillCam Recorder DR2/DR2C

## Guidance and manufacturer's declaration - electronic emissions

The PillCam recorder DR2 is intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam recorder DR2 should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Emissions test</th>
<th>Compliance</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions CISPR 11</td>
<td>Group 1</td>
<td>The PillCam recorder DR2 uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>RF emissions CISPR 11</td>
<td>Class B</td>
<td>The PillCam recorder DR2 is suitable for use in all establishments including domestic establishments and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes.</td>
</tr>
<tr>
<td>Harmonic emissions IEC 61000-3-2</td>
<td>Class A</td>
<td></td>
</tr>
<tr>
<td>Voltage fluctuations/ ficker emissions IEC 61000-3-3</td>
<td>Complies</td>
<td></td>
</tr>
</tbody>
</table>

## Guidance and manufacturer's declaration - electronic immunity

The PillCam recorder DR2 is intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam recorder DR2 should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD)</td>
<td>±6 kV contact</td>
<td>±6 kV contact</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td>IEC 61000-4-2</td>
<td>±8 kV air</td>
<td>±8 kV air</td>
<td></td>
</tr>
<tr>
<td>Electrical fast transient/burst</td>
<td>±2 kV for power supply lines</td>
<td>±2 kV for power supply lines</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-4</td>
<td>±1 kV for input/output lines</td>
<td>±1 kV for input/output lines</td>
<td></td>
</tr>
<tr>
<td>Surge</td>
<td>±1 kV line(s) to line(s)</td>
<td>±1 kV line(s) to line(s)</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-5</td>
<td>±2 kV line(s) to earth</td>
<td>±2 kV line(s) to earth</td>
<td></td>
</tr>
</tbody>
</table>
### Guidance and manufacturer's declaration - electronic immunity

<table>
<thead>
<tr>
<th>Voltage dips, short interruptions and voltage variations on power supply input lines</th>
<th>IEC 61000-4-11</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;5% ( U_T ) (&gt;95% dip in ( U_T )) for 0.5 cycle</td>
<td>&lt;5% ( U_T ) (&gt;95% dip in ( U_T )) for 0.5 cycle</td>
<td>Mains power quality should be that of a typical commercial or hospital environment. If the user of the PillCam recorder DR2 requires continued operation during power mains interruptions, it is recommended that the PillCam recorder DR2 be powered from an uninterruptible power supply or a battery.</td>
<td></td>
</tr>
<tr>
<td>40% ( U_T ) (60% dip in ( U_T )) for 5 cycles</td>
<td>40% ( U_T ) (60% dip in ( U_T )) for 5 cycles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>70% ( U_T ) (30% dip in ( U_T )) for 25 cycles</td>
<td>70% ( U_T ) (30% dip in ( U_T )) for 25 cycles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;5% ( U_T ) (&gt;95% dip in ( U_T )) for 5 sec</td>
<td>&lt;5% ( U_T ) (&gt;95% dip in ( U_T )) for 5 sec</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Power frequency (50/60 Hz) magnetic field

| IEC 61000-4-8 | 3 A/m | 3 A/m | Power frequency magnetic fields should be at levels characteristic of a typical location in a typical commercial or hospital environment. |

Note: \( U_T \) is the AC mains voltage prior to application of the test level.

### Guidance and manufacturer's declaration - electronic immunity

The PillCam recorder DR2 is intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam recorder DR2 should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
</table>
| Conducted RF | IEC 61000-4-6 | 3 VRMS 150 kHz to 80 MHz | 3\( V_{ms} \)  
\[ d = 1.2\sqrt{P} \]  
Portable and mobile RF communications equipment should be used no closer to any part of PillCam recorder DR2, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter.  
Recommended separation distance  
80 MHz to 800 MHz range |
| Radiated RF | IEC 61000-4-3 | 3 V/m 80 MHz to 2.5 GHz | 3 V/m  
\[ d = 1.2\sqrt{P} \]  
\[ d = 2.3\sqrt{P} \]  
80 MHz to 800 MHz range  
800 MHz to 2.5 GHz range |
Technical Description

### Guidance and manufacturer's declaration - electronic immunity

<table>
<thead>
<tr>
<th>Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>At 80 MHz and 800 MHz, the higher frequency range applies.</td>
</tr>
<tr>
<td>2</td>
<td>These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.</td>
</tr>
<tr>
<td>3</td>
<td>$P$ is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer and $d$ is the recommended separation distance in meters (m).</td>
</tr>
<tr>
<td>4</td>
<td>Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey, should be less than the compliance level in each frequency range.</td>
</tr>
<tr>
<td>5</td>
<td>Interference may occur in the vicinity of equipment marked with the following symbol: <img src="radio_signal.png" alt="Symbol" /></td>
</tr>
</tbody>
</table>

### Recommended separation distances between portable and mobile RF communications equipment and the PillCam recorder DR2

The PillCam recorder DR2 is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The customer or the user of the PillCam recorder DR2 can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the PillCam recorder DR2 as recommended below, according to the maximum output power of the communications equipment.

<table>
<thead>
<tr>
<th>Rated maximum output power of transmitter [W]</th>
<th>Separation distance according to frequency of transmitter [m]</th>
</tr>
</thead>
<tbody>
<tr>
<td>150 kHz to 80 MHz</td>
<td>$d = 1.2 \sqrt{P}$</td>
</tr>
<tr>
<td>80 MHz to 800 MHz</td>
<td>$d = 1.2 \sqrt{P}$</td>
</tr>
<tr>
<td>800 MHz to 2.5 GHz</td>
<td>$d = 2.3 \sqrt{P}$</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rated maximum output power of transmitter [W]</th>
<th>Separation distance according to frequency of transmitter [m]</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.01</td>
<td>Not applicable</td>
</tr>
<tr>
<td>0.1</td>
<td>Not applicable</td>
</tr>
<tr>
<td>1</td>
<td>Not applicable</td>
</tr>
<tr>
<td>10</td>
<td>Not applicable</td>
</tr>
<tr>
<td>100</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

For transmitters rated at a maximum output power not listed above, the recommended separation distance $d$ in meters (m) can be determined using the equation applicable to the frequency of the transmitter, where $P$ is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

**NOTE 1:** At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

**NOTE 2:** These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.
**PillCam Recorder DR3**

### Guidance and manufacturer's declaration - electromagnetic emissions

<table>
<thead>
<tr>
<th>Emissions test</th>
<th>Compliance</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions CISPR 11</td>
<td>Group 1</td>
<td>The PillCam recorder DR3 uses RF energy only for its internal function. Therefore, its RF emissions are low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>RF emissions CISPR 11</td>
<td>Class B</td>
<td>The PillCam recorder DR3 is suitable for use in all establishments, including domestic establishments and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes.</td>
</tr>
<tr>
<td>Harmonic emissions IEC 61000-3-2</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>Voltage fluctuations/ flicker emissions IEC 61000-3-3</td>
<td>N/A</td>
<td></td>
</tr>
</tbody>
</table>

### Guidance and manufacturer's declaration - electromagnetic immunity for all equipment and systems

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD)</td>
<td>6 kV contact 6 kV air</td>
<td>6 kV contact 8 kV air</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td>IEC 61000-4-2</td>
<td>8 kV air</td>
<td>8 kV air</td>
<td></td>
</tr>
<tr>
<td>Electrical fast transient/burst</td>
<td>2 kV for power supply lines</td>
<td>N/A</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-4</td>
<td>1 kV for input/output lines</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surge</td>
<td>1 kV line to line</td>
<td>N/A</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-5</td>
<td>2 kV line to earth</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Guidance and manufacturer’s declaration - electromagnetic immunity for all equipment and systems</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage dips, short interruptions and voltage variations on power supply input lines</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEC 61000-4-11</td>
<td>&lt;5% $U_T$ (&gt;$95%$ dip in $U_T$) for 0.5 cycle&lt;br&gt;40% $U_T$ (60% dip in $U_T$) for 5 cycles&lt;br&gt;70% $U_T$ (30% dip in $U_T$) for 25 cycles&lt;br&gt;&lt;5% $U_T$ (&gt;$95%$ dip in $U_T$) for 5 sec</td>
<td>N/A</td>
<td>Mains power quality should be that of a typical commercial or hospital environment. If the user of the PillCam recorder DR3 requires continued operation during power mains interruptions, it is recommended that the PillCam recorder DR3 be powered from an uninterruptible power supply or a battery.</td>
</tr>
<tr>
<td>Power frequency (50/60 Hz) magnetic field</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEC 61000-4-8</td>
<td>3 A/m</td>
<td>3 A/m</td>
<td>Power frequency magnetic fields should be at levels characteristic of a typical location in a typical commercial or hospital environment.</td>
</tr>
</tbody>
</table>

NOTE: $U_T$ is the AC mains voltage prior to application of the test level.
### Guidance and manufacturer's declaration - electromagnetic immunity

The PillCam recorder DR3 is intended for use in the electromagnetic environment specified below. The customer or the user of the PillCam recorder DR3 should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conducted RF</td>
<td>IEC 61000-4-6</td>
<td>3V\text{rms}</td>
<td>3V\text{rms}</td>
</tr>
<tr>
<td></td>
<td>150 kHz to 80 MHz</td>
<td>150 kHz to 80 MHz</td>
<td><strong>Recommended separation distance:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(d = 1.2\sqrt{P})</td>
</tr>
<tr>
<td>Radiated RF</td>
<td>IEC 61000-4-3</td>
<td>3 V/m</td>
<td>3 V/m</td>
</tr>
<tr>
<td></td>
<td>80 MHz to 2.5 GHz</td>
<td>80 MHz to 800 MHz</td>
<td><strong>Recommended separation distance:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(d = 1.2\sqrt{P}) 80 MHz to 800 MHz range</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(d = 2.3\sqrt{P}) 800 MHz to 2500 MHz range</td>
</tr>
</tbody>
</table>

**Note 1:** At 80 MHz and 800 MHz, the higher frequency range applies.

**Note 2:** These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.

**Note 3:** \(P\) is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer and \(d\) is the recommended separation distance in meters (m).

**Note 4:** Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey, should be less than the compliance level in each frequency range.

**Note 5:** Interference may occur in the vicinity of equipment marked with the following symbol:

\[\text{(!)}\]

\(a\) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the PillCam recorder DR3 is used exceeds the applicable RF compliance level above, the PillCam recorder DR3 should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating the PillCam recorder DR3.

\(b\) Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
Recommended separation distances between portable and mobile RF communications equipment and the PillCam recorder DR3

The PillCam recorder DR3 is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The customer or the user of the PillCam recorder DR3 can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the PillCam recorder DR3 as recommended below, according to the maximum output power of the communications equipment.

<table>
<thead>
<tr>
<th>Rated maximum output power of transmitter [W]</th>
<th>Separation distance according to frequency of transmitter [m]</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>150 kHz to 80 MHz</td>
</tr>
<tr>
<td></td>
<td>(d = 1.2\sqrt{P})</td>
</tr>
<tr>
<td>0.01</td>
<td>0.12</td>
</tr>
<tr>
<td>0.1</td>
<td>0.38</td>
</tr>
<tr>
<td>1</td>
<td>1.2</td>
</tr>
<tr>
<td>10</td>
<td>3.8</td>
</tr>
<tr>
<td>100</td>
<td>12</td>
</tr>
</tbody>
</table>

For transmitters rated at a maximum output power not listed above, the recommended separation distance \(d\) in meters (m) can be determined using the equation applicable to the frequency of the transmitter, where \(P\) is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

Note 1: At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.
Index

A

abdominal pain ............................................ 37
Acknowledge button ..................................... 68
action buttons, Study Manager .......................... 102
adaptive frame rate (AFR) ................................. 30
adhesive sleeve ............................................ 52
AFR mode .............................................. 69, 86, 120, 139
archive, add ................................................. 99
Archives ..................................................... 99
archives, options ........................................ 100
Atlas ......................................................... 34
Automatic shutdown ...................................... 74

B

battery-operated ........................................... 31
Blue .......................................................... 121

capsule
  troubleshooting ......................................... 209
Capsule ID .................................................. 47
capsule ID .................................................. 81
Capsule ingestion ........................................... 82
CD ............................................................ 107
CD/DVD burning, Study Manager ....................... 108
charging, PillCam recorder DR2 ........................ 75
circumference scale ...................................... 135
Clear Liquid Diet .......................................... 40
Clips/Images ............................................... 160
COLON 2 Sensor Locations .............................. 56
Colon Location Diagram .................................. 138, 140

commands
  Image Adjustment group ................................ 121
  Image Data group ....................................... 159
  Markings group ......................................... 152
  Preview group ......................................... 118
  Report group .......................................... 149
  Review group .......................................... 120
  Show group ............................................. 124
  Viewing Layout group .................................. 120
  Zoom group ............................................. 124
Comments Editor ......................................... 132
compare thumbnails ...................................... 141
Components, PillCam Capsule Endoscopy System ...
  29
Configure dialog box .................................... 149
CQV (Complementary QuickView) ..................... 126
cradle
  troubleshooting ......................................... 209
cradle, DR3 ............................................... 66
create a thumbnail ....................................... 131
creating a video ......................................... 89
Customer Support ........................................ 34

D

Delay First Instruction .................................. 47, 72
delete a study .............................................. 111
delete multiple studies .................................. 112
Delete Videos ........................................... 34
Dialog Box Launchers .................................. 114
download loop ............................................ 53
download loop, adjust .................................... 53
Download ................................................... 89
Dual Head View ........................................... 128
Dual view .................................................... 120
DVD ......................................................... 91, 107
Dynamic player control .................................. 124, 127

E

Error Messages
  RAPID .................................................. 211
ESO Sensor Locations .................................... 54
expiration date, capsule .................................. 57

F

FICE .......................................................... 121, 122
findings ..................................................... 122
findings, open ............................................ 143
findings, save ............................................ 144

G

GI Dictionary ............................................... 132

H

Help ............................................................ 34
Help Center ................................................ 34
HIS Import .................................................. 45
Home screen .............................................. 32
How to ....................................................... 34

I

Identify recorder .......................................... 39
<table>
<thead>
<tr>
<th>Page</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>121, 123</td>
<td>Image Adjustment</td>
</tr>
<tr>
<td>31</td>
<td>image data, restore</td>
</tr>
<tr>
<td>31</td>
<td>image data, transmission</td>
</tr>
<tr>
<td>31</td>
<td>image date, receive</td>
</tr>
<tr>
<td>3</td>
<td>Indications for Use</td>
</tr>
<tr>
<td>63</td>
<td>Initialization</td>
</tr>
<tr>
<td>137</td>
<td>landmark, create</td>
</tr>
<tr>
<td>130, 137</td>
<td>Landmarks</td>
</tr>
<tr>
<td>40</td>
<td>laxative</td>
</tr>
<tr>
<td>70</td>
<td>LEDs, PillCam recorder DR3</td>
</tr>
<tr>
<td>155</td>
<td>Lewis Score</td>
</tr>
<tr>
<td>138</td>
<td>Localization</td>
</tr>
<tr>
<td>52</td>
<td>loop</td>
</tr>
<tr>
<td>104</td>
<td>manage columns</td>
</tr>
<tr>
<td>46</td>
<td>Manual Data Entry</td>
</tr>
<tr>
<td>204</td>
<td>manual discharge</td>
</tr>
<tr>
<td>135</td>
<td>Mark Arrow</td>
</tr>
<tr>
<td>134</td>
<td>Mark Circle</td>
</tr>
<tr>
<td>134</td>
<td>marking tools</td>
</tr>
<tr>
<td>134</td>
<td>markings, on thumbnails</td>
</tr>
<tr>
<td>116</td>
<td>menu commands</td>
</tr>
<tr>
<td>31</td>
<td>metal objects</td>
</tr>
<tr>
<td>121</td>
<td>Mosaic view</td>
</tr>
<tr>
<td>37</td>
<td>MRI device</td>
</tr>
<tr>
<td>42</td>
<td>MRI device</td>
</tr>
<tr>
<td>37</td>
<td>nausea</td>
</tr>
<tr>
<td>69</td>
<td>navigation buttons</td>
</tr>
<tr>
<td>112</td>
<td>Offline studies</td>
</tr>
<tr>
<td>141</td>
<td>One thumbnail comparison</td>
</tr>
<tr>
<td>63, 80</td>
<td>Pairing</td>
</tr>
<tr>
<td>81</td>
<td>pairing, before capsule ingestion</td>
</tr>
<tr>
<td>80</td>
<td>Pairing, during patient check-in</td>
</tr>
<tr>
<td>141</td>
<td>passage times</td>
</tr>
<tr>
<td>32</td>
<td>Patient Check-In</td>
</tr>
<tr>
<td>43</td>
<td>Patient check-in</td>
</tr>
<tr>
<td>45</td>
<td>Patient Check-In wizard</td>
</tr>
<tr>
<td>42</td>
<td>Patient Guidelines, general</td>
</tr>
<tr>
<td>40</td>
<td>Patient Instructions, creating</td>
</tr>
<tr>
<td>37</td>
<td>Patient, preparing</td>
</tr>
<tr>
<td>29</td>
<td>PillCam Capsule Endoscopy</td>
</tr>
<tr>
<td>29</td>
<td>PillCam Capsule Endoscopy, Process</td>
</tr>
<tr>
<td>29</td>
<td>PillCam Capsules</td>
</tr>
<tr>
<td>139</td>
<td>PillCam Progress Indicator</td>
</tr>
<tr>
<td>210</td>
<td>PillCam Recorder DR2</td>
</tr>
<tr>
<td>31</td>
<td>troubleshooting</td>
</tr>
<tr>
<td>210</td>
<td>Troubleshooting</td>
</tr>
<tr>
<td>75</td>
<td>PillCam recorder DR2, charging</td>
</tr>
<tr>
<td>44</td>
<td>PillCam recorder DR2, software update</td>
</tr>
<tr>
<td>209</td>
<td>PillCam recorder DR3</td>
</tr>
<tr>
<td>31</td>
<td>troubleshooting</td>
</tr>
<tr>
<td>66</td>
<td>PillCam recorder DR3, charging</td>
</tr>
<tr>
<td>70</td>
<td>PillCam recorder DR3, LEDs</td>
</tr>
<tr>
<td>80</td>
<td>PillCam recorder DR3, pairing</td>
</tr>
<tr>
<td>63</td>
<td>PillCam recorder, initiation</td>
</tr>
<tr>
<td>59</td>
<td>PillCam recorder, positioning</td>
</tr>
<tr>
<td>63</td>
<td>PillCam recorder, preparing</td>
</tr>
<tr>
<td>52</td>
<td>PillCam sensor array, applying</td>
</tr>
<tr>
<td>51</td>
<td>PillCam sensor belt, applying</td>
</tr>
<tr>
<td>32</td>
<td>PillCam sensors</td>
</tr>
<tr>
<td>135</td>
<td>Polyp size estimation</td>
</tr>
<tr>
<td>41</td>
<td>Post-ingestion Instructions</td>
</tr>
<tr>
<td>40</td>
<td>Pre-ingestion Instruction Handouts</td>
</tr>
<tr>
<td>120</td>
<td>Quad View</td>
</tr>
<tr>
<td>115</td>
<td>Quick Access Toolbar</td>
</tr>
<tr>
<td>125</td>
<td>QuickView</td>
</tr>
<tr>
<td>153</td>
<td>RAPID Atlas</td>
</tr>
<tr>
<td>32</td>
<td>RAPID for PillCam software</td>
</tr>
<tr>
<td>89</td>
<td>raw data</td>
</tr>
<tr>
<td>68</td>
<td>real-time viewer, activate</td>
</tr>
<tr>
<td>63</td>
<td>Real-time viewing</td>
</tr>
<tr>
<td>69</td>
<td>Real-time viewing, activate</td>
</tr>
<tr>
<td>85</td>
<td>Real-time viewing, PillCam recorder DR3</td>
</tr>
<tr>
<td>48</td>
<td>Reason for Referral, check-in</td>
</tr>
<tr>
<td>39, 90</td>
<td>Recorder bar</td>
</tr>
<tr>
<td>58</td>
<td>recorder belt</td>
</tr>
<tr>
<td>32, 90</td>
<td>Recorder Download</td>
</tr>
<tr>
<td>57</td>
<td>recorder pouch</td>
</tr>
<tr>
<td>44</td>
<td>recorders update, automatic</td>
</tr>
<tr>
<td>34</td>
<td>Regimen Manager</td>
</tr>
<tr>
<td>64, 66</td>
<td>Regimen reminder</td>
</tr>
<tr>
<td>47</td>
<td>regimen, patient check-in</td>
</tr>
<tr>
<td>147</td>
<td>report template, select</td>
</tr>
<tr>
<td>146</td>
<td>report, create</td>
</tr>
<tr>
<td>114</td>
<td>ribbon</td>
</tr>
<tr>
<td>114</td>
<td>ribbon groups</td>
</tr>
</tbody>
</table>
ribbon tabs ............................................. 114

S

SB Sensor Locations ..................................... 55
SBI View ...................................................... 129
SD card ......................................................... 64
search, Study Manager .................................. 103
Sensor array
  troubleshooting ........................................... 208
sensor array .................................................. 32
sensor belt .................................................... 32
  troubleshooting ......................................... 209
Sensor Location Guide .................................... 53
Settings ......................................................... 34
Single view ................................................... 120
skin ............................................................. 52
spell checker .................................................. 133
status bar ....................................................... 101
studies .......................................................... 97, 100
Study Manager .............................................. 97
Study Manager, access .................................... 97
study, options ................................................ 101
Suggest SB Landmarks .................................... 138
suggest the Colon Flexure landmarks ............. 138

T

thumbnail comments ....................................... 132
Thumbnail Editor ........................................... 134
Thumbnail settings ......................................... 149
thumbnail, create ............................................ 131
thumbnail, view .............................................. 131
thumbnails .................................................... 130
thumbnails, scroll through ................................ 131
thumbnails, status .......................................... 131
two thumbnails comparison .............................. 142

U

Undo Mark ..................................................... 135
update patient details ..................................... 50
update, PillCam recorders ................................. 44
USB storage device ......................................... 91
use cycles, DR2 ............................................. 74
User Column .................................................. 105
User Dictionary ............................................. 34

V

video creation, batch ..................................... 92
video segment ............................................... 161
view a video .................................................. 125
View Study .................................................... 32
vomiting ......................................................... 37

X

X-ray ............................................................ 37

Z

Zip ................................................................. 107
Zip, study .................................................... 111